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Introducing Workshare Compare

Chapter 1: Introducing Workshare
Compare

This chapter introduces Workshare Compare, providing an overview of how it works as
well as a summary of the key features and benefits. It includes the following sections:

o What is Workshare Compare?, page 10, introduces Workshare Compare.

» Workshare Compare Functionality, page 11, describes the different areas of
functionality of Compare.

o Accessing Compare Functionality, page 14, describes how to access Compare
functionality after install.

» Licensing, page 16, describes how to license Compare after install.
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What is Workshare Compare?

Workshare Compare reimagines multi-party review and collaboration and ensures the safe
and accurate exchange of information, enabling the collaborative evolution of high value
business documents.

Workshare Compare is a desktop application that automates managing changes to
business documents.

Key features of Workshare Compare include:

Comparison of Word, PowerPoint, Excel and PDF files, including image-based
PDF files

Comparison of selected pieces of content, such as a single paragraph or clause
Ability to accept/reject changes in a comparison and then create new documents

Advanced comparison features including one-to-many comparisons (Word and
PDF files), version comparisons, and access from within Office and Document
Management Systems

Access to comparison functionality from within Outlook as well as right-click access
from within individual emails

Conversion from PDF to DOC format for local files and from within the DMS/CRM
Options to save and share Office documents to Workshare online
Access and visibility into online collaborative workspaces directly from Office

Secure file sharing from all devices and browsers with metadata removal and end-
to-end encryption

ECM/DMS and OCR integration with desktop comparison features
Centralized user account management and control

Complete access to Workshare online functionality to share and collaborate on
documents, including setting folder access and permissions, positional commenting
and reviewer communications with presence indicators

Desktop sync app to synchronize your online content to your local desktop

Note: Workshare Compare can be installed without Microsoft Office integration. In this
case, the comparison functionality is only available from the Workshare comparison
applications.

10
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Workshare Compare Functionality

Workshare Compare provides sophisticated functionality that is convenient and
accessible, enabling users to move smoothly between tasks and work rapidly to manage
changes. Workshare Compare assists you throughout the complete document lifecycle —
from document assembly, review, verification and security. Workshare Compare has also
made key functionality of the DMS available, for example, enabling the comparison of
DMS versions.

Workshare Compare may include the Connect product to extend its functionality to
Workshare online.

What can Compare do?

Workshare Compare reinvents multi-party review by helping users understand,
communicate and implement changes more quickly and accurately. Compare shows
precise changes between versions of Word, PDF, PowerPoint and Excel files including
DMS files and versions. The DeltaView redline sets the standard for an easy-to-read,
accurate view of changes between document versions. Compare’s advanced comparison
engine performs comparisons accurately and seamlessly enabling users to quickly
compare even the most difficult and complex documents, presentations and spreadsheets.

See the changes

With Microsoft Word and PDF files, users can perform one-to-one and one-to many
comparisons and see accurate DeltaView redlines in individual tabs. Compare compares
both regular text-based PDF files and image-based PDF files that originate from scanned
documents, automatically applying OCR (Optical Character Recognition) processing to
translate the images of typewritten text into editable text. Compare provides access to files
and version information stored in a DMS/CRM or SharePoint and users can browse for
files to compare as well as save comparisons into the DMS/CRM or SharePoint.

Users can launch Compare from the environment that suits them:
e Launch a comparison of an attachment directly from an email message
o Launch a comparison from within Word, Excel or PowerPoint

e Launch a comparison from within a DMS/CRM or SharePoint

Selective Compare enables the user to copy snippets of text from anywhere and run a
comparison in Workshare. This is much faster and more focused than comparing an entire
document.

11
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Understand the changes

Compare provides an intuitive interface that enables users to navigate easily between
changes. Category View divides changes according to type, for example, numbering
changes, punctuation changes or matching changes, enabling users to quickly focus on
the changes that are important to them.

Implement the changes

When comparing Word and PDF files, Compare includes the ability to accept and reject
changes (individually or as a group) and create a new Word document that includes all
the changes.

File share and sync

Workshare’s online services provide a secure file sharing and online collaboration tool that
enables users to store, share, and collaborate on content. There are several ways of
interacting with the online services offered by Workshare, either online through a web
browser or using special apps. The Workshare desktop app is the app for use on PCs and
it is installed as part of the Compare installation when you select the file share & sync
option.

Note: Workshare’s mobile apps are apps designed for use on smartphones and tablets
that provide access to documents in Workshare online while on the move.

Users can sync documents safely across all their devices automatically updating content
between Workshare online and their desktop and mobile devices.

With the Groups functionality, users can easily organize and manage files and projects,
ensuring the correct users and permissions are set up for a group. Tools for commenting,
annotating, and file comparison are available to support all stages of document evolution.
Users receive updates when files in particular groups are being accessed, commented on,
or modified by other reviewers, so ideas and conversations are never missed. Once new
file versions are uploaded, users can compare old and new versions to see at a glance
what has changed.

Users can access, review, and collaborate on files from any device, supporting company-
wide mobility initiatives. Users can also select files to save for offline access, enabling
users to work on files without Internet access. Once the device is connected again, all
updates are synced back as a new version.

IT security controls are available at an account level, allowing data governance regulations
to be met, and reduce the risk of accidental data loss. For added security, organizations
can choose where their corporate data is stored (public cloud, custom public cloud, or
hybrid). Finally, Workshare online can be integrated with existing DMS to securely mobilize
content, and get the most out of IT system investments.

12
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With Compare, users can save and share redlines or Office files (directly from Compare or
Office) to Workshare online so they can access them on their other devices and on the
move. Once shared, users can see their shared document, spreadsheet or presentation
come alive and understand who’s reviewing it online - directly from Word, Excel or

PowerPoint.

DMS/CRM integration

DMS/CRM integration

Workshare Compare can integrate with your DMS or CRM as well as SharePoint to
provide comparison and other functionality.

Note: To integrate with a DMS/CRM or SharePoint, Workshare Compare must be
installed with the relevant integration selected and additional details may need to be
configured in the Workshare Configuration Manager. Refer to your system administrator

for further information.

The specific functionality available with each DMS/CRM integration is detailed in the table

below:

Note: The comparison functionality relates to all file types — Word, PDF, Excel and
PowerPoint — unless specified.

Functionality

iManage

Net
Documents

OpenText

Worldox

SharePoint

From Workshare
comparison
application, browse
to DMS

V4

V4

v

From Workshare
comparison
application, save to
DMS

v

v

Right-click from
within DMS, launch
Workshare
comparison

< 2
.5

<

-
3 [E

From Connect
desktop app, browse
to DMS to add files
to Workshare

V4

V4

<
X
v
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The right-click option is available in iManage FileSite/DeskSite clients. If you're
using the iManage Work 10 web client, you can access Workshare comparison for
Word and PDF files from the kebab menu but you will need the Workshare
IManage Integration Server installed. See Installing WIIS in the knowledge base
for more information.

The Workshare options are available via Send to application functionality in
NetDocuments.

In Worldox, the Workshare comparison is also available using the Compare Files
button in the toolbar.

Accessing Workshare Compare

Workshare Compare can integrate with Microsoft Word, Excel, PowerPoint and Outlook so
that comparison is available from within these Office applications. Additionally, Workshare
Compare and Workshare Compare for PowerPoint are available as standalone
applications.

After you have installed Compare, the Workshare tab is added to the ribbon in your
Microsoft Office applications - Word, Excel and PowerPoint. The addition of Compare does
not affect the standard functionality of Word, Excel or PowerPoint. You can operate these
applications as usual and access the Compare functionality as required.

Workshare Compare functionality can also be accessed in the following ways:

Right-click closed Word or PowerPoint documents and select Compare with
Workshare.

Right-click closed PDF documents and select Compare with Workshare or Open
in Word with Workshare.

Right-click attachments in Outlook and select Compare with Workshare.
Click Compare or Selective Compare in the Workshare ribbon in Outlook.

Right-click any file and select Workshare/Share to Group.

The Workshare Compare standalone application can also be accessed
from the Start menu or by double-clicking the Workshare Compare icon
on the desktop.

The Workshare Compare for PowerPoint standalone application can
also be accessed from the Start menu or by double-clicking the
M Workshare Compare for PowerPoint icon on the desktop.

PowerPoint

14
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The Workshare Compare for Excel standalone application can also be
accessed from the Start menu or by double-clicking the Workshare
Compare for Excel icon on the desktop.

Note: Workshare Compare can be installed without Microsoft Office integration. In this
case, the Workshare ricbbon is not available. The Workshare comparison functionality is
only available from the Workshare standalone applications.

Workshare ribbon

In Office applications, the Workshare ribbon is included as follows:

=B O < E @

s = ] M= -

Compare Selective | Toggle Saveto My Share | Options = Help
Compare | Panel Files ~ ¥

Compare Sharing Cptions Infa

Whether these options are included in the ribbon is configurable from the General > User
Interface category in the Workshare Configuration Manager. Refer to Workshare
Configuration Options for further information.

The Workshare ribbon includes the following options:

Group Item Description Available
Compare | Compare | Enables you to compare a Word or PowerPoint | Word,
file with a previous version of the same file or PowerPoint,
with another file. Refer to Overview - Comparing | Outlook
Documents and Introducing Compare for
PowerPoint for further information.
Selective Enables you to compare a snippet of text with Word,
Compare | another snippet of text. Refer to Comparing Outlook
Selected Content for further information.
Sharing | Toggle Displays/hides the Workshare Connect panel in | Word,
Panel your Office window where you can see what'’s Excel,
happening with a collaboration in real-time. PowerPoint
Refer to Getting Content Online for further
information.
Save to | Enables you to save documents to Workshare Word,
My Files | online so they will be accessible to you online at | Excel,
all times. Refer to Saving to My Files for further | PowerPoint
information.

15
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Group Item Description Available
Share Enables you to share documents to groups in Word,

Workshare online so you can collaborate on Excel,
them with others. Refer to Sharing to a PowerPoint
Workshare group for further information.

Options | Options | Enables you to configure system parameters in | Word,
the Workshare Configuration Manager. Refer to | Excel,
Introducing the Workshare Configuration PowerPoint
Manager for further information.

Info Help Provides access to version, copyright and Word,
license information about Workshare Compare Excel,
as well as online help. PowerPoint

Enabling Workshare Compare functionality

To ensure Workshare Compare functionality is fully enabled, you should work with saved
documents. If you are working in Microsoft Office on an unsaved document and you select
Compare, the following message is displayed:

Workshare >
[ The document needs to be saved
i The Warkshare functionality you have selected is not
currently enabled for an unsaved document.
e

16
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Licensing

After installation, you are prompted to log in to your Workshare account in order to retrieve
your license entitlements. This can be in either of the following ways:

o When file share & sync is included in the installation, the Workshare desktop app is
launched after install and you will see the following:

) Workshare - O x
File ¥iew Help

) workshare

(=) Workshare

Welcome, let’s get started

Enter your email address to sign in or register

| Email address

B2 Sign in with Microsoft work account

Find out more

Enter your Workshare credentials (email address and password) and click Sign in.
Your license entitlements are retrieved and you have access to all Workshare
functionality. Your license entitlements are shown in the My Products tab of the
Workshare Configuration Manager.

If you do not log in at this point, then...

17
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» The first time you access Workshare functionality, for example, by clicking any
option in the Workshare tab, you will see the following:

e Workshare 10.C

Sign in

to validate your Workshare subscription

m

Forgotten password

Why do I have to sign in?

Create an account

Note: You can also open the Workshare Configuration Manager, select the My Products
tab and click Sign in.

Enter your Workshare credentials (email address and password) for Workshare and click
Sign in. Your license entitlements are retrieved and you have access to all Workshare
functionality. Your license entitlements are shown in the My Products tab of the
Workshare Configuration Manager.

Users who do not yet have a Workshare account can click Create an account in the login
dialog. Workshare checks their email address and will automatically register them against
your corporate Workshare account and update their license entitlement.

18
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Chapter 2: Comparing Documents

This chapter describes Workshare Compare, a standalone application that enables you to
compare two or more Microsoft Word or PDF documents. It includes the following
sections:

Overview — Comparing Documents, page 20, introduces the Workshare Compare
application.

Performing Comparisons, page 21, describes how to compare a document
against an earlier version of the document or against a different document using
Workshare Compare.

Comparing Selected Content, page 27, describes how to compare a snippet of
content with another snippet of content.

Ensuring Successful Comparisons, page 28, describes how Workshare
Compare performs comparisons using auto retry mode and failsafe mode.

Workshare Compare Main Window, page 30, describes the Workshare Compare
environment and provides an overview of the functionality available.

Working with redlines, page 47, describes the tools available to you when working
with the compared (redline) document after a comparison.

19
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Overview - Comparing Documents

Note: This chapter describes how to compare Word documents and PDF files. The
comparison of PowerPoint presentations is described in Chapter 3 and the comparison of
Excel spreadsheets is described in Chapter 4.

The Workshare Compare application compares documents — the original document and
the modified document — and produces a comparison (redline document), enabling you to
instantly see any differences between them. In one view, you can see the source
documents and the resulting DeltaView redline. You can compare an original document
against several different modified documents and see the redline for each comparison in a
different tab. Documents can be stored in your DMS or CRM, locally or on your network.

You can compare any of the following file formats:
DOC DOCX PDF RTF TXT

Workshare Compare’s powerful engine accurately and reliably displays document changes
in a redline document with the differences clearly marked. For example, deleted-textisred
and-struck-through and added text is blue and double underlined. All content is compared
including images, tables and embedded Microsoft Excel tables. You can review the
redline, navigating between the changes and accepting or rejecting the changes to create
a new and revised document. To make the review easier, you can customize how the
changes are highlighted within the document.

RUN A COMPARISON

LaunchWorkshare Compare, selectthe
documentsto compare and runyour
comparison.

ACCEPT/REJECT CHANGES

In Compare, review and apply the
changesyou want.

SAVE AND SHARE

Save yourreviseddocumentlocally orin
your DMS, or share it with others.

20
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PDF comparison

Workshare Compare can compare both regular text-based PDF files and image-based
PDF files that originate from scanned documents. Regular PDF files are compared by
converting them to RTF before performing a comparison. With image-based PDF files,
Workshare Compare will first apply OCR (Optical Character Recognition) processing to
translate the images of typewritten text into editable text and then produce an RTF file.

PDF files that originate from scanned documents may include:

» PDF files generated from files that have been scanned: OCR (Optical Character
Recognition) has already been used to translate images of typewritten text into
editable text. Workshare Compare supports the comparison of such PDF files.

» PDF files that have been created directly from the scanning: Where OCR has not
been used and PDF files contain pure images of text. Workshare Compare applies
OCR to the PDF files before performing comparisons.

Notes:
If you compare scanned PDF files without applying OCR, it may result in a blank redline.

Workshare Compare can perform OCR on the following languages: English, Danish,
Dutch, Finnish, French, German, Italian, Norwegian, Polish, Portuguese, Spanish,
Swedish and Russian.

Performing Comparisons

You can compare your original document against any previous version of the document or
against another document entirely. For example, there may be ten versions of a document
in your DMS. You can open version 3 and compare it against version 5. You can also
compare a document against multiple versions. For example, you can open version 3 and
compare it against version 5, version 7 and version 10.

Note: You cannot compare secure PDFs, meaning PDF files with security settings
configured.

You can launch Workshare Compare and perform comparisons from within Microsoft
Word, from your desktop, from right-click options or from an email and each of these
scenarios is described in the following sections.

Note: Comparison of selected pieces of text, such as a single paragraph or clause, is
described in Comparing Selected Content.
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Launching Workshare Compare from Microsoft Word

In this scenario, you first open your document in Microsoft Word.
To compare documents:

Click Compare in the Workshare tab. The Compare Documents dialog is displayed with
the open document in the Modified Document field. Select the file to compare it against
as described in Launching Workshare Compare from your desktop.

Launching Workshare Compare using right-click options

You can launch Workshare Compare by right-clicking documents in File Explorer or in your
DMS (iManage/OpenText/Worldox).

e Right-click the original document and select Compare with Workshare. The
Compare Documents dialog is displayed with the selected document in the Original
Document field. Select the files to compare it against as described in Launching
Workshare Compare from your desktop.

« Select the original and modified documents, right-click and select Compare with
Workshare. The Compare Documents dialog is displayed with the selected
documents in the Original Document and Modified Document fields. Continue as
described in Launching Workshare Compare from your desktop.

You cannot launch Workshare Compare from SharePoint using right-click options.

You can launch Workshare Compare from the Work 10 browser interface using the kebab
(context) menu if you have WIIS (Workshare iManage Integration Server) installed. See
this knowledge base article - Installing Workshare iManage Integration Server.
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Launching Workshare Compare from email

You can launch Workshare Compare from the dropdown context menu of an attachment to

an email or using the Compare button in the Workshare tab.

o Select one (or two attachments), click the dropdown and click Compare with
Workshare.

Sample Madified Document.docx
W=| 33KB

Ef_ﬂl Spre|
22| 20K

[} Sam

Preview

Open

Quick Print

Save A=

Save All Attachments...
Remove Attachment

Copy

Calact nll

o

Compare with Workshare

The Compare Documents dialog is displayed with the attachment in the Modified
Document field. Continue as described in Launching Workshare Compare from
your desktop.

« With an email selected in your inbox, click Compare in the Workshare tab. If the
email doesn’t include attachments, the Compare button is disabled. If the email
includes one or two Word or PDF attachments, the Compare Documents dialog is
displayed with the attachments selected. If the email contains more than two

attachments, the following dialog is displayed:

Lo

&
=
g
g
-2
-
@
B

oogoooon

Select up to two attachments to compare

Sample Modified Document.docx
Sample Original Document.docx
Spreadsheet Axlsx

Spreadsheet B.xlsx
Sample_presentation_version_1.pptx
Sample_presentation_version_2.pptx
Sample Modified Documentpdf

Sample Original Document.pdf

You can only compare: Word,/Word, PDF/PDF, Word/PDF, Excel/Excel and PowerPaint/
PowerPoint

I Cancel ._
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Select the attachments you want to compare and click Continue. The Compare
Documents dialog is displayed with the attachments selected. Continue as
described in Launching Workshare Compare from your desktop.

Note: If you select attachments that can’t be compared for example, a DOCX and
an XLSX, the Continue button will be disabled.

Launching Workshare Compare from your desktop

In this scenario, you launch Workshare Compare as a standalone application from your
desktop or the Start menu. You then select the documents you want to compare.

To compare documents:

1. Double-click the Workshare Compare shortcut on your desktop or select
Workshare Compare from the Start menu. The Compare Documents dialog is

displayed:
Workshare Compare >
(=) Workshare
Please select the documents you want to compare:
Original Document:
I -] [&]
Modified Document: |gjﬁ

| v| =]

Rendering Set:
ismndard V: | EJ

Comparison Mode:

| s |

Help Ok | Cancel |
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Select the original document you want to compare:
o Drag the file over the Original Document field, or

= Click to the right of the Original Document field, navigate to the
document location in your local file system, SharePoint or DMS/CRM and click
Open.

The selected document is displayed in the Original Document field.

Tip: You can also enter text directly into the text box. Workshare Compare will
predict locations as you type. This is possible for locations accessible from the
local machine but not for locations in a DMS.

Select the document you want to compare with the original document:
= Drag the file over the Modified Document field, or

o Click to the right of the Modified Document field, navigate to the
document location in your local file system, SharePoint or DMS/CRM and click
Open.

The selected document is displayed in the Modified Document field.

Tip! If you want to compare a recently used file, click the dropdown ¥ in the
Original Document and Modified Document fields and select the documents
you want to compare. These lists contain the last 10 documents you have used.

Tip! To swap the original and modified documents, click . This button is only
available if you are comparing two documents rather than comparing multiple
documents against an original document.

. If you want to compare the original document against another document, click .
An additional Modified Document field is added.

Select the document you want to compare with the original document:
o Drag the file over the second Modified Document field, or

= Click to the right of the second Modified Document field, navigate to the
document location in your local file system, SharePoint or DMS/CRM and click
Open.

Repeat step 5 to add further documents as required.
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7. From the Rendering Set dropdown list, select the rendering set you want to use.
Rendering sets contain a set of parameters that define how changes are displayed
in the redline (compared) document. You can select from the standard rendering
sets provided with Workshare Compare or you can create and customize your own
rendering sets (described in Introducing Rendering Sets).

Rendering Set:

Standard no color

Standard no moves

Standard with caret for deletes
Standard with change numbers
H5tandard with font changes
Standard with shading

Note: Clicking to the right of the Rendering Set field displays the Rendering
Sets Manager where you can create, modify and delete rendering sets. For a full
description refer to Introducing Rendering Sets.

8. From the Comparison Mode dropdown list, select the type of comparison you
want to perform from the following:

o Standard: Workshare Compare performs a regular comparison.

= Fast: When comparing a DOC or DOCX file against another DOC or DOCX file,
Workshare Compare performs a binary comparison which is faster than a
standard comparison.

Note: The Fast option is only available if the Enable fast comparison parameter
(Comparison > Administration category) in the Workshare Configuration
Manager is selected.

o Text Only: Workshare Compare performs a text-only comparison, comparing
only the text in a document and not the formatting or styles.

o Compare without OCR: Workshare Compare compares PDF files without first
performing OCR. With image-based PDF files, Workshare Compare will first
apply OCR (Optical Character Recognition) processing to translate the images
of typewritten text into editable text in order to compare. If you do NOT want
Workshare Compare to perform OCR, select this option.

9. Click OK. The comparison process is launched and a progress dialog is displayed.

Tip: Progress is also indicated by the shading in the Task Bar icon for Workshare

Compare ﬂ@
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When the comparison is complete, the redline is displayed in the Workshare Compare
window. If the original document has been compared against multiple documents, each
redline is displayed in a different tab. For a full description of the Workshare Compare
interface, refer to Workshare Compare Main Window.

Note: When comparing a PDF file, the display may vary according to the type of PDF -
the software used to create the PDF file. For example, Adobe, Amyuni, CutePDF,
novaPDF, and so on.

Comparing Selected Content

You can use Selective Compare to run a comparison on snippets of content pasted from
emails, chats or files. This is much faster and more focused than comparing an entire
document. Content can include text, tables, code and images and results are displayed in
the familiar Compare environment.

To compare selected content:

1. From the Workshare tab in Microsoft Word or Outlook, click Selective Compare.

) Selective Compare . O X

Original Modified

iR

Cancel

2. Drag the content you want to compare into the Original area or click in the area to
paste your content there. The content can include text, images, tables, code.

3. In the Modified area, drag or paste the content you want to compare with the
original content.

Tip! To swap the original and modified content, click < .

4. Click Compare. The comparison is displayed in the Workshare Compare window.
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Ensuring Successful Comparisons

If Workshare Compare cannot complete the comparison, it will do one of two things:
« Invoke auto retry mode, if it is enabled.

» Invoke failsafe mode, if auto retry mode is not enabled or if Workshare Compare
cannot complete the comparison in auto retry mode.

Auto retry mode

If Workshare Compare is unable to complete the comparison, and auto retry mode is
enabled, then Workshare Compare attempts to perform the comparison using reduced
settings. For example, Workshare Compare may attempt to compare the documents
without comparing field codes or without comparing footnotes. Workshare Compare
repeatedly attempts to perform the comparison disabling settings one at a time until the
comparison is successful.

Note: Auto retry mode is enabled in the rendering set — the Allow Auto Retry parameter
in the Comparison Options category of the Rendering Sets Manager.

Once the comparison is successful, a message is displayed informing you that the
comparison has been performed using reduced settings. Click OK and scroll to the
Redline Options Summary, which is displayed at the beginning or end of the redline
according to the settings in the selected rendering set (in the Redline Options category of
the Rendering Sets Manager). Even if the rendering set does NOT have the Include
Redline Options Summary parameter selected, when Workshare Compare performs an
auto retry the Redline Options Summary is always displayed after the comparison.

The Redline Options Summary indicates which settings Workshare Compare disabled in
order to perform the comparison. For example:

Redline Options Summary

Option: Status:
Redline Statistics at End of Document ON
Include Redline Comparison Summary OFF
Show Line Numbering OFF
Show Change Numbers OFF
Show Change Bars on Left ON
Show Hidden Text OFF
Detect List Numbering Changes ON
Compare Headers/Footers ON
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Redline Options Summary

Compare Footnotes SET OFF
Display Compare Footers OFF
Ignore Embedded Objects/Images OFF
Compare at Character Level OFF
Compare Numbers at Character Level OFF
Show Moved Deletions OFF
Show Changes to Spaces OFF
Show Paragraph Changes OFF
Ignore Case Changes OFF
Ignore Textboxes SET ON
Ignore Field Codes OFF
Ignore Tables OFF

Note: The comparison may take longer than usual because Workshare Compare is
attempting to compare using different settings.

The status indications are as follows:
ON This setting is selected and was applied during the comparison.
OFF This setting is not selected and was not applied during the comparison.

SET ON This setting was not selected but was enabled by Workshare Compare
and applied during the comparison.

SET OFF This setting was selected but was disabled by Workshare Compare and
not applied during the comparison.

If Workshare Compare cannot complete the comparison even using reduced settings,
failsafe mode is invoked.

Failsafe mode

If Workshare Compare is unable to complete the comparison and auto retry mode is
disabled, or if Workshare Compare cannot complete even a reduced comparison in auto
retry mode, then failsafe mode is invoked. Failsafe mode means that Workshare Compare
performs a text-only comparison, comparing only the text in a document and not the
formatting or styles.
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You can manually invoke failsafe mode so that a text-only comparison is performed. You
may want to do this if, after a full comparison, your redline was not fully shown in
Workshare Compare for any reason. Additionally, you may want to do this if you are more
interested to see text changes rather than formatting and style changes.

To manually invoke failsafe mode:

Before running the comparison, select Text Only as the Comparison Mode in the
Compare Documents dialog.

Workshare Compare Main Window

The Workshare Compare main window enables you to view redlines - the results of a
comparison between an original document and a modified document. You can view (in one
work area) both source documents, the redline and a summary of the changes between
the two source documents.

Quick Access Toolbar

Redline Tabs Ribbon
File Menu
0 iy (= _"_ @:‘ ® ‘Weorkshare Compare - Sample Qriginal Document-Sample Modified Dogument - o x
HOME MORE

. —

™ SN & el =) 6

. a @ @ 14 First T_k ;-

=1 Last

Ne‘w. Save Saveto Share; Email Brint I.;Iuse FDF \i.varu _ﬂmgg Search Previous Mext . Select  Edit Se[e‘c‘l‘
Comparison As= My Files~ - - - An - Summary == Specific - -
New Comparisor document Conmvert Change Navigation Comparison Theme:  Layout
Sample Original Document-Sample... x -
Change Summary ~ & x Source Documents v X
Changes i Search | Orignal: fie://C:\... Modules\Sample Original Document. doc Modified: file:/]C: ... Modules\Sample Modified Document.doc
O Categary View (0 List View © Status View || Dagr Sirs. 1| Dear SirMadam, 3
Accapt  Category
= = PROPOSED QUALITY BONDS PLC ISSUE PROPOSED QUALITY BONDS PLC ISSUE
4. M1 Nombering thanges b unread) BY QUALITY BONDS PLC ISSUER PLC |BY QUALITY BONDS PLC ISSUER PLC
J a5 §.-Our comfort letter wil [“‘he |55UEI’") t“the Issuer”)
2 G __¥-For the avoidance of ¢
[ 26 27 Unless atherwise sg || Introduction Introduction

B 33, Ad=The terms and cond hd -
o A__b-the [insert datesofm| || *
| Punctuation Changes (2 unread)
| Matching Changes (25 unread) [Date] I
| Footnote Changes (6 unread)

|| Uncategorized Changes (28 unread Dear SiesSilladam,
PROPOSED QUALITY BONDS PLC ISSUE BY QUALITY BONDS PLC ISSL
(“the Issuer")
n J : ’ . 1 jucti n
(<3 m ] »
Change Summary Window Redline Document Source Documents Window

When you select to run multiple comparisons, each resulting redline is displayed in an
individual tab.

30



Comparing Documents

Moving and placing windows

The Source Documents window and the Change Summary window can easily be moved
to different positions in the Workshare Compare main window according to individual
preference.

Left-click the title bar of the Source Documents window or Change Summary window and
then drag the window to your preferred position. The selected window will float over the
workspace.

To dock a window:

Left-click the title bar of a floating window and keep the mouse button pressed. Positioning
arrows appear at the top, bottom, left and right of the Workshare Compare main window,
as well as in the center.

Change Summary  —
Changes | Search — I

@ Category View () List View () Status View

Accept  Category
I [l Numbering Changes (5 unread)

I [F] Punctuation Changes (2 unread)
|

Matching Changes (25 unread) |_.ALONE BONDS
Footnote Changes (6 unread)

Uncategorized Changes (28 unrsad) =
0 ig e Ji

— agraph 2 below)

EEO

( BONDS PLC ISSUER PLC

-

Introduction

Move the mouse pointer over the required positioning arrow and release the mouse
button. The window is docked in the selected location. For example, dragging the Change
Summary window over the left positioning arrow will dock the Change Summary window
down the left side of the Workshare Compare main window.

To hide a window:

Click * in the top right corner of the Source Documents window or the Change Summary
window or use the options in the Layout group on the Home tab.
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To auto-hide a window:

Click * in the top right corner of the Source Documents window or the Change Summary
window. The selected window is hidden with just a tab remaining.

For example, if the Change Summary window is displayed on the left side of the

Workshare Compare main window:

5. Click *, the Change Summary window is hidden with just a tab displayed on the

left side.

6. Hover over this tab, the Change Summary window is displayed again and you can

work in it as required.

7. Click elsewhere, for example in the redline, the Change Summary window is

automatically hidden again.

. Sample Original Document-Sample... X |
Change Summary

==

@ Category View () List View () Status View

Accept Category |

¢ [_] Numbering Changes
I [l Punctuation Changes

ource Documents
¢ [7] Matching Changes (2 s,

: Sample Originﬂ Document-Sample...

: file://C: \Program Files\Workshare Module:

x

"] Footnote Changes (6
I [ Uncategorized Chan

)Dear Sirs,

Geuuns afueyn

Eﬁﬁfgﬁu =T

@E

Matching Changes (25 unread)
Footnote Changes (6 unread)
Uncategorized Changes (28 unread)

S Change Summa v &
Introduction | & B&: Yy
® | Changes |Search |
1. This an € _ .
g ® Category View () List View © Status View
3 Accept Category
"] Numbering Changes (5 unread)
] Punctuation Changes (2 unread)

To turn off auto-hide, click +
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Quick access toolbar

(in] il o0

The quick access toolbar provides one-click access to popular functionality. By default, the
New Comparison, Open Comparison, Save and Save As buttons are included in the
quick access toolbar. By clicking the arrow to the right of the quick access toolbar, you can

customize it as follows:

Customize Quick Access Toolbar
v MNew Comparison
v  Open Comparison
v Save
W

Save As...

More Commands...

Show Below the Ribbon

Minimize the Ribbon

Select/deselect the New Comparison, Open
' Comparison, Save or Save As options to display/hide
| these options in the quick access toolbar.

' Select More Commands to add additional options to the
quick access toolbar.

- Select Show Below the Ribbon to display the quick
' access toolbar below the ribbon.

- Select Minimize the Ribbon to hide the details of the
+ ribbon until you click the Home, Review or View tabs.

Note: To change the commands that appear in the quick access toolbar, right-click in the
ribbon and select Customize the Ribbon. Refer to Customize the Workshare ribbon.

File menu

Clicking File displays a menu with the following options:

Option

Description

New Comparison

Opens the Compare Documents dialog enabling you to
perform a new comparison. Refer to Launching
Workshare Compare from your desktop.

Open Comparison

Enables you to open a saved comparison. Comparisons
are saved as Workshare DeltaFiles (.WDF). Refer to
Opening saved Workshare DeltaFiles.

Save Enables you to save the current comparison. Refer to
Saving redlines.
Save As Includes the following sub-options:

Comparison
document

Enables you to save the redline as a WDF, DOC,
DOCX, TXT, RTF, HTM or PDF file. Refer to Saving
redlines.
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Option

Description

Word document with
Track Changes

Enables you to save the redline as a DOCX document
with the changes shown as track changes. Refer to
Saving redline as track change document.

Save to My Files

Includes the following sub-options:

As Comparison
document

Enables you to save the redline to Workshare online as
a WDF, DOC, DOCX, TXT, RTF, HTM or PDF file.
Refer to Saving redlines to Workshare online.

As Word document

Enables you to save the redline to Workshare online as

with Track Changes a DOCX document with the changes shown as track
changes. Refer to Saving to Workshare online as track
change document.
Share Includes the following sub-options:
As Comparison Enables you to share the redline to a group in
document Workshare online as a WDF, DOC, DOCX, TXT, RTF,

HTM or PDF file. Refer to Sharing redlines to
Workshare online.

As Word document

Enables you to share the redline to a group in

with Track Changes Workshare online as a DOCX document with the
changes shown as track changes. Refer to Sharing to
Workshare online as track change document.
Email Includes the following sub-options:

Attach as PDF

Converts the redline to PDF and opens a new email
window with the PDF attached. Refer to Sending by
email.

Attach as PDF (only
pages with changes)

Converts the changed pages in the redline to PDF and
opens a new email window with the PDF attached.
Refer to Sending by email.

Attach as Word
document with Track
Changes

Converts the redline to a Word document with the
changes shown as track changes and opens a new
email window with the document attached. Refer to
Sending by email as track change document.

More email Enables you to select which documents from the

options.... comparison to email and in what format. Refer to
Sending by email.

Print Enables you to print the redline and includes the

following sub-options: Refer to Printing redlines.

Comparison only

Enables you to print the redline.

Comparison +
Modified

Enables you to print the redline and the modified source
document.
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Option Description
Comparison + Enables you to print the redline, the modified source
Modified + Original document and the original source document.

Print Preview Enables you to preview the print output and includes the

following sub-options:

Comparison only Enables you to preview the redline.
Comparison + Enables you to preview the redline and the modified
Modified source document.
Comparison + Enables you to preview the redline, the modified source
Modified + Original document and the original source document.

Help Includes the following sub-options:
Help Provides access to online help.
About Displays version and copyright information about

Workshare Compare.

Keyboard shortcuts Displays a list of keyboard shortcuts available in
Workshare Compare.

License Displays information about your Workshare Compare
license in the My Products page of the Workshare
Configuration Manager.

Workshare Config Opens the Workshare Configuration Manager where, if
Manager you have permission, you can configure system
parameters. Refer to Infroducing the Workshare
Configuration Manager for further information.

Exit Workshare Closes the Workshare Compare application. You are
Compare prompted to save any open redlines.
Home tab

The Home ribbon provides access to key functionality in Workshare Compare.

FILE HOME MORE

I N |_j 57| =a uj @ @ = 14 First =~ A | T
=1 FE® o 2 [

T @ &l ] &8 i e | = [EY | [

Mew Save Saveto Share Email Print  Close PDF  Word Change Search Previous MNext Select  Edit Sel

Comparison As~  MyFiles~ = - All summary == Specific
Mew Comparison document Convert Change MNavigation Comparison Themes  Layout
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The options are described in the following table.

Group

Option

Description

New

New
Comparison

Opens the Compare Documents dialog enabling you
to perform a new comparison. Refer to Launching
Workshare Compare from your desktop.

Comparison
document

Save As

Includes the following sub-options:

Comparison

Enables you to save the redline as a WDF, DOC,

document DOCX, TXT, RTF, HTM or PDF file. Refer to Saving
redlines.

Word Enables you to save the redline as a DOCX

document document with the changes shown as track changes.

with Track Refer to Saving redline as track change document.

Changes

Save to My Files

Includes the following sub-options:

As Enables you to save the redline to Workshare online
Comparison as a WDF, DOC, DOCX, TXT, RTF, HTM or PDF file.
document Refer to Saving redlines to Workshare online.
As Word Enables you to save the redline to Workshare online
document as a DOCX document with the changes shown as
with Track track changes. Refer to Saving to Workshare online
Changes as track change document.

Share Includes the following sub-options:
As Enables you to share the redline to a group on
Comparison Workshare online as a WDF, DOC, DOCX, TXT,
document RTF, HTM or PDF file. Refer to Sharing redlines to

Workshare online.

As Word Enables you to share the redline to a group on
document Workshare online as a DOCX document with the
with Track changes shown as track changes. Refer to Sharing to
Changes Workshare online as track change document.

Email Includes the following sub-options:
Attach as Converts the redline to PDF and opens a new email
PDF window with the PDF attached. Refer to Sending by

email.

Attach as Converts the changed pages in the redline to PDF
PDF (only and opens a new email window with the PDF
pages with attached. Refer to Sending by email.
changes)
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Group Option Description
Attach as Converts the redline to a Word document with the
Word changes shown as track changes and opens a new
document email window with the document attached. Refer to
with Track Sending by email as track change document.
Changes
More email Enables you to select which documents from the
options... comparison to email and in what format. Refer to
Sending by email.
Print Enables you to print the redline and includes the
following sub-options: Refer to Printing redlines.
Comparison Enables you to print the redline.
only
Comparison + | Enables you to print the redline and the modified
Modified source document.
Comparison +  Enables you to print the redline, the modified source
Modified + document and the original source document.
Original
Close All Closes all open comparisons.
Convert PDF Enables you to convert the redline to PDF. Refer to
Converting redline to PDF.
Word Includes the following sub-options:
Open in Word | Opens the redline in Microsoft Word where you can
edit it. Refer to Editing redlines.
Open in Word | Opens the redline in Microsoft Word with the changes
with Track converted to track changes so you can implement
Changes changes using track changes functionality. Refer to
Showing changes as track changes.
Change Change Displays/hides the Change Summary window.
Navigation | Summary
Search Displays the Search tab in the Change Summary
window enabling you to search for specified text or
keywords in the redline and source documents.
Previous Navigates to the previous change and highlights the
entire change in the redline. Refer to Navigating
between changes.
Next Navigates to the next change and highlights the

entire change in the redline. Refer to Navigating
between changes.
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Group

Option

Description

First

Navigates to the first change and highlights the entire
change in the redline. Refer to Navigating between
changes.

Last

Navigates to the last change and highlights the entire
change in the redline. Refer to Navigating between
changes.

Specific

Enables you to navigate to a specific change
number. The entire change is highlighted in the
redline. Refer to Navigating to a specific change
number.

Comparison
Themes

Select

Enables you to select a different rendering set from
the dropdown list and Workshare Compare
automatically re-runs the comparison applying the
selected rendering set. Refer to Introducing
Rendering Sets.

Edit

Opens the Rendering Sets Manager where you can
apply different rendering sets to a comparison and, if
you have permission, you can add, edit and delete
rendering sets. Refer to Infroducing Rendering Sets.

Layout

Select

Enables you to select what is displayed in the
Workshare Compare window.

Comparison
only

Hides the Source Documents window and displays
the redline only.

Comparison +
Original

Displays the redline as well as the original document
in the Source Documents window.

Comparison +

Displays the redline as well as the modified

Modified document in the Source Documents window.
Comparison +  Displays the redline as well as both source
Original + documents.

Modified
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The More ribbon provides access to other useful functionality.

More tab
Home Maore
|
Swap Comparison
Mode~
Criginal/Modified Maode

®

Help

-

Info

The options are described in the following table.

Group Option Description
Original/ | Swap Swaps the original and modified documents. Refer to
Modified Swapping the source documents.
Mode Comparison Enables you to select a comparison mode from the
Mode dropdown list and Workshare Compare automatically re-
runs the comparison in the selected mode — Fast,
Standard, Text Only or Image Based PDF.
Info Help Includes the following sub-options:
Help Provides access to online help.
About Displays version and copyright information about
Workshare Compare.
Keyboard Displays a list of keyboard shortcuts available in
Shortcuts Workshare Compare.
License Displays information about your Workshare Compare

license in the My Products page of the Workshare
Configuration Manager.
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Customize the Workshare ribbon

To change the commands that appear in the Workshare Compare ribbons and quick
access toolbar, right-click in the ribbon and select Customize the Ribbon.

Workshare 10.0 *
Quick Access Toalbar Choose commands from: Customize the Ribbon:
Customize Ribbon Fle v [Main Tabs v
About ~ Main Tabs

% As Comparison document > [ Home

¢ As Comparison document 4

L+ As Word document with Track Char b Original/Modified

[} As Word document with Track Char [ Mode

[ Attach as PDF  Info

&1 Attach as PDF {only pages with cha
&1 Atach as Word document with Trac

1 F
& Email v
O b :
Help iz
(@) Help ;

Keyboard Shortcuts
License
.JLT:! New Comparison
E Open Comparison
=1 Print 3
I=] Prirt Comparison
E3 Print Comparison + Modffied

I=) Print Comparison + Modified + Origin ,, ennl Finann IEan
A = | St (e | R e
Keyboard shortcuts: [ Customize... Customizations: |  Reset

Corcal | [ b

To customize the Compare environment to suit your needs, you can select which
commands to include in the Home and More tabs or add new tabs.

The redline

The DeltaView redline shows the results of the comparison between the original document
and the modified document. Changes are marked according to the rendering set applied to
the comparison. For example, deleted text could be red-and-struck-through and added text
could be blue and underlined.

You can navigate between the changes in the redline and accept/reject the changes to
create a new and revised document. You can also save the redline locally, or to your DMS
or to Workshare online. All of these options are described in Working with Redlines.
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Redline tabs

/ Sample Original Document-Sample... xr Sample Criginal Document-Draft R...

When the original document has been compared against multiple modified documents,
each resulting redline is displayed in a different tab. Select the tab header to display the
comparison in the Workshare Compare window. You can also display the tabs
simultaneously side by side by clicking and dragging the tab header across the Workshare
Compare window.

A Sample Original Document-Sample... XI - 7 Sample Criginal Document-Draft R... XI

|

DRAFT ARRANGEMENT LETTEF ‘ About This Guide

Redline right-click menu

Right-clicking text or changes in the redline displays a popup menu, providing rapid access
to some of the more commonly used tools.

Option Description

Copy Copies selected text to the clipboard.

Select All Selects all the content of the redline.

Find Displays the Search tab in the Change Summary window enabling you to
search for specified text or keywords in the redline and source
documents.

Find Next When you have specified text or a keyword in the Search tab, navigates

to the next occurrence of the specified search text or keyword.

Edit redline | Opens the redline in Microsoft Word where you can edit it. Refer to

Editing redlines.
Convert to Opens the redline in Microsoft Word with the changes converted to track
Track changes so you can implement changes using track changes
Changes functionality. Refer to Showing changes as track changes.
Zoom Enables you to change the display of the redline from 20% to 200% of its
original size.
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Link to
Move

Link to
Change

Comparing Documents

Description

When text has been moved to another position, navigates and highlights

the text in its new or previous position in the redline.

« When right-clicking text in its new position, clicking Link to Move
highlights the text in its previous position.

« When right-clicking text in its original position, clicking Link to Move
highlights the text in its new position.

You must right-click a move-type change for this option to be available.
Jumps to the redline Summary (at the end of the redline) highlighting the

selected change. You must right-click a change for this option to be
available.

Note: The Include Redline Comparison Summary parameter
(Redline Options category of the Rendering Sets Manager) must be
selected in the applied rendering set.

Redline comparison summary

At the beginning or end of the redline, you can see a summary of the comparison and a list
of the changes found.

In order for the redline to include this summary, the Include Redline Comparison
Summary parameter in the Redline Options category of the Rendering Sets Manager

Redline Summary:

No. Change Text

1-2 Change "Dear Sirs," changed to "Dear SirfMadam"

3 Deletion 5 The Lead Manager...with the proposed
Issue.

4 Insertion 5.
"6. Our comfort letter will be provided”

5 Change changed to "Our comfort letter will be
provided"

6 Insertion 6.
"7. Forthe avoidance of doubt, nothing"

7 Change changed to "For the avoidance of doubt,
nothing"

must be selected in the applied rendering set.
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Change Summary window

The Change Summary window provides a list of changes found between the source
documents. Selecting a change highlights the change in the redline and displays the
position of the change in both the source documents. From the Change Summary window,
you accept and reject changes. Refer to Reviewing changes.

You can hide/display the Change Summary window by clicking Change Summary in the
Home tab.

Tip! The Change Summary window is by default positioned down the left side of the
Workshare Compare environment. It can be moved as required. Refer to Moving and
placing windows.

The Change Summary window includes two tabs — Changes and Search — and the
Changes tab has three views. These are described in the following sections.

Changes tab Category View

Changes | Search

@ Category View ) List View () Status View

Accept  Category

4 Numbering Changes {5 unread)

o 8-Cur comfort letter will be |
b, +-For the avoidance of doub
26, 2T Unless otherwise specific
33 2&-The terms and condition:
f Bthe [insert dates of manag

BEEEE

Punctuation Changes (2 unread)
Matching Changes (29 unread)
Footnote Changes (2 unread)
Endnote Changes (1 unread)
Header Changes (1 unr=ad)

Footer Changes (2 unread)
Uncategorized Changes (31 unread)

OEEDE @M

| m | b

Apply Accepted Changes
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The Changes tab, Category View displays all the changes between the original document
and the modified document according to the type of change. The changes can be grouped
into any of the following categories:

Numbering Changes: Any changes to numbering lists identified in a document.

Whitespace Changes: Changes that only involve whitespace — ie deletion/insertion
of spaces or tabs, or a space changing to a tab or 3 spaces changing to tabs.

Capitalization Changes: Any changes to the capitalization of a word.
Punctuation Changes: Any changes to a punctuation mark.

Spelling Corrections: Changes where a single word replacement includes the
deletion of a word that is not a dictionary word and the insertion of a dictionary word
in its place. The replacement word must also be a spell check suggestion for the
replaced word — for instance replacing ‘recieve’ with ‘receive’.

Word Variations: Changes which involve changing the form a word ie replacing
‘confirms’ with ‘confirmed’ — the two words (original and replacement) must come
from the same stem word and just have different endings.

Matching Changes: Changes that are repeated and identical.

Suggested Changes: Changes that a reviewer could have neglected to make. For
example, there are 400 instances of “ACME INC” in the original document but the
reviewer has only changed 399 of these to “Workshare Inc”. The Suggested
Changes category will indicate that there is 1 change that might have been missed.

Style Changes: Changes made to styles in a document.

Font Changes: Changes made to font type, font style, font colour, underline style,
underline color and font effects.

Footnote Changes: Any changes in the footnotes of a document.
Endnote Changes: Any changes in the endnotes of a document.
Header Changes: Any changes in the headers of a document.
Footer Changes: Any changes in the footers of a document.

Placeholder Changes: Blocks of placeholder text that are found to be matching
between the original and modified documents. While these are not changes
between the two documents as such, they highlight areas where the editing of the
document may be incomplete. Typical blocks of placeholder text might be ‘[Client
Name], [Company Address] etc.

Boilerplate Changes: Changes that occur inside blocks of boilerplate text. These
changes merit special attention as in general boilerplate text should not be
modified. Note that the change is only marked as a boilerplate change if it is found
inside an occurrence of one of the boilerplate text items in the original document.

Comment Changes: Changes that have been made to comments.

Uncategorized Changes: Changes that do not fall into any of the above groups.
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Changes tab List View

m The Changes tab, List View displa_y§ all
the changes between the original
) Category View @ List View © Status View document and the modified document in
# O Y R the order that they occur. The following
1 = & M@MH information is shown for each change:
- 1,54 o adbmeesuda #: The number of the change in the
3 1,35 [ Add reference number document. A change may have two
4-5 113 [l Dear SirsSiiMadam, numbers when it includes two actions.
6 1,50 [l the Lead Manager confi For example, a deletion and an addition.
7 1,50 [[] LThiswill vary .
i N E s n i Page, Line: The page number and the
' line number in the original document
9 2,13 5 & Our comfort
= = , where the change occurs.
10 241 El B, F-For the avoic
1 2,25 E s T Accept: Whether you accept the
12-13 2.2 [ Z___Any such clail _ change or not.
- — ~ ) v Change Text: Details of the change.

Changes tab Status View

m The Changes tab, Status View

displays all the changes between the

© Category View (O List View ® Status View original document and the modified

4 Accepted document according to their review

5. 6.0ur comfort letter will be provided status — Accepted, Not Accepted or

I Mot Accepted Flagged. When you have selected the

4 Flagged checkbox to the left of a change, it
[J ¥ Add.company and date appears under Accepted.

E 33 & The terms and conditions,

. m | ¥
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The Search tab enables you to search

[[] Ignore Case

date

[Search changed text only Search |

|
m | b

# Pageline  Accept Change Text
1 11 ¥ Add company and date
40-41 5,2 [E] ._The audit opinion is valid
55 - 56 6,7 [l Weintend to provide you w
131 14,27 [E] Our work did not extend to t

for changes in the redline that include a
specific keyword or text. Refer to
Searching for changes.

Source Documents window

The Source Documents window is where you can view the documents that have been
compared. You can select (from the Layout group in the Home tab) to display the original
document, the modified document or both documents in the Source Documents window.

Source Documents

Original: file: f/C:\Program Files\Workshare Modules\Sample Criginal Document.doc Modified: file: f/C:\, .. \WorkshareYModules\Sample Modified Document. doc

e

Comfort Letter
7 The Lead Manager confirms that, in connection | |
with the proposed issue of the Securities, it is
aware of guidance relating to due diligence issued

by the International Primary Market Association
from time to time, which will be followed by it in
connection with the proposed issue.

Cur comfort letter will be provided to the

addressees of this letter solely in the context of
the due diligence procedures that you undertake,
or procure to be undertaken, pursuant to the
guidance referred to in paragraph 5 above in
connection with the contents of the offering
circular for the purpose of any due diligence
defence that you may wish to advance in

2

Comfort Letter

Our comfort letter will be provided to the
addressees of this letter solely in the context of
the due diligence procedures that you undertake,
or procure to be undertaken, pursuant to the
guidance referred to in paragraph 5 above in
connection with the contents of the offering
circular for the purpose of any due diligence
defence that you may wish to advance in
connection with the contents of the offering
circular.  Accordingly our comfort letter will be
addressed to you for that purpose and may not be
relied on by you for any other purpose.

For the avoidance of doubt, nothing in paragraph
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You can scroll through both documents. Selecting a point in one source document
automatically scrolls the other source document as well as the redline to the same point.
The source documents are read-only and cannot be modified in any way. The name of the
source document is shown above the document.

Tip! The Source Documents window is by default positioned across the top of the
Workshare Compare environment. It can be moved as required. Refer to Moving and
placing windows.

Right-clicking text in the original document or the modified document displays a popup
menu, providing rapid access to some of the more commonly used tools.

Option Description

Copy Copies selected text to the clipboard.

Select All Selects all the content of the original or modified document.

Find Displays the Search tab in the Change Summary window enabling you
to search for specified text or keywords in the redline and source
documents.

Find Next When you have specified text or a keyword in the Search tab, navigates
to the next occurrence of the specified search text or keyword.

Zoom Enables you to change the display of the original or modified document
from 20% to 200% of its original size.

Working with Redlines

This section describes the tools available to you when working with the DeltaView redline
after a comparison.

Navigating changes

After performing a comparison, you can review the redline (the result of the comparison)
and look through the changes between the original and modified documents. You can
move between changes in the redline by jumping from change to change or searching for
a specific change using change numbers or keywords. You can also accept or reject the
changes and create a new document based on your decisions — refer to Reviewing
changes.
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Navigating between changes

Selecting a change in the Change Summary window highlights the change in the redline
and displays the position of the change in both of the source documents.

Click Previous in the Home tab to move to the previous change and highlight the
entire change in the redline. Click First to move to the first change in the redline.

Click Next in the Home tab to move to the next change and highlight the entire
change in the redline. Click Last to move to the last change in the redline.

Navigating to a specific change number

Changes are allocated numbers, which are displayed next to the change in the Change
Summary window. A change may have two numbers when it includes two actions, for
example, a deletion and an addition. You can move to a specific change number in the

redline.

To navigate to a specific change number:

1.

4.
5.

Click Specific in the Home tab. The following dialog is displayed:

Workshare Compare *

Enter the change number to go to within the current document.,

Change Mumber: | |

In the Change Number field, enter the number of the change you want to display
in the redline.

Click Go To. The entire change is highlighted in the redline.
Repeat steps 2 and 3 to navigate to further changes as required.

Click Close to close the dialog.

Tip! To maximize this feature, apply a rendering set with the Show Change Numbering
parameter selected in the Redline Rendering category, Change Numbering section. This
shows all the change numbers against each change in the redline, for example,

Dear Sks'SivMadam ?

48




Comparing Documents

Searching for changes

You can search for changes in the redline that include a specified keyword or text.
Workshare Compare can search only the changes for the specified text or it can search
the text of the original or modified documents.

To search for a change:

1. In the Change Summary window, select the Search tab or click Search in the
Home tab.

2. In the text box at the top of the Search tab, enter the search criteria — the word or
words for which you want to search.

3. If the case is not important, select the Ignore Case checkbox.

4. Select where you want to search from the dropdown list. The options are as
follows:

o

o

Search changed text only: Searches through all text in the redline that has
been changed.

Search text near a change: Searches through all text in the redline that has
been changed and also text that is within 100 characters of a change.

Search Original Document text: Searches through all text in the original
document.

Search Modified Document text: Searches through all text in the modified
document.

Search all Redline text: Searches through all text in the redline.

5. Click Search. A list of changes that include the specified word or words is
displayed in the lower text area.

Change Summary v 3%
Changes | Search
comfort letter Ignore Case
| Search changed text only x | I Search
# Pageline Accept Change Text
472 - 45 5.9 g il be-nacassany
49-51 5,27 B 2 We shall answer qui
Bs-88 83 O e The geidwhichizat
04 93 [E] Deaf Comiast Latiar
a5 9.4 [C] DRAFT COMFORT LETTER
131 14, 27 [ Qurwork did notextend to t
< | m ¥

Selecting a change in the search results highlights the change in the redline and displays
the position of the change in both the source documents.
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Reviewing changes

You can accept and reject changes from within Workshare Compare and create a new
Word document that includes all your changes. Changes can be accepted/rejected
individually or as a group. Using the Category View of the Changes tab, you can choose
to accept or reject an entire category. For example, the Matching Changes category
includes changes that are repeated and identical and you can accept or reject them all at
one time. Switching to Status View provides an easy way to quickly see what changes
haven’t yet been reviewed.

To accept/reject changes:

1. Review the changes that you care about and mark them in any of the following
ways:

o In the Change Summary window, select the checkbox to the left of an individual
change to accept it.

= In Category View, select the checkbox to the left of a category to accept all
changes in that category.

Tip! You can select all changes in a category by selecting the category checkbox
and then deselect one or two changes within that category as required.

= Right-click an individual change or a category and select Flag. This is a way to
highlight the change — perhaps for future consideration or to check sources.

= Right-click an individual change or a category and select Mark as Read. This is
a way to indicate that you have reviewed the change but do not want to give it a
status.

Note: To reset a change marked as read, select Mark as Unread from the right-
click menu.

2. When you have completed your review, click Apply Accepted Changes at the
bottom of the Change Summary window. A new Word document is opened with the
changes accepted or rejected according to your selection. You can save this
document as your new master document.

Note: Changes to comments (grouped in the Comments category) will not be
accepted.

The comparison is not altered in any way so you can return to the comparison in
Workshare Compare and change your mind about whether to accept changes or
not. Every time you click Apply Accepted Changes, a new Word document is
opened with the current accept/reject statuses applied.

You can also save the comparison as WDF file and this will save all your selections along
with the source documents and redline document. You can open this WDF at a later time
and continue working or send it a colleague for further review.
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Editing redlines

A redline remains an accurate comparison of two documents and cannot be directly edited
in Workshare Compare. However, you can open the redline in Microsoft Word and edit the
document as required. There are two ways of opening the redline in Word — one where the
changes appear as text and another where the changes appear as track changes.

Showing changes as text

Using this method, changes appear as normal text with just the formatting to identify them.
For example, if the rendering set used in the comparison showed inserted text as red with
a double underline, then the text will appear as red with a double underline in Word.

To open the redline in Word:

1. In the Home tab, click Word and then Open in Word or right-click in the redline
and select Edit redline. The redline is opened in Microsoft Word with the default
name redline.docx. All the changes are displayed as ordinary text but with
formatting marks indicating whether they are additions, deletions and so on.

2. Edit the document as required.

3. Save the document. By default, the document is saved in a temporary folder.

Showing changes as track changes

Using this method, the changes are converted to track changes and you can implement
the changes using Microsoft Word’s track changes functionality.

Note: The converting to track changes functionality is only enabled, if the Enable
Convert to Track Change functionality parameter (Comparison > User Interface
category) in the Workshare Configuration Manager is selected.

To convert to track changes:

1. In the Home tab, click Word and then Open in Word with Track Changes. The
redline is opened in Microsoft Word with all the changes displayed as track
changes.

2. Review the track changes and implement them as required.

3. Save the document. By default, the document is saved in a temporary folder.

Changing the comparison

You can re-run a comparison swapping the source documents, changing the comparison
mode, applying a different rendering set or changing specific comparison options.
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Swapping the source documents

You can re-run a comparison exchanging the original document for the modified document
and the modified document for the original document. For example, if you selected
Document A as the original document and Document B as the modified document,
Workshare Compare compares Document A to Document B and presents the changes
made to Document A. You can then swap the original and modified documents so that
Document B is now the original document and Document A is the modified document.
Workshare Compare automatically re-runs the comparison, comparing Document B to
Document A, and presents the changes made to Document B.

To swap the source documents:

Click Swap in the More tab to swap the source documents. Workshare Compare
automatically runs a new comparison, using the modified document as the original
document and the original document as the modified document. The new redline is
displayed in the same tab replacing the first comparison.

Changing the comparison mode
You can re-run a comparison using a different comparison mode (or type) if required.
To re-run a comparison using a different mode:

In the More tab, click Comparison Mode and then select the required mode from the
following:

o Fast: Workshare Compare performs a fast comparison. When comparing a .DOC
file against another .DOC file, Workshare Compare performs a binary comparison
which is faster than a standard comparison because it is comparison at the binary
level. When comparing a .DOCX file against another .DOCX file, Workshare
Compare performs a faster comparison by converting the documents to DOC
followed by comparison at the binary level.

Note: The Fast option is only available if the Enable fast comparison parameter
(Comparison > Administration category) in the Workshare Configuration
Manager is selected.

« Standard: Workshare Compare performs a regular comparison.

o Text Only: Workshare Compare performs a text-only comparison, comparing only
the text in a document and not the formatting or styles.

» Image Based PDF: Workshare Compare will re-run the comparison and force OCR
processing on scanned/image content. You may want to try this if Workshare
Compare has performed a Standard or Fast comparison and some scanned/image
content has not been converted to text.
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Note: This type of forced’ OCR may be useful when scanned pages are difficult to
detect, for example, when they have lots of annotations on top of the scans like
Bates numbering, etc. or when the text is actually vector output (from a CAD
product for example) and there are no actual characters with fonts in the PDF.

Workshare Compare re-runs the comparison using the selected mode and displays the
resulting redline in the Workshare Compare main window.

Applying a different rendering set
You can re-run a comparison using a different rendering set.
To re-run a comparison with a different rendering set:

1. In the Home tab, click Select in the Comparison Themes group. A list of the
currently defined rendering sets is displayed.

—n e
Select  Edit Select
e -

+  Standard

Standard no calor

Standard no moves

Standard with caret for deletes
Standard with change numbers
Standard with font changes

i Standard with shading

2. Select the rendering set to apply.

Workshare Compare re-runs the comparison using the selected rendering set and displays
the resulting redline in the Workshare Compare main window.
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You can re-run a comparison changing specific options within the rendering set.

To re-run a comparison with different options:

1. In the Home tab, click Edit in the Comparison Themes group. The Rendering Sets

Manager is displayed.

@ Rendering Sets

- [m] x

Rendering Set: | Standard 4 Save

| Search Rendering Options

Comparison Options Comparison Options

Redline Options

Redline Rendering | A Comparison Options
Allow Auto Retry

Detect List Numbering Changes

Compare Headers/Footers
Compare Footnotes

O Compare at Character Level

O Ignore Embedded Objects/images
O Ignore Case Changes

[ Ignore Text Boxes

[ Ignore Field Codes

Compare field contents as text

O Ignore Tables

O Display comments in redline

[ Detect Changes to Images

Select the document features to be compared.

Detect Footnote/Endnote Numbering Changes

O Compare Numbers at Character Level

[ Ignere auto list against manual number list changes

Redline Preview

| Cancel || Help |

2. Edit the rendering set parameters as required. For example, select the Ignore
Tables checkbox. Rendering set parameters are described in Rendering Set

Parameters.

3. Do one of the following:

o Click Apply. Workshare Compare re-runs the comparison using the selected
parameters and displays the resulting redline in the Workshare Compare main
window. Click OK to close the Rendering Sets Manager. Any changes you made

to the rendering set parameters are lost.
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o Click OK. The save dialog is displayed. Enter the name of an existing rendering
set to overwrite a rendering set or enter a new name to create a new rendering
set. Do not use the following characters when naming rendering sets: <, >, :, \, ,
/,\\ or |. Click Yes. Workshare Compare re-runs the comparison using the
revised options and saves the revised options as the specified rendering set.
Click No. Workshare Compare re-runs the comparison using the revised options
and saves the revised options as a temporary rendering set called “Custom
rendering set”.

Note: The “Custom rendering set” will be selected in the Rendering Set dropdown list the
next time the Rendering Sets Manager is opened. However, once you navigate away
from the “Custom rendering set” and a different rendering set is selected and the
Rendering Sets Manager is closed, the “Custom rendering set” is lost.

Distributing redlines

After you have compared your documents, Workshare Compare provides many options for
saving or circulating the redline. Workshare’s DeltaView redline can be distributed in many
formats, such as PDF or TXT or DOCX. Only if it is distributed as a WDF will your ‘Accept’
and ‘Flag’ selections, as well as the source documents, be included. WDF files can only be
opened in Workshare Compare. The redline can also be distributed as a Word document
with the changes shown as track changes. The following sections describe how you can
distribute your redlines:

e Save locally or to your DMS, refer to Saving redlines

o Save to Workshare online, refer to Saving redlines to Workshare online

» Share to Workshare online, refer to Sharing redlines to Workshare online
o Email, refer to Sending by email

o Print, refer to Printing redlines

o Convert to PDF, refer to Converting redline to PDF
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Saving redlines

You can save the redline as a Workshare Compare DeltaFile (WDF), which contains all
three documents (original, modified and redline) as well as your ‘Accept’ and ‘Flag’
selections. You can also save just the redline as a DOC/DOCX, RTF, HTM, TXT or PDF
file or you can save the redline as a track change document.

You can save the redline to your DMS/CRM, SharePoint or locally. The following
procedure describes how to save to NetDocuments as an example.

To save the redline:

1. Click Save As and then Comparison document in the Home tab (or quick access
toolbar or File menu). The following dialog is displayed.

Workshare Compare >

: =

Save
Select the option for saving the selected document

@ What do you want to do with the document?
| Save a Mew Document |

Saves the comparison as a new document or version in
the current document system...

2. Select whether you want to save the comparison as a new document or attach it to
the original or modified documents.
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3. Click OK. The NetDocuments Save As dialog is displayed.

Save As

Acme Ltd » Documents

‘ Add Folder | | Go to Workspace |

X

Search by "Document Na... @ = E

=

© Home
* Recent Documents
4 Recent Locations
1 7| Documents
4 [ Acme Ltd
" [ Recent Workspaces
[ Favorite Workspaces
|7 Folders
b . Demo Dave
4 . Documents
[& Recent Workspaces
" |5 Favorite Workspaces

~

Name
1_: Redmond MCP WP_Why Customers Use Box with...
f_;:] ND Original
2| ND Modified 2

@ ND Modified 1
@ Modified DOC - Original DOCX

Date Medified -

07/07/201511:02
27/04/2015 13:51
27/04/2015 13:51
27/04/2015 13:50
23/04/2015 21:44

Document 1D
4823-8387-3829
4850-0968-9635
4848-5869-4691
4846-7414-3315
4810-8126-1859

Type

Adobe Acroba...
Microsoft Wer...
Microsoft Wor...
Microseft Wor...
Microsoft Wor...

File name: |ND Original - ND Maodified 1

Save as type: I Adobe Acrobat File ( *.pdf)

Profile Templates

Client: Click to edit

Save as new version ‘Description

Matter: Click to edit

DocType: Click to edit

|« Official version

s | (oo

Notes:

displayed.

If you are not working with a DMS or SharePoint, the LocalStore Save As dialog is

If you click Cancel in the DMS save dialog, a message is displayed asking if you
would like to save the redline locally.

Tip! If you are working with a DMS or SharePoint but both documents compared
are local documents, then you can press the Shift key while clicking Save and the
LocalStore Save As dialog is displayed.

name of the comparison as required.
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5. From the Save as type dropdown list, select the format for the saved file from the
following:

Workshare DeltaFile Saves both the redline and the source documents, as

(*.wdf) well as your ‘Accept’ and ‘Flag’ selections, as a
Workshare DeltaFile. This file can only be opened in
Workshare Compare.

Word Document Saves the redline as a Microsoft Word file. The source

(*.doc/*.docx) documents and your ‘Accept’ and ‘Flag’ selections are
not saved.

Text Only (*.txt) Saves the redline as a text file. The source documents
and your ‘Accept’ and ‘Flag’ selections are not saved.

Rich Text Format Saves the redline as an RTF file. The source

(*.rtf) documents and your ‘Accept’ and ‘Flag’ selections are
not saved.

HTML Document Saves the redline as a HTML document. The source

(*.htm) documents and your ‘Accept’ and ‘Flag’ selections are
not saved.

Adobe Acrobat File  Saves the redline as a PDF file. The source

(*.pdf) documents and your ‘Accept’ and ‘Flag’ selections are
not saved.

Adobe Acrobat Saves the redline as a PDF/A file. The source

PDF/A File (*.pdf) documents and your ‘Accept’ and ‘Flag’ selections are
not saved.

6. Click Save.

Saving redline as track change document

You can also save the redline as a Microsoft Word file that shows the changes as track
changes.

Note: The converting to track changes functionality is only enabled, if the Enable
Convert to Track Change functionality parameter (Comparison > User Interface
category) in the Workshare Configuration Manager is selected.

To save redlines with changes as track changes:

1. Click Save As and then Word document with Track Changes in the Home tab (or
quick access toolbar or File menu).

2. Select whether you want to save the comparison as a new document or attach it to
the original or modified documents.

3. Click OK. The NetDocuments Save As dialog is displayed.

4. Browse to the location where you want to save the track change document and
modify the name of the document as required.
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5. Click Save. The redline is saved as a Microsoft Word document with the changes
indicated by track changes.

When you open the saved file in Microsoft Word, the changes are displayed as track
changes.

Opening saved Workshare DeltaFiles

When a comparison has been saved as a Workshare DeltaFile, you can open it from
Workshare Compare.

To open a saved comparison:

1. Click Open Comparison from the File menu. An Open dialog is displayed.

Note: Clicking Open when you work with a DMS/CRM or SharePoint accesses the
DMS/CRM or SharePoint. To open from a local or network drive, hold the Shift key
down when clicking Open or click Cancel in the DMS/CRM or SharePoint open
dialog.

2. Navigate to the location where the comparison is saved and select the WDF file
you want to open.

3. Click Open. The selected comparison is opened in Workshare Compare. The
source documents and the redline are displayed as well as any ‘Accepted’ and
‘Flagged’ selections you made in the Change Summary window.

Saving redlines to Workshare online

If you work with Workshare online, you can save redlines there so they will be accessible
to you online at all times.

You can save the redline as a Workshare DeltaFile (WDF), which contains all three
documents (original, modified and redline) as well as your ‘Accept’ and ‘Flag’ selections.
You can also save just the redline as a DOC/DOCX, RTF, HTM, TXT or PDF file or you
can save the redline as a track change document.

Note: You can also use Save As and save the redline to your Workshare sync folder and
it will be synchronized to Workshare online. Refer to Adding files to Workshare.
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To save the redline to Workshare online:

1. Click Save to My Files and then As Comparison document in the Home tab (or
File menu). The Save to My Files dialog is displayed.

€3 saveto My Files — O x
& Create new folder
4 @ @ My Files
() 2 Work in Progress
O B 550
) &3 Private
) = Draft Contracts
File name: iSample Original Document - Sample Mudrﬁedi
Save as type: | Adobe Acrobat File { *.pdf) v |

2. Browse through My Files and select the folder where you want to save the
comparison.

Note: To create a new folder, click Create new folder, enter a name for the folder
and click Create.

3. In the File name field, modify the name of the comparison as required.
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4. From the Save as type dropdown list, select the format for the saved file from the

following:

Workshare DeltaFile Saves both the redline and the source documents, as

(*.wdf) well as your ‘Accept’ and ‘Flag’ selections, as a
Workshare DeltaFile. This file can only be opened in
Workshare Compare.

Word Document Saves the redline as a Microsoft Word file. The source

(*.doc/*.docx) documents and your ‘Accept’ and ‘Flag’ selections are
not saved.

Text Only (*.txt) Saves the redline as a text file. The source documents
and your ‘Accept’ and ‘Flag’ selections are not saved.

Rich Text Format Saves the redline as an RTF file. The source

(*.rtf) documents and your ‘Accept’ and ‘Flag’ selections are
not saved.

HTML Document Saves the redline as a HTML document. The source

(*.htm) documents and your ‘Accept’ and ‘Flag’ selections are
not saved.

Adobe Acrobat File  Saves the redline as a PDF file. The source

(*.pdf) documents and your ‘Accept’ and ‘Flag’ selections are
not saved.

Adobe Acrobat Saves the redline as a PDF/A file. The source

PDF/A File (*.pdf) documents and your ‘Accept’ and ‘Flag’ selections are
not saved.

5. Click Save.

Saving to Workshare online as track change document

You can also save the redline to Workshare online as a Microsoft Word file that shows the
changes as track changes.

Note: The converting to track changes functionality is only enabled, if the Enable
Convert to Track Change functionality parameter (Comparison > User Interface
category) in the Workshare Configuration Manager is selected.

To save redlines to Workshare online with changes as track changes:

1. Click Save to My Files and then As Word document with Track Changes in the
Home tab (or File menu).

2. In the Save to My Files dialog displayed, select a folder in My Files (or create a new
one), specify a name for the track change document and click Save. The redline is
saved as a Microsoft Word document with the changes indicated by track changes.
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Sharing redlines to Workshare online

When you work with Workshare online, you can share redlines to groups there so you can
collaborate on them with others.

You can share the redline as a PDF file or you can share the redline as a track change
document.

Note: You can also use Save As and save the redline to a group folder in your
Workshare sync folder and it will be synchronized to Workshare online. Using this
method, you could share the entire comparison, including the source files and your
‘Accept’ and ‘Flag’ selections as a WDF file. Refer to Adding files to Workshare.

To share the redline to Workshare online:

1. Click Share and then As Comparison document in the Home tab (or File menu).
The Share dialog is displayed.

Share *
@

A copy of your file will be shared to:

Enter group name

lﬂ? sample Original Document - Sample Modified Document ¢~ Version 1

232,2 KB

‘ | Cancel
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2. Enter the name of the group you want to share the redline with. As you start to
enter the name, groups are suggested to you.

A copy of your file will be shared to:

Kn Q

Knowledage Group ‘

Workshare, 1 members i

Create a new group: Kn ‘

3. Select a group or enter a new group name and click Create a new group.

4. Edit the name of the redline by clicking i , modifying the name and then clicking

Q.

5. Click Share. The redline is saved to the group in Workshare online and a
confirmation dialog is displayed.

Share *
S

©

File shared

A copy of Sample Original Document - Sample Modified Document
has been shared in the following group:

L

Sunset Project Group D
Waorkshare Ltd G" '

Link to file: [ &
https://my.workshare.com/#agroups/share/5cdafcce-588d-11e6-a415-000d3ab2f07h
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6. Continue in one of the following ways:

o Click Send email to open a new email in Outlook that includes a link to the
redline in Workshare online. You can invite people to the group by sending the
email to them.

= Click Go to group to open the group in Workshare online where you can see
the redline and set group permissions and members.

Note: Click & to copy the link to the redline to your clipboard. You can then
paste this link to another location, for example, an email or an instant message.

Sharing to Workshare online as track change document

You can also share the redline to Workshare online as a Microsoft Word file that shows the
changes as track changes.

Note: The converting to track changes functionality is only enabled, if the Enable
Convert to Track Change functionality parameter (Comparison > User Interface
category) in the Workshare Configuration Manager is selected.

To share redlines to Workshare online with changes as track changes:

Click Share and then as Word document with Track Changes in the Home tab (or File
menu). The redline is saved as a Microsoft Word document with the changes indicated by
track changes and shown in the Share dialog as a DOCX file. Complete the share process
as described in the procedure above.

Sending by email

Workshare Compare integrates with your email system so you can send the redline as well
as the original and modified documents as email attachments. You can send the entire
redline or just the pages that include changes. You can also send the redline as a
Microsoft Word file that shows the changes as track changes. This is useful if the recipient
does not have Workshare Compare.

To send a redline as a PDF:

Click Email and then Attach as PDF in the Home tab (or File menu). The redline is
converted to PDF and a new email window is opened with the PDF attached.

To send changed pages as a PDF:

Click Email and then Attach as PDF (only pages with changes) in the Home tab (or File
menu). The changed pages in the redline are converted to PDF and a new email window
is opened with the PDF attached.
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To send source documents with the redline:

1. Click Email and then More email options in the Home tab (or File menu). The
Email Comparison Documents dialog is displayed.

Workshare Compare - Email Comparison Documents x

) —

Select the documents to attach to a new emai message

Create a new message attaching

() Workshare 9's internal file format (DeltaFile)

Document Type Dacument Name Document Format
[ mf: original Document ‘ Sample Original Dncumen| | Waord 97-2003 Document (*.doc) |
[ mf: Modified Document ‘ Sample Modified DDCLII'HEI| | Word 97-2003 Document {*.doc) |
™" Redline Document ‘ Sample Original Dncumen| ié_d_o_b_g_ﬁng_q’g File (*.pdf) v

[] only indude pages with changes in Redline (FOF only)

Cance

2. Select the files to send by selecting one of the following options:
= Individual documents included in this comparison
Selecting this option displays a list of the documents included in the comparison
in the lower pane. Select the checkboxes to the left of the documents you want

to send. You can click in the Document Name fields and modify the names of
the documents.

Note: The original and modified documents are sent in Microsoft Word format and
the redline is sent by default as a PDF. Click in the Document Format field of the
redline to change the default format, for example, to RTF.
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o  Workshare Compare’s internal file format (DeltaFile)

Selecting this option sends the compared documents as a DeltaFile which
contains all three documents (original, modified and redline) as well as your
‘Accept’ and ‘Flag’ selections. A DeltaFile can only be opened in Workshare
Compare. The file extension for a DeltaFile is WDF.

Document Type Document Mame

[¥] Eéj Workshare DeltaFile Sample Original Documen

Tip! Click in the Document Name field to change the name of the redline.

3. If you only want to include the pages with changes in the redline, select the Only
include pages.... checkbox. This is only available when you are sending the
redline as a PDF.

4. Click OK. An email message window is displayed with the selected files as
attachments.

5. Enter the recipient(s) name and any other text you want to include and click Send.

Sending by email as track change document

You can also send the redline as a Microsoft Word file that shows the changes as track
changes.

Note: The converting to track changes functionality is only enabled, if the Enable
Convert to Track Change functionality parameter (Comparison > User Interface
category) in the Workshare Configuration Manager is selected.

To send redlines with changes as track changes:

Click Email and then Attach as Word document with Track Changes in the Home tab
(or File menu). The redline is saved as a Microsoft Word document with the changes
indicated by track changes and a new email window is opened with the Word document
attached.

Printing redlines

You can print the entire redline or just the pages that have changes, as well as either of
the source documents.

To print the comparison documents:

1. Click Print in the Home tab (or File menu) and then one of the following options:
= Comparison only
o Comparison + Modified
o Comparison + Modified + Original
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The Print dialog is displayed.

Print

Printer

Status:  Ready

Where:  PORTPROMPT:
Comment:

Print range

O]

Name: Microsoft XPS Document Writer

O Pages _from:|1 ] go:|1?

(O Selection

[] Print Redline in black and white
[C] Only print pages with changes

Type: Microsoft XPS Document \Writer v4

Copies

Number of copies: 1 ”:—
513) 5013
41)»2_}_J E ]J»Z-LI Collate

| Cance

v Properties

[] Print to file

2. Select from the standard print options in the usual way.

3. If you are printing to a black and white printer, select the Print Redline in black
and white checkbox, as color text may not appear clearly when printing in black

and white.

4. If you only want to print pages of the redline that include changes, select the Only
print pages with changes checkbox.

5. Click OK.

Note: You can preview the printed version of the redline, original or modified document

using the Print Preview options in the File menu.
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Converting redline to PDF

You can convert the redline to PDF and save it locally or in your DMS or you can attach

the PDF to an email and send.

To convert a redline to PDF:

1. Click PDF in the Home tab. The Convert to PDF dialog is displayed.

Workshare Protect - Convert to PDF

Save document as:
(@ PDF (.pdf)

| Configure PDF Security |

Select pages to include:
@ all

() Pages

View and send
(@) Maone
(") Open POF once created
(") Email PDF as attachment

Convertyour document to PDF and configure its security options,

Qotimized for everyday usage
(O POF/A (pdf)  optimized for archiving

Pt

(=) Workshare

Enterpagenumberand/orpageranges
separated by commas (e.g. 2, 5-8)

Helo | Preview

i Create ” Cancel |

Note: This dialog displays slightly differently depending on whether you are

working with a document saved in your DMS/CRM.

2. Select whether you want to convert the redline to PDF or PDF/A.
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3. Ifrequired, click Configure PDF Security to set PDF security options as well as
metadata cleaning options. The following dialog is displayed.

Workshare Protect .

i p—

PDF security configuration

[] Prevent printing

[] Prevent editing of text

[] Prevent thecopying of textand/or graphics
] Prevent comments being added

Metadata cleaning

Cleaning Options 0 option(s) selected

Password protection

Specify a password forthe gensrated POF. Only users with the
password can openthe document,

|Spen:iﬁr password |

|C|:unﬁrm password |

[ Conct

4. If you selected PDF, you can select one or more of the security options as required:
= Prevent printing: Prevents recipients from printing the PDF document.

o Prevent editing of text: Prevents recipients with Adobe Distiller from editing
the PDF document.

o Prevent the copying of text and/or graphics: Prevents recipients from
copying graphics or text directly from the PDF document.

= Prevent comments being added: Prevents recipients with Adobe Distiller from
adding comments to the PDF document.
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5. If you selected PDF or PDF/A, click Cleaning Options to specify what metadata to
remove before converting the redline to PDF.

Workzhare Protect

Advanced Options

Choose the hidden data elements you would like deaned in the selected
documents:

=0

Rigk Elements

O accept changes and turn off Track Changes {Word and Excel)
O convert attached template to Mormal {Word)
O convert field codes to text {Office)

[ Delete built-in properties (Office)

[ Delete comments (Office)

[ Delete custom properties {Office)

[ Delete document variables (Word)

[ pelete hidden text (Word)

[ Delete routing slip (Word and Excel 2003)

[ Delete Smart Tags {Word 2003/2007)

[ Delete text smaller than Spt {Word)

[ Delete versions {Word 2003)

[ Delete white text on white background (Ward)
O Turn off versioning (Word 2003)

Help

6. Select metadata elements as required. For a full description of all the metadata

elements,

7. Click OK.

refer to the Workshare Professional User Guide.

8. If you selected PDF, you can set a password to protect the PDF by entering the
password twice in the Password protection area. WWhen a password is specified,
the recipient can only open the PDF after entering this password.

9. Click Apply.

10. In the Convert to PDF dialog, when working with a DMS, select whether to save the
PDF as a new document or as a related document or locally.
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11.

If you want to create a PDF of part of the redline only, select the Pages radio
button and specify a page range.

Note: You can also PDF individual pages by specifying the pages (separated by
commas) in the Pages field.

12.
13.

14.

15.
16.

If required, click Preview to view the document as a PDF.

To open the PDF once it has been created, select the Open PDF once created
checkbox.

To attach the PDF to a new email message once it has been created, select the
Email PDF as an attachment checkbox.

Click Create. The Save as dialog is displayed.

Specify the name and location for the PDF file and click Save. The redline is
converted to PDF.
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Chapter 3: Comparing Presentations

This chapter describes Workshare Compare for PowerPoint, a standalone application that
enables you to compare two presentations. It includes the following sections:

o Introducing Compare for PowerPoint, page 73, introduces the Workshare
Compare for PowerPoint application and explains how to launch it.

« Comparing Presentations, page 73, describes how to compare a presentation
against an earlier version of the presentation or against a different presentation
using Workshare Compare for PowerPoint.

» Workshare Compare for PowerPoint Main Window, page 80, describes the
Workshare Compare for PowerPoint environment and provides an overview of the
functionality available.

» Working with Comparisons, page 86, describes the tools available to you when
working with the compared presentation after a comparison.
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Introducing Compare for PowerPoint

Note: This chapter describes how to compare PowerPoint presentations. The
comparison of Word documents and PDF files is described in Chapter 2 and the
comparison of Excel spreadsheets is described in Chapter 4.

Workshare Compare for PowerPoint is a presentation comparison tool designed to make
the process of editing and revising presentations as fast and efficient as possible.
Workshare Compare for PowerPoint enables you to compare Microsoft PowerPoint
presentations and immediately see any differences between them. In one view, you can
see both the original and modified presentations with the differences clearly marked as
well as a written summary of the changes and color-coded thumbnails of the slides
showing which slides were modified, deleted, and inserted. Presentations stored in your
DMS or CRM, locally or on your network can be compared.

To make the review easier, you can select different “comparison themes” to define exactly
what is compared as well as how changes are displayed.

What is compared?
Workshare Compare for PowerPoint provides a comprehensive comparison of two
Microsoft PowerPoint presentations and can detect the following changes:

« Slide moves, insertions and deletions

o Text moves, insertions and deletions

o Text formatting changes

« Image and object content changes

e Text box changes

o Hyperlink changes

o Speaker note changes

» Slide background changes

Comparing Presentations

You can compare your original presentation against a previous version of the presentation
or against another presentation entirely. For example, there may be ten versions of a
presentation in your DMS. You can open version 10 and compare it against version 5.

You can launch Workshare Compare for PowerPoint and perform comparisons from within
Microsoft Word, from your desktop, from right-click options or from an email and each of
these scenarios is described in the following sections.
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Launching PowerPoint comparisons from Microsoft
PowerPoint

In this scenario, you first open your presentation in Microsoft PowerPoint.

To compare presentations:

Click Compare in the Workshare tab. The Select Presentations for Comparison dialog is
displayed with the open presentation in the Modified Presentation field. Select the
presentation to compare it against as described in Launching PowerPoint comparisons
from your desktopLaunching Workshare Compare from your desktop.

Launching PowerPoint comparisons using right-click
options

You can launch Workshare Compare for PowerPoint by right-clicking presentations in File
Explorer or in your DMS (iManage FileSite/DeskSite and OpenText).

» Right-click the original presentation and select Compare with Workshare. The
Select Presentations for Comparison dialog is displayed with the selected
presentation in the Original Presentation field. Select the file to compare it against
as described in Launching PowerPoint comparisons from your desktopLaunching
Workshare Compare from your desktop.

» Select the original and modified presentations, right-click and select Compare with
Workshare. The Select Presentations for Comparison dialog is displayed with the
selected presentations in the Original Presentation and Modified Presentation
fields. Continue as described in Launching PowerPoint comparisons from your
desktop.

Note: You cannot launch Workshare Compare for PowerPoint from SharePoint or
Worldox using right-click options, from NetDocuments using Send to Application, or from
the iManage Work 10 browser interface using the kebab (context) menu.
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Launching PowerPoint comparisons from email

You can launch Workshare Compare for PowerPoint from the dropdown context menu of
an attachment to an email or using the Compare button in the Workshare tab.

o Select one (or two attachments), click the dropdown and click Compare with
Workshare.

i, | Sample_presentation version_1.pptx
2MB

: L) Sa r.;l Preview
Open

-

Quick Print
¢ Save As

=

[

@a Save All Attachments...
/X Remove Attachment
B

Copy
EfL select Al

@ Compare with Workshare

The Select Presentations for Comparison dialog is displayed with the attachment in
the Modified Presentation field. Continue as described in Launching PowerPoint
comparisons from your desktop.

o With an email selected in your inbox, click Compare in the Workshare tab. If the
email doesn’t include attachments, the Compare button is disabled. If the email
includes one or two PowerPoint attachments, the Select Presentations for
Comparison dialog is displayed with the attachments selected. If the email contains
more than two attachments, the following dialog is displayed:

Lo %

Select up to two attachments to compare

You can only compare: Word,/Word, PDF/PDF, Word/PDF, Excel/Excel and PowerPaint/
PowerPoint

ﬂ: Sample Modified Document.docx
[@= Sample Criginal Document.dock
ﬂ-- Spreadsheet Axlsx

-E' Spreadsheet B.xlsx

ﬂ; Sample_presentation_version_1.pptx
ﬂll'l' Sample_presentation_version_2.pptx
@ Sample Modified Documentpdf

@ Sample Original Document.pdf

oogoooon
o

Cancel |
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Select the attachments you want to compare and click Continue. The Select
Presentations for Comparison dialog is displayed with the attachments selected.
Continue as described in Launching PowerPoint comparisons from your desktop.

Note: If you select attachments that can’t be compared for example, a DOCX and
an PPTX, the Continue button will be disabled.

Launching PowerPoint comparisons from your desktop

In this scenario, you launch Workshare Compare for PowerPoint as a standalone
application from your desktop or the Start menu. You then select the presentations you
want to compare.

To compare presentations:

1. Double-click the Workshare Compare for PowerPoint shortcut on your desktop or
select Workshare Compare for PowerPoint from the Start menu. The Select
Presentations for Comparison dialog is displayed:

o Select Presentations for Comparison x

=

& Workshare

Select the presentations that you would like to compare.

Original Presentation:

Modified Presentation:

Select Comparison Theme:
Detect Text Changes vl =
This comparisen theme will ignore changes tor images, embedded objects,

itern locotions, text formatting, text box formatting, slide bockgrounds,
hyperlink destingtions, autoshapes.

Help _OImpaEe [ Cancel
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Note: Click Cancel if you want to close the Select Presentations for Comparison
dialog without running a comparison. For example, if you just want to open the
Workshare Compare for PowerPoint window in order to open a previously saved
comparison.

. Select the original presentation you want to compare:
o Drag the file over the Original Presentation field, or

o Click = to the right of the Original Presentation field, navigate to the
presentation location in your local file system, SharePoint or DMS/CRM and
click Open.

The selected presentation is displayed in the Original Presentation field.

Tip! If you want to compare a recently used file, click the dropdown '~ in the
Original Presentation and Modified Presentation fields and select the
presentations you want to compare. These lists contain the last 8 files you have
used.

. Select the presentation you want to compare with the original presentation:
o Drag the file over the Modified Presentation field, or

=

o Click = to the right of the Modified Presentation field, navigate to the
presentation location in your local file system, SharePoint or DMS/CRM and
click Open.

The selected presentation is displayed in the Modified Presentation field.

“‘g B

Tip! To swap the original and modified presentations, click

. From the Select Comparison Theme dropdown list, select the comparison theme
you want to use. Comparison themes contain a set of parameters that define
exactly what is compared as well as how changes are displayed. You can select
from the standard comparison themes provided with Workshare Compare for
PowerPoint or you can create and customize your own comparison themes. Refer
to Appendix B: Configuring Comparison Themes for further information.

Note: Clicking == to the right of the Select Comparison Theme field displays
the Comparison Themes Manager where you can create, modify and delete
comparison themes. For a full description refer to Appendix B: Configuring
Comparison Themes.
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5. Click OK. The comparison process is launched and a progress dialog is displayed.

When the comparison is complete, the Workshare Compare for PowerPoint window is
displayed showing the changes between the selected presentations. For a full description
of the Workshare Compare for PowerPoint interface, refer to Workshare Compare for
PowerPoint Main Window. For a description of how to navigate between the changes and
review the changes in your compared presentations, refer to Working with Comparisons.

Workshare Compare for PowerPoint from the command
line

Comparisons can be run from the command line. Running DeckCompare.exe /? displays
a summary of the available command line options when the program starts up.

Workshare Compare for PowerPoint >

Sload < comparison file=

faoriginal < presentation file=
/modified < presentation file>
Stheme < comparison theme name:
fsave <comparison filex

Sreport < pdf report file name=
Jshowselector
Sresetwindowlayout

/noapply

Examples:
DeckCompare.exe fload "csavedComparisonawcp”

DeckCompare.exe foriginal "choriginal.ppt”
/modified "c\modified. ppt”
Jtheme "Detect All Changes”
Jsave "ohsavedComparison.wdp”

The command line parameters are as follows:

Parameter Definition

lload <file> Loads an existing comparison file (*.wcfp).

loriginal <file> Selects an existing original presentation file for comparison.
Imodified <file> Selects an existing modified presentation file for comparison.
/theme <name> Selects the named comparison theme.
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Parameter

Definition

[save<file>

For an initial comparison from the command line, specifies a file to
save the comparison to.

Ireport <file name>

Creates a report of the comparison that includes the original and
modified slide as well as a list of the changes per slide pair.

Ishowselector

Displays the Select Presentations for Comparison dialog enabling
you to perform a new comparison.

Iresetwindowlayout

Displays the main window in its default layout.

Inoapply

Turns off the apply change functionality for the comparison.

1?

Shows the command line options.

If /load is used, or both /original and /modified, the Select Presentations for Comparison
dialog is bypassed. Otherwise, the dialog is pre-populated with whichever of /original,
/modified and /theme are specified.
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Workshare Compare for PowerPoint Main
Window

The Workshare Compare for PowerPoint main window enables you to view the results of a
comparison between an original presentation and a modified presentation. You can view
(in one work area) both source presentations, slide thumbnails and a summary of the
changes between the two source presentations.

File Menu Slide Selector Area
More Tab Home Tab  Slide View Area Change Summary Area
o =Ty . Sample_presentation_version_2.pptx ¢ gainst Sample_presentation_version_1.pptx - Workshare Compare for PcwerPoint = 1
HOME  MURE o
N Y ] — _—
B =1EN == .- ® = B
ool B3 = O\ ] | [y
New Print Create Show  Change Current Slide Find Next wp| Last Select Edit
Change . Summary Only Change
Comparison Reports Change Navigation Comparison Themes
Slide Selector - @ x Original : Sample_presentation_version_ 1 (slide 1) ¥ X Modified : Sample_pre:entation_version_2 (slide 1~ X
Original slides Modified slides
3=ttt [ S et Workshare Demo Workshare Demo
o Showing how the redaction tool mig  Shows how the “edaction tool migh
@ @ Cetaler §, 2008 30 Sepeember, 2008
Moved to slide 11 Change Summary >0 x
Slide Number Change Numbers Type Details
LCIR T 1-2 Replaced text Octoberi30 September, 2038
B n 3-4 Replaced text ShowingShows how the redaction tool might work
Moved from slide | == :
’13 2 = ¥ S Slide move sourc
@ R 6 Slide move destii
< 33 7 Deleted text Executive-Summary
s 44 8-9 Replaced text 13 Prse baiid - Cleves and i owith

The ribbon changes according to the selected tab. In the above example, the Home tab is
selected so the Home ribbon is displayed.

The different areas of the Workshare Compare for PowerPoint work area are described in
the following sections.
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File menu

The File menu includes the following options:

Option Description

Open Enables you to open a saved comparison. Comparisons are saved as
Workshare .wcfp files. Refer to Opening saved Workshare Compare
for PowerPoint files.

Save Enables you to save the current comparison. Refer to Saving
comparisons.

Save As Enables you to save a saved comparison with a new name.

Print Enables you to print a comparison report showing the changes found
by the comparison. Refer to Printing comparison reports.

About Displays version information about Workshare Compare for
PowerPoint.

Exit Closes Workshare Compare for PowerPoint.

Quick access toolbar

The quick access toolbar provides one-click access to functionality. By default, the Save
and New buttons are available. Click the arrow to the right of the quick access toolbar and
select Minimize the Ribbon to hide the ribbon.

Note: To change the commands that appear in the quick access toolbar, right-click in the
ribbon and select Customize Quick Access Toolbar.

Home tab

The Home ribbon enables you to move between slides and changes, as well as apply and
edit comparison themes.

vowe | wore o

Az = EE =

£ 12 B T,
) B E e B = & =| =&
New Print Create Show  Change Current Slide Find Next =p| Last Select Edit

Changes Summary Only Change

Comparison Reports Change Navigation Comparison Themes
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The options are described in the following table.

Section

Comparison

Reports

Change
Navigation

Comparison
Themes

Option

New

Print

Create

Show
Changes

Change
Summary

Current Slide
Only

Find Change

Previous

Next

First

Last

Select

Edit

Description

Opens the Select Presentations for Comparison dialog
enabling you to perform a new comparison. Refer to
Comparing Presentations.

Enables you to print a comparison report showing the
changes found by the comparison. Refer to Printing
comparison reports.

Enables you to create a comparison report showing
the changes found by the comparison. Refer to
Creating comparison reports.

Displays only slides that include changes, hiding those
slides that have not changed.

Displays/hides the Change Summary area. Refer to
Change Summary area.

Displays only changes relating to the currently
displayed slide in the Change Summary area.

Enables you to search for specific text in the Change
Summary area. Refer to Searching changes.

Navigates to the previous change in the Change
Summary area. The change in also highlighted in the
Slide View area. Refer to Navigating between
changes.

Navigates to the next change in the Change Summary
area. The change in also highlighted in the Slide View
area. Refer to Navigating between changes.

Navigates to the first change in the Change Summary
area. The change in also highlighted in the Slide View
area. Refer to Navigating between changes.

Navigates to the last change in the Change Summary
area. The change in also highlighted in the Slide View
area. Refer to Navigating between changes.

Enables you to select an alternative comparison theme
from the dropdown list. This comparison theme is then
applied to the current comparison. Refer to Applying
Comparison Themes.

Opens the Comparison Themes Manager from where
you can modify existing comparison themes as well as
create new comparison themes. Refer to Customizing
Comparison Themes.
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More tab

The More ribbon enables you to change the display of the different areas in the main
window.

Home | nore o

- = A E] . —' : ‘
= ElE= =] =] o _“. J"\
Swap Horizontal Vertical Tabbed Zoom Fit
Width
Original / Modified Slide / Views Zoom

The options are described in the following table.

Section Option Description
Original/ Swap Swaps the original and modified presentations and re-
Modified runs the comparison. Refer to Swapping the source files.

Slide/Views | Horizontal | Displays the original and modified presentations side by
side in the Slide View area.

Vertical Displays the original presentation above the modified
presentation in the Slide View area.

Tabbed Displays the original and modified presentations in tabs in
the Slide View area.

Zoom Zoom Enables you to change the magnification of the original
and modified presentations in the Slide View area. There
are also zoom controls on the right side of the status bar.

Fit Width Fits the original and modified presentations to the width of
the Slide View area.

Slide Selector area

The Slide Selector area displays thumbnail images of the slides in the original and
modified presentations. The slides have different colored borders so you can see at a
glance when a new slide has been inserted or a slide has been deleted or includes
changes. The border colors are as follows:

Yellow The content of the slide has changed.

Green The slide has moved its position (the new position is indicated).
Red The slide has been deleted.

Blue The slide is a new inserted slide.

Slides that have not changed in any way have no colored border.
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In addition, the following icons in between the slide pairs indicate which slide pairs are
different and which are the same:

© Both slides in the slide pair are the same.
) There are differences between the slides in the slide pair.

The slides currently selected in the Slide Selector area are displayed in the Slide View
area.

The Slide Selector area is by default positioned down the left side of the Workshare
Compare for PowerPoint environment. It can also float over the other windows. Click the
~ and select from the following options:

S, Tip! You can also use the ¥ to auto-hide the Slide
Dockable Selector area.

Tabbed Document

Auto Hide

Hide

Slide View area

The Slide View area displays both presentations that have been compared and clearly
indicates the changes on each. The presentations are synchronized so that if you select a
particular slide in the Slide Selector area or a particular change in the Change Summary
area then that slide or change is shown in both the original and modified presentations.

Changes are marked according to the comparison theme applied to the comparison. For
example, deleted text could be red-and-struck-through and added text could be blue and
underlined.
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Change Summary area

The Change Summary area provides a list of all the changes between the original and
modified presentations in the order that they occur. Changes can be displayed for all slides
or on a slide by slide basis. Selecting a change in the Change Summary area displays the
slides that include the change in the Slide View area and highlights the slides in the Slide
Selector area. The change that is selected is highlighted in light green in the Slide View
area.

The color and formatting of the change in the Change Summary area and in the Slide View
area is determined by the comparison theme applied to the comparison. For a full
description of comparison themes, refer to Appendix B: Configuring Comparison Themes.

You can select changes in the Change Summary area using the mouse or using buttons in
the Home tab.

The following information is shown for each change in the Change Summary area:

Slide The number of the original slide and the number of the modified slide in

Number the comparison.

Change The number of the change in the comparison. A change may have two

Numbers numbers when it includes two actions. For example, a deletion and an
addition.

Type The type of change, such as replaced text, deleted text box, moved
slide.

Details Details of the change.

The icons to the left of each change indicate the type of change as follows:

5_» Replacements A7 Formatting changes
= Insertions ‘% Slide move source
=X Deletions ¥ Slide move destination

The Change Summary area is by default positioned across the bottom of the Workshare
Compare for PowerPoint environment. It can also float over the other windows. Click the
= and select from the following options:

Floating Tip! You can also use the & to auto-hide the Change
Dockable Summary area.

Tabbed Document

Auto Hide

Hide
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Working with Comparisons

Navigating changes

After performing a comparison, you can review the result of the comparison and consider
the changes between the original and modified presentations. You can move between
changes by navigating between slides or by navigating between changes. All areas of the
Workshare Compare for PowerPoint window are synchronized.

Navigating between slides

Clicking slides in the Slide Selector area displays the selected slides in the Slide View area
and shows the changes relating to that slide in the Change Summary area.

Slide Selector - B x Original : Sample_presentation_version_1 (slide 3) oy ¢ Meodified : Sample_presentation_version_2 (slide 3) S <

Original slides Modified slides | Exeeutive Summary Summary
Moved to slide 11 Change Summary - 0 x
Slide Number Change Mumbers Type Details
B 2 6 Slide move destil
= .33 7 Deleted text Executive Summary
Moved from slide | === i " = :
58 44 g-3 Replaced text §Erma dhouse hands lever and rich swith 3 T
tex Fthe bect b £ -+ e had ol bt s
5 Shoressing 3 ¥ 24
littleto dist har5Sh the yeungest of the bwe daughter: of
father { had—+ o jcters + b H=2 e
* a =84 Sisters i Stress
H ther had died tao | forhertoh
cm | . . - EE R o

The following icons in between the slide pair in the Slide Selector area indicate whether
the slide has changed or not:

©  The slide has not changed.
o  The slide has changed.

In addition, the thumbnail images of the slides in the Slide Selector area have different
colored borders so you can see at a glance when a new slide has been inserted or a slide
has been deleted or a slide includes changes. The border colors are as follows:

Yellow The content of the slide has changed.

Green The slide has moved its position (the new position is indicated).
Red The slide has been deleted.

Blue The slide is a new inserted slide.

Slides that have not changed in any way have no colored border.
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Navigating between changes

Clicking a change in the Change Summary area displays the slides that include the
change in the Slide View area and highlights the slides in the Slide Selector area. The
change that is selected is highlighted in light green in the Slide View area.

The color and formatting of the change in the Change Summary area and in the Slide View
area is determined by the comparison theme applied to the comparison. For a full
description of comparison themes, refer to Appendix B: Configuring Comparison Themes.

Change Summary i
Slide Number Change Numbers Type Details o
" 6/6 15-16 Replaced text Scope & Lppreachapproach
% 7T 17 Text Box Changed Mowved up and left
& 77 18-14 Replaced text Section 2 - Scope & Appreachapproach
- S/ 20 Inserted text wconjunction with the paragraph on prospective financial inf
unless it is Thursday.
& s/ 21-22 Replaced text Section 32,1
F$ o 23-24 Replaced table cell O-tempera-emereslempus fugit
f$ o9 25-26 Replaced text Section 32,1 - Detailed Finding
W m 27 Slide move destination

You can also move between changes in the Change Summary area using the First, Last,
Previous and Next buttons in the Change Navigation group of the Home tab.

Note: By default, the Change Summary area provides a list of all changes occurring on
all slides in the compared presentations. If you want to display just the changes that
occur on the displayed slide, click the Current Slide Only button in the Change
Navigation group of the Home tab.

The Change Summary area indicates the type of change as well as details of the change
itself, such as the specific text that has been inserted or deleted.
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Searching changes

You can search for specific text in the Change Summary area. Workshare Compare for
PowerPoint can search all text in the Change Summary area or just the text that has been
changed (inserted, deleted or moved).

To search changes:

1. Click the Find Change button in the Change Summary group of the Home tab.
The Find Changes dialog is displayed.

@ Find Changes bt
Find what: . v
[ ] Match case Search changed text only

Eind [ | Close

2. In the Find what field, enter the text that you want to look for.

3. Select the Match case checkbox if you want to search for identical text in the same
case.

4. Select the Search changed text only checkbox if you want to search only the text
that has been changed.

5. Click Find. Workshare Compare for PowerPoint searches for the specified text.
When it is found, the text is highlighted in the Change Summary area and the
relevant slide is shown in the Slide Selector area and Slide View area.

6. Click Find Next to search for further occurrences of the specified text. Click Find
Previous to return to the previously found instance.

7. Click Close to close the Find Changes dialog.
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Swapping the source files

You can re-run a comparison exchanging the original presentation for the modified
presentation and vice versa. For example, if you selected Presentation A as the original
presentation and Presentation B as the modified presentation, Workshare Compare for
PowerPoint shows the changes made to Presentation A to produce Presentation B. You
can then swap the presentations so that Presentation B is now the original and
Presentation A is the modified presentation. Workshare Compare for PowerPoint
automatically re-runs the comparison and shows the changes made to Presentation B to
produce Presentation A.

To swap the source presentations:

Click Swap in the More tab. Workshare Compare for PowerPoint automatically runs a new
comparison, using the modified presentation as the original presentation and the original
presentation as the modified presentation. The new comparison is displayed in the
Workshare Compare for PowerPoint window replacing the previous comparison.

Saving comparisons

You can save a comparison as a Workshare Compare for PowerPoint file (.wcfp) in your
DMS or CRM, locally or on your network. This file type can be opened in Workshare
Compare for PowerPoint.

To save a comparison:

1. Click Save in the File menu or quick access toolbar. The Save As dialog is
displayed.

2. Navigate to the location where you want to save the file and enter a name for the
file.

3. Click Save.

Note: If you work with Workshare online, you can also use Save As and save the
comparison to your Workshare sync folder and it will be synchronized to Workshare
online. Refer to Adding files to Workshare.

Opening saved Workshare Compare for PowerPoint files

When a comparison has been saved as a Workshare Compare for PowerPoint file, you
can open it from the Workshare Compare for PowerPoint main window.
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To open a saved comparison:

1. Click Open in the File menu. An Open dialog is displayed.

Note: If Workshare Compare for PowerPoint is not open, launch it in the usual
way and click Cancel in the Select Presentations for Comparison dialog so that no
initial comparison is performed and a blank Workshare Compare for PowerPoint
main window is displayed.

2. Navigate to the location where the comparison is saved and select the .wcfp file you
want to open.

3. Click Open. The selected comparison is opened in Workshare Compare for
PowerPoint.

Creating comparison reports

After you have run a comparison, you can create a report showing the changes found by
the comparison. The PDF comparison report can include both the original and modified
slides as well as a list of changes per slide pair or you can select to include just the slide
pair or just the list of changes.

To create a comparison report:

1. Click Create in the Home tab. The Create Comparison Report dialog is displayed.

@ Create Comparison Report >

~Choose Report Layout

(® Full Comparison Report Sample Layout

Includes both eriginal and modified slides as well as
a list of changes per slide pair. Original
i) Change Summary Onl
) Mg Smmary (nly T
Includes a list of changes in table format for each
slide pair.

Changes

i) Slide View Only

Includes both eriginal and modified slides,

Exclude Unchanged Slides from Report

Preview | I Create [ | Cancel

2. Inthe Choose Report Layout area, select what you want to include in the report
by selecting one of the following options:

o Full Comparison Report: Includes the original and modified slide as well as a
list of the changes per slide pair.
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o Change Summary Only: Includes the list of changes in table format for each
slide pair.
o Slide View Only: Includes the original and modified slides.

Select the Exclude Unchanged Slides from Report checkbox if you only want to
include slides with changes in the report.

Note: To display the selected comparison report, click Preview.

Click Create.
In the save dialog, browse to a save location and enter a name for the report.

Click Save. The comparison report is generated and saved as a PDF in the
specified location.

Printing comparison reports

After you have run a comparison, you can print a report showing the changes found by the
comparison. The comparison report can include both the original and modified slides as
well as a list of changes per slide pair or you can select to include just the slide pair or just
the list of changes.

If you have created a comparison report already and saved it as a PDF (as described in
Creating comparison reports) you can simply print the PDF in the usual way. The following
procedure describes how to create and print a comparison report in one step.

To print a comparison report:

1.

Click Print in the Home tab or File menu. The Print Comparison Report dialog is
displayed.

. Inthe Choose Report Layout area, select what you want to include in the report

by selecting one of the following options:

o Full Comparison Report: Includes the original and modified slide as well as a
list of the changes per slide pair.

o Change Summary Only: Includes the list of changes in table format for each
slide pair.

o Slide View Only: Includes the original and modified slides.

Select the Exclude Unchanged Slides from Report checkbox if you only want to
include slides with changes in the report.

. In the Printer area, select which printer to use.

In the Print Range area, select whether to include all slides or selected slides.

In the Copies area, enter how many copies of the comparison report you want to
print and select the Collate checkbox if collating of multiple copies is required.
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Note: To display the selected comparison report, click Preview. Note that the full
report is displayed for preview even if a page range has been specified.

7. Click OK. The comparison report is created and printed as specified.

92



Comparing Presentations

Chapter 4. Comparing Spreadsheets

This chapter describes Workshare Compare for Excel, a standalone application that
enables you to compare two spreadsheets. It includes the following sections:

Introducing Compare for Excel, page 94, introduces the Workshare Compare for
Excel application and explains how to launch it.

Comparing Spreadsheets, page 94, describes how to compare a spreadsheet
against an earlier version of the spreadsheet or against a different spreadsheet
using Workshare Compare for Excel.

Workshare Compare for Excel Main Window, page 100, describes the
Workshare Compare for Excel environment and provides an overview of the
functionality available.

Understanding Changes, page 103, describes how changes are displayed in the
comparison.

Working with Comparisons, page 109, describes the tools available to you when
working with the compared spreadsheet after a comparison.
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Introducing Compare for Excel

Note: This chapter describes how to compare Excel spreadsheets. The comparison of
Word documents and PDF files is described in Chapter 2 and the comparison of
PowerPoint presentations is described in Chapter 3.

Workshare Compare for Excel is a spreadsheet comparison tool designed to make the
process of editing and revising spreadsheets as fast and efficient as possible. Workshare
Compare for Excel enables you to compare Microsoft Excel spreadsheets and immediately
see any differences between them. The differences between each cell are clearly marked
and a detailed summary of the change provided in a panel. Spreadsheets stored in your
DMS or CRM, locally or on your network can be compared.

What is compared?

Workshare Compare for Excel provides a comprehensive comparison of two Microsoft
Excel presentations and can detect the following changes:

e Cell insertions and deletions

o Cell merges and splits

o Changes to number values

e« Text changes

e Changes to formulas

o Number format changes

e Changes to visual formatting in cells

« Changes to font formatting

Comparing Spreadsheets

You can compare your original spreadsheet against a previous version of the spreadsheet
or against another spreadsheet entirely. For example, there may be ten versions of a
spreadsheet in your DMS. You can open version 10 and compare it against version 5.

You can launch Workshare Compare for Excel and perform comparisons from your
desktop, from right-click options or from an email and each of these scenarios is described
in the following sections.
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Launching Excel comparisons using right-click options

You can launch Workshare Compare for Excel by right-clicking presentations in File
Explorer or in your DMS (iManage FileSite/DeskSite and NetDocuments).

» Right-click the original spreadsheet and select Compare with Workshare. The file
selection dialog is displayed with the selected spreadsheet in the Original field.
Select the file to compare it against as described in Launching Excel comparisons
from your desktop.

» Select the original and modified spreadsheets, right-click and select Compare with
Workshare. The file selection dialog is displayed with the selected spreadsheets in
the Original and Modified fields. Continue as described in Launching Excel
comparisons from your desktop.

Note: You cannot launch Workshare Compare for Excel from SharePoint, OpenText or
Worldox using right-click options, or from the iManage Work 10 browser interface using
the kebab (context) menu.

Launching Excel comparisons from email
You can launch Workshare Compare for Excel from the dropdown context menu of an
attachment to an email or using the Compare button in the Workshare tab.

o Select one (or two attachments), click the dropdown and click Compare with
Workshare.

Spreadsheet B.xlsx
20 KB

'_T.LI Cair Preview
Open
B Quick Print
Ed Savens
@a Save All Attachments...

7<  Remoye Attachment

Bz Copy

. Select All

@ Compare with Workshare

The file selection dialog is displayed with the selected spreadsheet in the Modified
field. Continue as described in Launching Excel comparisons from your desktop.
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o With an email selected in your inbox, click Compare in the Workshare tab. If the
email doesn’t include attachments, the Compare button is disabled. If the email
includes one or two Excel attachments, the file selection dialog is displayed with
the attachments selected. If the email contains more than two attachments, the
following dialog is displayed:

L] by

Select up to two attachments to compare

You can only compare: Word,/Word, PDF/PDF, Word/PDF, Excel/Excel and PowerPoint/
PowerPoint

Sample Medified Document.docx
Sample Original Document.docx
Spreadsheet Axlsx

Spreadsheet B.xlsx
Sample_presentation_version_1.pptx
Sample_presentation_version_2.pptx

Sample Modified Document.pdf

1L 4 Y 4
0 09 0 N L Ll

Sample Original Documentpdf

Cancel |

Select the attachments you want to compare and click Continue. The file selection
dialog is displayed with the attachments selected. Continue as described in
Launching Excel comparisons from your desktop.

Note: If you select attachments that can’t be compared for example, a DOCX and
an XLSX, the Continue button will be disabled.

Launching Excel comparisons from your desktop
In this scenario, you launch Workshare Compare for Excel as a standalone application

from your desktop or the Start menu. You then select the spreadsheets you want to
compare.
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To compare spreadsheets:

1. Double-click the Workshare Compare for Excel shortcut on your desktop or select
Workshare Compare for Excel from the Start menu. The file selection dialog is
displayed:

[:_:—:j Workshare

Select the files you want to compare Recently opened files

s L Acme Ink Forecast Model 1.xlsx
Original EE| oo el

=)  U:\ODD Documents 20...ents\Excel Compare
=== Acme Ink Forecase Model 2.xlsx

E2|  UAO00 Documents 20...ents\Excel Compare

=== Modified accounts..xlsx
E2|  UADOC Documents 20..ents\Excel Compare

Modified

ﬁg_l;r Original accounts..xlsx
“ 2| UAOOD Documents 20..ents\Excel Compare

==k Spreadsheet A.xlsx
22| UAOOD Documents 20..ents\Excel Compare

a==| Spreadsheet B.xlsx
2| UAODOD Documents 20...enits\Excel Compare

=ty DMS integrations..xsx
22] U000 Documents 2008\Professional 10

2. Select the original spreadsheet you want to compare:
= Drag the file over the Original field, or

= Click to the right of the Original field, navigate to the spreadsheet location
in your local file system, SharePoint or DMS/CRM and click Open.

The selected spreadsheet is displayed in the Original field.

Tip! If you want to compare a recently used file, drag the file from Recently
opened files.

3. Select the spreadsheet you want to compare with the original spreadsheet:
= Drag the file over the Modified field, or

s Click "' tothe right of the Modified field, navigate to the spreadsheet location
in your local file system, SharePoint or DMS/CRM and click Open.

The selected spreadsheet is displayed in the Modified field.

Tip! To swap the original and modified spreadsheets, click T
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4. If you want to compare individual sheets, select the Select sheets to compare
radio button.

Select the files you want to compare

[==]»  ORIGINAL X
] Acme Ink Forecast Model 1.xlsx
. U000 Documents 2008...umentsh\Excel Compare 22 Nov 2018, 0343 AM
1R ]
[mmly,  MODIFIED e
uEE Acme Ink Forecase Model 2.xlsx
==]  U\ODQ Documents 2008...uments\Excel Compare 22 Mowv 2018, 09:43 AM

O Compare everything

@ Select sheets to compare

Original sheets

Revenue Waterfall 2 ~

Modified sheets

5. Select the sheet in your original spreadsheet and the sheet in your modified
spreadsheet that you want to compare.

6. Click Compare. The comparison process is launched.

When the comparison is complete, the Workshare Compare for Excel window is displayed
showing the changes between the selected spreadsheets. For a full description of the
Workshare Compare for Excel interface, refer to Workshare Compare for Excel Main
Window. For a description of how to navigate between the changes and review the
changes in your compared spreadsheets, refer to Understanding Changes and Working
with Comparisons.
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Password-protected spreadsheets

Workshare can compare password-protected spreadsheets once you enter the password.
After clicking Compare in the file selection dialog, you are prompted to enter the password
for any password-protected files you have selected.

) Password protected file

This file is password protected

Enter the password to compare this file.

PP Spreadsheet Axlsx

Unlock _. Cancel

Enter the password for the spreadsheet and click Unlock. The comparison process is
launched.
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Workshare Compare for Excel Main Window

The Workshare Compare for Excel main window enables you to view the results of a
comparison between an original spreadsheet and a modified spreadsheet.

File Menu Home Ribbon

Acme Ink Forecast Model 1 - versus - Acme Ink Forecase Model 2

) ] . | Numbers | [/ Cell changes | Cell format /27y ¢\ 1+ First change
& @ -, ‘.' &) !

o Text | Cell merges | Font format =#| Last change

Mew Swap Export Show source Show direct Previous Next Legend
formatting changes only +/| Formulas |+ Number format

hange Type hange Type Filter hange Navigation
="U\Decuments and Settingsikevind\Local Settings\Temporary Internet Files\Content. Outlook\ OHVNZIMO\[Bookings Vs Revenue-old.xlsx]Notes'IE22"'U\Documents and Settings

A B C D E F G H

22 Bookings by Gee Region | | . Cell G25

23 New Bockings (Includes hardware) |

‘Returns W] 6 The ceil reference may have changed because
T columns or rows have been modified.

13501,050

2‘ - =
25 | AMER
EMEA

e
26 =W 300 400 808 700
27 APAC s 350 200 458 330
28 New Bookings 1200 [ 2301200 27002100 NUMBER CHANGE Indirect change
24 . = £ o i
30 Renewal Bookings 1 l 1
31 AMER 164 287164 268207 © 4258
32 EMEA 200 350200 450350
33 APAC R 5532 7155 © 600
34 Renewal Bookings 286 £02 3% 880 652
< — - - F
3; Tetal Bookings by Geo l
37 A::ER 264 1337764 17181337
A " 0 5
38 ip:c £ 1050600 12301050 FORMULA CHANGE Direct change
39 32 | 4052312 324 405
40 Total Bookings by Geo 1506 2702 1.596 35002792
i 5 T el I L O e e
42 Invoiced Bookings and Order Backlog | " . -
43 | O =z'UADocuments and Settings\kevi..
44 Perpetual Booking 705 B840 m%' 1470840 18901470 i
e e
» LR Revenue Waterfall 1
Comparison Change Details Panel

The different areas of the Workshare Compare for Excel work area are described in the
following sections.

File menu

The File menu includes the following options:

Option Description

New Opens the file selection dialog so you can start a new comparison. The
existing open comparison will be closed. Refer to Comparing
Spreadsheets.

Swap Swaps the original and modified spreadsheets and re-runs the

comparison. Refer to Swapping the source files.
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Export

About

Closes

Home tab

Description

Comparing Presentations

Enables you to save the current comparison as an Excel file showing
the changes and including a change summary tab. Refer to Saving

comparisons.

Displays version information about Workshare Compare for Excel.

Closes the open comparison and Workshare Compare for Excel.

The Home ribbon enables you to move between changes, as well as control what changes

are shown.

FILE HOME

=)
New Swap Export

Comparison

“ | @
Show source
formatting

Style Change Type

Show direct
changes only

~/ Numbers  |+/| Cell changes l4= First change

[] cenformat (e X
\.(__/'I _> /

[] Text |+/] Cell merges | Font format : ==
h i g i Prerone Net Last change Legend
/| Formulas || Mumberformat

Change Type Filters Change Mavigation Information

The options are described in the following table.

Section

Comparison

Style

Change
Type

Change
Type Filters

Option

New

Swap

Export

Show source
formatting

Show direct
changes only

Numbers

Text
Formulas

Cell changes

Description

Opens the file selection dialog so you can start a new
comparison. The existing open comparison will be
closed. Refer to Comparing Spreadsheets.

Swaps the original and modified spreadsheets and re-
runs the comparison. Refer to Swapping the source
files.

Enables you to save the current comparison as an
Excel file showing the changes and including a change
summary tab. Refer to Saving comparisons.

Displays/hides the formatting applied to the original
and modified spreadsheets, such as cell shades and
font styles. Refer to Source formatting.

Displays/hides indirect changes. Indirect changes are
changes that occur as the result of a modification to a
different cell. Refer to Direct and indirect changes.

Displays/hides changes to number values.

Displays/hides changes to text.
Displays/hides changes to formulas.

Displays/hides whether cells have been inserted or
deleted.
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Section Option Description
Cell merges Displays/hides whether cells have been merged or
split.
Number Displays/hides changes to the number format applied
format to a cell.
Cell format Displays/hides changes to the visual formatting of a
cell.
Font format Displays/hides changes to the font formatting of a cell.
Change Previous Navigates to the previous change in the comparison.
Navigation Refer to Navigate between changed cells.
Next Navigates to the next change in the comparison. Refer

to Navigate between changed cells.

First change Navigates to the first change in the comparison. Refer
to Navigate between changed cells.

Last change Navigates to the last change in the comparison. Refer
to Navigate between changed cells.

Information | Legend Displays a description of the meaning of the colors
used in the comparison.

Comparison area

The comparison area clearly indicates the changes between the compared spreadsheets.
« Inserted cells, rows, columns are blue
e Indirect changes are green
e Direct changes are yellow

o Deleted cells, rows, columns are red

Selecting a cell displays details about its changes in the Change details panel on the right.
You can select changes in the comparison using your mouse or the buttons in the Home
tab.

When several sheets have been compared, you can select a worksheet using the tabs at
the bottom of the comparison.
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Change details panel

The change details panel is displayed to the right of the comparison when a cell is
selected. It provides details about the changes in the selected cell.

Each change is listed in its own card in the panel. The change type is displayed at the top
of the card.

You can close the change details panel by clicking the close icon in the top right.

Understanding Changes

Changes are shown using a combination of color, formatting and text description and
Workshare offers several ways to filter changes to help make review of your changes as
easy as possible.

Source formatting

Source formatting is any formatting applied to the original and modified files. It includes
effects such as:

o Cell shades

e Cell colors

e Cell borders

» Non-standard fonts

e Font colors

e Fontunderlines

o Font styles (italic, bold)

» Font effects (strikethrough, superscript, subscript)
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In the comparison, source formatting is turned off by default so it's easier to see the
changes.

Jul-17 Aug-17
55215381 66356235

Jun-17 Jul-17 Aug-17
4538 5581 5381 6635 6235

138 145 105 145 105
1650 1720 2346 1720 2346
A comparison with source formatting off The same comparison with source

formatting on

To view the source formatting, click Show source formatting in the Home ribbon.

HOME -
-,
. \ +| Mumbers |+ Cell changes +'| Cell format e If'"". |+= First change
' * Show source " S 7 7 Fonth & ) ?
New Swap Exp fOI'I'I'IﬂHiI'Ig direct i At marhes ont fofmat Previous Mext 1 Last change Legend
_ ﬁtxonl} + | Formulas  |» MNumber format

Direct and indirect changes

When a cell has changed, it can be useful to know if any other cells have also changed as
a result.

Any change that has occurred as the result of a modification in the same cell is called a
direct change. Any change that has occurred as the result of a modification to a different cell
is called an indirect change.

For example, take a workbook that has a row full of formulas. If you insert a new row above
the formula row, all the formulas are pushed down by one row. The change to these formulas
is indirect. If you select one of the cells with a formula and modify the formula, the change
is direct.
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In a Workshare comparison, direct changes are highlighted yellow and indirect changes are
highlighted green. You can see all changes to a cell by selecting the cell (see Changes to a
cell).

Note: If a cell contains direct changes and indirect changes, it's highlighted yellow.

Direct changes are always highlighted. Indirect changes are highlighted by default, but you
can toggle them on and off by using the Show direct changes only button in the Home
ribbon.

I -- Y , YN
i L e

& 1 ay SR Humbers | Cell changes | Cell format -{_—| =) += First change
h S N
o | Cell merges | Font fonmat % A -+l han
Hew Swap  Export Show sou changes only | -~ Previous  Mest HaLchinge Legend
formatting . . !Formulas | Humber format
-Nange 1ype

Change type filters

The change type filters let you focus on the types of changes that matter to you. By
default, every type of change is highlighted in the comparison. Switch off highlighting of
individual change types by deselecting them in the Home ribbon.

= O
+'| Cell format

+'| Numbers +| Cell changes
I—_)-‘I = [First change

_’
b & ] | Text +| Cell merges +' Font format B A B
Mew Swap Export Show source 5 Ned, 7 et Legend
fomatting cha - +'| Formulas |+ MNumber format /',

F
>
-
S

The following types of changes can be highlighted:
Type Description

Numbers Cells with number values that have changed. For example, “1” has
changed to “2".

Note: The number format of the cell can be any format, including
General, Number, Text, Currency, eftc.

Text Cells with text values that have changed. For example, “January” has
changed to “February”.

Where cells include text and numbers (e.g. “A1” is changed to “B2”),
they will be marked as Text changes.

Formulas Cells with a formula that has changed.

105




Comparing Presentations

Type

Description

Cell changes

Cells that have been inserted or deleted. Inserted cells are
highlighted blue. Deleted cells are highlighted red.

Cell merges

Cells that have been merged or split.

Number format

Cells that have had a change to their number format. For example,
the number format has been changed from “General” to “Currency”.

This includes changes to the properties of the number format. For
example, a cell with the Currency format has had the number of
decimal places changed from “2” to “0”.

Cell format

Cells that have had a change to the visual formatting, including the
cell shade, color and border.

Font format

Cells that have had a change to the font formatting, including the font,
font size, color, underline, style (italic, bold) and effect (strikethrough,
superscript, subscript).

Note: These checkboxes only change what information is highlighted in the comparison.
If you select a cell, all changes to that cell will be displayed in the change details panel on
the right, regardless of which change type filters are selected.
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Changes to a cell

You can dive into any cell to see all its changes. Select a cell and the changes are
displayed in the change details panel on the right.

H

Cell H21

Total (Prev 6 Months)

The cell reference may have changed because

il 3961 3381 columns or rows have been modified.
NUMBER CHANGE Indirect change
9 535
5 10806 o 130314
o 11811
7 452
'8 593
5 712 FORMULA CHANGE Direct change
5 476
[ o =G21
5 497
9 1020 0 =SUM(H3+H7-H17)
5 626
5 3356 4376
NUMBER FORMAT CHANGE
0 7450 6430 )
The number format for this cell
ll 302 11811] has been modified from general

|: to number.

Each change is listed in its own card in the panel. The change type is displayed at the top
of the card and also whether it's a direct or indirect change. You can clearly see what the
cell contained in the original spreadsheet and what it contains in the modified spreadsheet.

Navigate between changed cells

The Change Navigation buttons in the Home ribbon enable you to move quickly through
the changes in the comparison.

e ot -
(_\ -/__)\‘\I I+ First change *
E ('_'_} -lu - ‘ +| Mumbers | Cell changes | € / L\ & i
: - 7 . =#| Last change
Mew Swap Export Show source Showw direct o) T o Lelmemen ki Previous MNext 9

formatting changes anly « Formulas || Mumberfomat
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There are four buttons:
e Previous: The previous change is highlighted.
» Next: The next change is highlighted.
o First change: The first change is highlighted.
» Last change: The last change is highlighted.

Priorities for highlighting direct and indirect changes

If a cell contains direct changes and indirect changes, the direct change takes priority and
the cell is highlighted yellow.

Priorities for highlighting inserted and deleted cells

In cases where an inserted or deleted row intersects an inserted or deleted column,
changes are displayed as follows:

o If aninserted column intersects with an inserted row, the cell displays as inserted

(blue):
27 58 8
35 47 18
s 2 62
17 56 67
50 36 67
o If aninserted column intersects with a deleted row, the cell displays as deleted
(red):
27 58 8
35 47 18
o u «
17 56 67
50 36 67
» If a deleted column intersects with an inserted row, the cell displays as deleted
(red):
27 58 8
35 < 18
s 2] 62
17 56 67
50 38 67
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o If a deleted column intersects with a deleted row, the cell displays as deleted (red):

27 58 8
35 42 18
s3] 62
17 56 67
50 36 67

Working with Comparisons

Swapping the source files

You can re-run a comparison exchanging the original spreadsheet for the modified
spreadsheet and vice versa. For example, if you selected Spreadsheet A as the original
spreadsheet and Spreadsheet B as the modified spreadsheet, Workshare Compare for
Excel shows the changes made to Spreadsheet A to produce Spreadsheet B. You can
then swap the spreadsheets so that Spreadsheet B is now the original and Spreadsheet A
is the modified spreadsheet. Workshare Compare for Excel automatically re-runs the
comparison and shows the changes made to Spreadsheet B to produce Spreadsheet A.

To swap the source spreadsheets:

Click Swap in the Home ribbon. Workshare Compare for Excel automatically runs a new
comparison, using the modified spreadsheet as the original spreadsheet and the original
spreadsheet as the modified spreadsheet. The new comparison is displayed in the
Workshare Compare for Excel window replacing the previous comparison.

Saving comparisons

You can quickly export your changes to a new Excel file that you can save and share. You
can save the file in your DMS or CRM, locally or on your network.
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To export the comparison:

1. Click Export in the Home ribbon. The Export to Microsoft Excel dialog opens.

€ Export to Microsoft Excel X

What do you want to export?

@ Entire workbook

O Selected sheets

Include:
Change type filters
indirect highlights

Source formatting

2. Select whether you want to export the Entire workbook or only some Selected
sheets.

3. If you choose Selected sheets, click inside the Select one or more sheets field
and choose the sheets to export.

O Entire workbook
@ Selected sheets

Select one or more sheets I\ v ‘

4. By default, all of the following will be included in the comparison:
= Change type filters: All change type filters currently highlighted.
= Indirect highlights: All indirect changes.
= Source formatting: Source formatting from the original and modified files.

If you would like to exclude any of these options, deselect them.
5. Click Export. The Save As dialog opens.

6. Navigate to a save location.
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7. In the File name field, enter a name for the new file.

8. Click Save. The comparison is exported as a new Excel file.

Note: The file does not open automatically after it'’s saved.

H -2 s Version 1 - versus - Version 2.xlsx - Excel 7 B - O X
HOME  INSERT  PAGELAYOUT = FORMULAS  DATA  WORKSHARE

A1 | || ink v
A B C D E F G H | J

1 ILink _|Change# Sheet Column Row Change Type Direct/Indirect Original Modified

2 View 1 Summary A 1 Number Format Direct

3 View 2 Summary A 14 Text Direct EguipmentPurchases

4 View 3 Summary A 15 Text Direct Rent

5 View 4 Summary A 15 Cell Change Direct

6 View 5 Summary B 15 Number Direct 200

7 |View 6 Summary B 15 Cell Change Direct

8 View 7 Summary B 17 Number Indirect 507

9 View 8 Summary B 74 Formula Indirect ¥B10:845)1(B10:B16)

10 |View 9 Summary B 19 Number Indirect 1643

11 |View 10 Summary B 19 Formula Indirect YHB20-B3)(B21-B3)

12 |View 11 Summary B 21 Number Indirect 2881

13 |View 12 Summary B 21 Formula Indirect 3+B87-B16)3+B7-B17)

14 |View 13 Summary C 3 Number Indirect 55881

15 |View 14 Summary C 3 Formula Indirect =B20 =B21

16 |View 15 Summary C 15 Number Direct 200

17 |View 16 Summary C 15 Cell Change Direct

18 |View 17 Summary C 17 Number Indirect 566 -

Change Report Summary Receipts Disbursements [©) K| »

The first worksheet of the Excel file is the Change Report. It lists every change from the
comparison (excluding any changes you chose not to include when you exported the
comparison). To jump to a change, click its View option in the Link column.

The other worksheets correspond to the worksheets in the original and modified files.
Select a sheet to view its comparison.
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Chapter 5:  Working Online

This chapter describes the file share & sync element of your installation, which brings the
online secure file sharing, collaboration and storage features of Workshare to your
desktop. It includes the following sections:

o Overview, page 113, introduces the online functionality available with Workshare.

» Syncing local files, page 113, describes how to use the Workshare desktop app
to sync content between your desktop and Workshare online.

» Getting content online, page 127, describes how to share files to Workshare
groups from open Office documents and using right-click options
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Overview

With file share & sync included in your installation, you can add your files to the secure
Workshare online platform. Once there, you can access your files from anywhere and
share them securely with people inside or outside your organization.

Workshare integrates with File Explorer so you can save and organize your files in local
folders that function seamlessly on your hard drive, but automatically synchronize with
Workshare online. Workshare also integrates with Office so you can share for review, for
example, from right inside Word.

Workshare is available online through a browser at my.workshare.com. Content is divided
into different areas to suit your needs:

Folders Use Folders to publish files and make them available to others. Within
Folders, use My Files to store your own private files that you don’t want to
share with anyone but you want easy access to from anywhere.

Groups Use groups as workspaces where you can collaborate on files with people
inside and outside your company.

Workshare integrates its save and share functionality into your familiar working
environment:

« Using the Workshare sync folder on your desktop, you can save and share any
files to all areas of Workshare online

« From open Office documents, you can save files to My Files in Workshare and
share files into Workshare groups

o From your desktop, you can right click any file and share it to a group in Workshare

In order to access and use Workshare online, you must have a Workshare account.

Syncing Local Files

The Workshare sync folder is your local access point to the online services of Workshare.
Both the Workshare sync folder and the synchronization functionality are provided by the
Workshare desktop app.
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What is the desktop app?

With file share & sync included in your installation, the Workshare desktop application (the
desktop app) is installed. This is an application that syncs content between Workshare
online and your PC so you can access your files and continue collaborating from your
desktop while offline. The key features of the desktop app are as follows:

e Synchronization - Synchronizes groups, folders and files between Workshare and
your desktop. You can be selective about what is synchronized to reduce the
storage footprint on your local machine. If you can’t work online, as soon as you’re
back online, the new versions are uploaded right away.

» Integration - Integrates Windows with Workshare online linking Workshare directly
to everyday applications — users can save files directly into the Workshare sync
folder from where they are copied into Workshare online.

Launching the desktop app for the first time

The desktop app is launched once the Workshare installation is complete.

5 Workshare - [} x

File View Help

) Workshare

(=) Workshare

Welcome, let's get started

Enter your email address 1o sign in or register

‘ Email address

2 Sign in with Microsoft work account

Find out mare

The installation of the desktop app places an icon in your Windows taskbar for basic
management and it puts a folder in your Favorites/Quick access section in File Explorer,
S0 you can quickly access and save your Workshare content. In order to access and use
the desktop app, you must log in to it. You only need to perform this login once; afterwards
the desktop app will launch automatically when Windows starts. You use your Workshare
login credentials to log in to the desktop app.
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To log in to the desktop app for the first time:

 When the desktop app launches after installation, enter the email address and
password you used to sign up for Workshare and click Sign In.

Note: You can also display the login page by clicking the Workshare icon on your
desktop or selecting Workshare Desktop from the Start menu.

The Workshare desktop app looks very similar to Workshare online accessed from a
browser.

In fact, from the desktop app, you can do all the things you can do when logging into
Workshare online through a browser.

Once you have logged in:

e Your files and folders from your online Workshare account start to synchronize to
your local Workshare sync folder

e« The desktop app icon appears in your system tray

Workshare sync folder

The Workshare sync folder is your local access point to your online Workshare content.
You can always find the latest copy of your Workshare files and you can add files to
Workshare via the sync folder. It appears in your Favorites/Quick access section and its
default location is C:\Users\[user name]\Workshare. You can change the location of the
Workshare sync folder in Preferences > Sync Settings, described in Configuring the
Workshare Desktop App.

You can also click Open Workshare Folder from the desktop app main window.

In your Workshare sync folder, you will see all your synchronized Workshare files and
folders, grouped as follows:

o Folders: Shows all your Workshare files and folders, including files you have
uploaded, as well as files others have shared with you. There are also three default
folders:
= My Files: Includes personal files that you don’t want to share.

o Received: Includes all the files sent to you by secure file transfer from Outlook.
o Sent Files: Includes all the files you sent out to others by secure file transfer
from Outlook.

o Group Files: Includes all your Workshare groups which are flexible workspaces
ideal for projects that require dynamic conversations.

If you add, update or delete a file in your Workshare sync folder, it will be added, updated
or deleted in Workshare online too. Similarly, if you add, update or delete a file in a synced
folder in Workshare online through the web app on a browser, the changes will be seen in
the Workshare sync folder.
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The icon to the left of a file/folder indicates its sync status:
L
(+E Waiting to be synchronized or synchronization is in progress
(VB Synchronized

In this two-way file synchronization, updated files are copied in both directions, usually with
the purpose of keeping the two locations identical to each other. You can control what is
synced from your desktop just by adding or replacing files in your Workshare sync folder.
Careful though because anything you remove from your Workshare sync folder will also be
removed from your Workshare online content.

Default sync

By default, the following files are synchronized:
o Files you add to My Files
o Files you add to a shared folder or a group that you own

o Files others add to a shared folder or a group that you own

You can select which folders to sync using the selective sync option. Refer to Selective
synchronization.

System tray icon

The desktop app system tray icon shows the status of the desktop app as follows:

Icon  Status Description

‘OJ Synced The files in your local Workshare desktop folder are fully
synced you’re your online Workshare content.

E}J Sync in The files in your local Workshare desktop folder are currently

progress syncing with your online Workshare content.
?'7“.'] Pause Synchronization between your local Workshare desktop
: folder and your online Workshare content is currently paused.

"&l Conflict There is a conflict between files in your local Workshare
desktop folder and files in your online Workshare content.

QJ Upgrade An upgrade is available for the Workshare desktop app.

V;’J Offline The desktop app has been placed offine so no

synchronization can occur.
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Clicking the icon displays the following options:

Option Description

Open Workshare Opens the Workshare desktop app window.
App

Open Workshare Opens the Workshare sync folder.

folder

Files up to Indicates that all files are synchronized successfully or if there

date/conflicts are sync conflicts between the desktop app and Workshare.

Pause Pauses the current synchronization. The option becomes
Resume Syncing when synchronization is paused.

Refresh Refreshes the display and synchronizes with Workshare
online.

Recycle Bin Displays the Workshare recycle bin which includes all the
Workshare files, folders and groups that have been deleted.

Selective Sync Enables you to select which folders are synchronized between
your desktop and Workshare online.

Preferences Enables you to change application settings for the desktop
app, such as the location of the sync folder or general account
settings.

Help and support Provides access to the Workshare knowledge base.

Quit Workshare Stops the synchronization between your desktop and
Workshare online.

Adding files to Workshare via the sync folder

You can add most file types to your local Workshare sync folder which will then be
synchronized with your Workshare online account. You can add files to existing groups or
folders or create new folders. You cannot create new groups from within the sync folder.

Note: Groups are created in Workshare from the web app or the desktop app.

You can simply copy/paste or save files into your local Workshare sync folder and they will
be synchronized to Workshare online by default. However, if you have selected that
specific folders do not synchronize then files added to those folders will not be
synchronized. Refer to Selective synchronization.
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To copy/paste to your local Workshare sync folder:

Drag the files or folders you want to add into your local Workshare sync folder.

| [ = | Matter 77 - Romeo v Juliet - O X
Home Share View 0
&~ v <« Folders » Matter 77 - Romeo v Juliet v D Search Matter 77 - Ro... 0@
el
w [ Workshare-ElizabethMorris o Mame Date modified Type
v @ Folders &) Emails File folder
@/ 01039697 - GoodSmith, Gregg & U 6;? FAQs - Deployment Options WHS.docx Microsoft Word
@ Ainsley's folder for cool people ﬁ-{ W5 Connect - Mew Feature.docx Microsoft Word
@ All hands + talent show pictures @}_{. WS Hybrid Storage Installation Guide.docx /07/2016 09:40 Microsoft Word
@ Blood Samples
@ Documents
> @ Draft Guides
@ Getting Started
> @ Inbox - .
@ Letters W
&/ Limited Editions —
> @ Matter 77 - Romeo v Juliet |$ Move to Matter 77 - Romeo v Juliet
> @i My Files
S o Rl_a__ ~ =
4itemns

To save files to the Workshare sync folder:

1.

Open a file — this can be any file, for example, a Word file, a PowerPoint
presentation or an image file.

Click Save As.

Browse to your Workshare sync folder in Favorites/Quick access. By default this
folder is located at Users\[user name]\Workshare.

Browse to a location in any of the three areas in Workshare and select an existing
folder or create a new folder.

Click Save. Your file is now saved in your local Workshare sync folder and it is
immediately synchronized to Workshare online (unless the selected folder is not set
to synchronize).

Files won’t sync from here...

Files or folders added to the top level “Workshare” folder in your local sync folder
will not be synchronized. Files and folders must be added into one of the two areas
of Workshare — Folders or Group Files.

New folders added to the Group Files area will not be synchronized — Groups can
only be created via the web app.
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In either of the above scenarios, the icon B next to the file and a popup message alert
you that the file/folder cannot synchronize to Workshare.

I Your file is not placed in a folder that syncs to
L.’ Workshare

Move it to & group folder or My Files' to syncit,

View

Clicking View opens the non-syncing folder locally so you address the problem.

Restoring deleted files

From the desktop app, you can access the Workshare online recycle bin where you can
restore any of your accidentally deleted files, folders or groups. The recycle bin lists all
your Workshare files and folders (those you own) that have been deleted — you may have
deleted them using a web browser, from the desktop app or directly from the Workshare
sync folder.

Note: When you have deleted files and folders from the desktop app or the Workshare
sync folder, you will only see the deleted files and folders in the recycle bin after
synchronization.

The desktop app provides a window into the Workshare online recycle bin so if you are
offline, you will not be able to access the recycle bin.
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To access the recycle bin:

Click Recycle Bin in the left panel.

Working Online

5 Workshare

File View Help

51 warkshare

Search

Q

Open workshare folder El] Selective sync

Helen Sagal @ v

[65)] O

Recycle Bin

Deleted files and folders

Show Me

Deleted by me

Deleted by everyone else

] P

] P E

Name a

1-1

= 2810 right click png

ACME - ACME Corp

B | Best practice admin guide.docx
B | boiler plate text.docx

|| Comp Ver

Parent folder

|
Pro 9 Uda

|

Drafts
Content Guild

Silent video files

Deleted by

Helen Sagal
Helen Sagal
Helen Sagal
Helen Sagal
Helen Sagal
Helen Sagal

e

Owned By

James Swand..
Helen Sagal
James Swand..
Helen Sagal
Dave Ewart
Dave Ewart

MINTON
DRESDEN

STAFFORD

Deletion date

9 months ago
1 year ago
9 months ago
1 year ago
3 months ago

2 years ago

In the recycle bin you can see:

« Files, folders and groups owned by you that have been deleted by anyone; and

« Files, folders and groups owned by anyone that have been deleted by you.

You can filter the list to see what was deleted by you and what was deleted by others.

o Click Restore All to restore all files and folders in the recycle bin back to their
original location.

« Click Empty Recycle Bin to permanently delete all files and folders in the recycle

bin.
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To restore selected files:
1. Click Recycle Bin in the left panel.

2. Select a file or a folder (or several files and folders). The buttons change to Restore
Selected and Empty Selected.

) Workshare

File View Help

5 Workshare

Search Q [F= Open workshare folder [ selective sync Helen Sagal @ v

——— MINTON
EayLIeam DRESDEN

Deleted files and folders

STAFFORD

Restore Selected Empty Selected

Name A Parent folder Delsted by Owned By Deletion date

Show Me

[0 @ peietea by me
Deleted by everyons else "/ 1-1 \ Helen Sagal James Swand... 9 months ago
@ =] 2810 right click png Pro 9 Uda Helen Sagal  Helen Sagal 1 year ago
[0 ¥ 1 ACME - ACME Corp \ Helen Sagal  James Swand . 9 months ago
| W] Best practice admin guide.docx Drafts Helen Sagal Helen Sagal 1year ago
| ®] bailer plate text docx Content Guild Helen Sagal  Dave Ewart 3 months ago

[] Comp Ver Silent video files  Helen Sagal ~ Dave Ewat 2 years ago

3. Click Restore Selected to restore the selected folders and files.

File synchronization

The desktop app synchronizes your online Workshare content to your local machine so
you can access your files and continue collaborating when offline. By default, the following
files are synchronized:

o Files you add to My Files
o Files you add to a shared folder or a group that you own

» Files others add to a shared folder or a group that you own

So if you add any of these files to Workshare via a web browser, they will be synced to
your desktop and you will be able to access them from the Workshare desktop app (or
sync folder). Synchronization works both ways so if you delete any of these files from the
Workshare desktop app (or sync folder), they will be deleted from Workshare online and
you will no longer be able to access them via a web browser.

Synchronization between Workshare online and your desktop occurs in the following
situations:

« When logging into the desktop app

« When a new event occurs on Workshare online, such as a new file uploaded or a
new version added
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When a new event occurs in the Workshare desktop app (or sync folder), such as a
new folder created or a file added

When the desktop app has been offline and then you go back online
When clicking Refresh in the desktop app system tray menu

When clicking Update and Sync in the Selective Sync page

You can pause synchronization at any time, for example, if you have a slow connection,
and then restart it when convenient.

To pause synchronization:

Click the desktop app system tray icon and select Pause. Synchronization stops.

To restart synchronization, click the desktop app system tray icon and select Resume.

Selective synchronization

You can modify the default synchronization settings so that less files and folders are
synchronized to your desktop in order to reduce the storage footprint on your local
machine.

To select folders to synchronize:

1.

Click Selective Sync in the desktop app main window (or from the desktop app
system tray menu or the File menu). The selective sync page is displayed showing
the root folders on Workshare — Folders and Group Files.

Click a folder to display its subfolders.

Select the folders that you want to synchronize between Workshare and your
desktop by selecting the checkbox to the left of the folder/subfolder name.
Selecting or deselecting a folder will automatically select/deselect the subfolders
belonging to the folder. However, you can select a folder but then manually
deselect some of its subfolders. Use the Select All checkbox to quickly
select/deselect all folders.

Note: By default when a folder or group is shared with you it is not selected for
synchronization. To change this, select the Automatically sync new folders
shared with me checkbox.

Click Update and Sync. All folders with a selected checkbox will be synchronized.
The progress of the synchronization is shown in the sync progress page.

Folders that are not synchronized will not appear in your local Workshare sync folder.
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Sync progress
The sync progress page shows the folders and files currently being synchronized.
To display the sync progress page:

When synchronization is in progress, select Sync Progress from the View menu.

5 Workshare Sync Progress = O *
User name, file name, type or folder = . O 'u'
Name Folder Size Progress Last Updated By ™
E] ShutdownService.html Server 10 KB l Hisie ] Michzel Ward
Downipad Completed
[#] SMTPMessage.html class-use 10 KB l 100% I Michael Ward
Downipad Completed
E] package-use.html general 9 KB | 100% ] Michael Ward
Downipad Completed
IE] SynergyDemo.html Synergy 9 KB l 100% I Michael Ward
Downipad Completed
E] SynergyDemo.html Synergy S KB l Hisie ] Michzel Ward
Downipad Completed
IE] InvalidAddressException.html class-use 9 KB l 100% I Michael Ward
Downipad Completed
E] help-doc.html apidocs S KB l Sl ] Michael Ward
Downipad Completed
[#] Message.html class-use 8 KB l 100% I Michael Ward
Downipad Completed
= WorkshareInstal.exe WP4 SR-1 Build 8147 60 MB " el Michael Ward
Dowrlpading
[  worksharelnterwoven.exe 8177 57 MB ] 2% Michael Ward
Pomwbacﬁ':g
[  worksharelnstal.exe Workshare 4 - RC1 57 MB - 0% Michael Ward
Wadting fo sync
ﬁl WaorkshareLondonSymbols.msi Build 6711 50 MB - bk Michael Ward
Waiting fo sync
i  workshareLondonSymbols.msi Build 6702 50 MB — % * Michael Ward v
< >
g | Syndng - 827 files remaining

The status bar provides a summary of the sync situation and the sync progress report
provides a detailed view.

The files being synchronized are shown in a queue format. If you want to move a file in the
queue, for example, you want to upload a small Word document and it is being held up by
a large PowerPoint presentation, right-click the file you want to delay and select Lower the
sync priority.
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Synchronization conflict
The sync conflicts page provides a dedicated area where you can deal with file conflicts.
Possible conflict scenarios include:

* You have opened a synced file locally and you are editing it. Meanwhile, in the web
app, a new version is added to the file. When you save the open file, a conflict is

shown.

« Two users are working offline and make changes to a file they share. User 1 goes
back online and the revised file is synced to Workshare online as a new version.
User 2 goes back online and a conflict is shown.

In your local Workshare sync folder, the file icon shows there is a conflict:

6] Sample Changed Modified Document.do...
6] Sample Modified Document.docx
@J Sample Original Document.docx

In addition, the desktop app system tray icon shows there is a conflict and the menu
includes a Conflicts option:

& Open Workshare App
=y Open Workshare folder

«  All files and folders are up to date

1 Hause

Refresh

Recycle Bin
Selective Sync...
Preferences...

Help and support

Q doRrRE

Cuit Workshare
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To resolve a conflict:

1. Click Conflicts in the desktop app main window (or from the desktop app system
tray menu). The sync conflicts page is displayed listing the files with conflicts.

2. Expand a file in the sync conflicts page by clicking Q. The options for resolving
the conflict are displayed. For example, you may want to add your file as the latest
version or overwrite your version with the online version. You can always opt to
keep both files involved in the conflict. Different options are displayed according to
the particular conflict.

53 Sync Conflicts = s

Name Owner Date of COf;tht

E‘é‘ Sample Original Document.doc
—A >

Users = helens = Workshare = Folders = Untitled RERLSERS °
Helen Sagal has updated this file while you were editing it.
How would you like to resolve this?
@ Keep both (choose this option if you're not sure)
Keeping both files means your file will be renamed
(O Keep my version Size 80 KB Date modified. 16 May 2016 16:03
Add my version as the latest on Workshare
() Keep Helen Sagal's version Size: 80 KB Date modified: 16 May 2016 16:04

Querwrite my wersion on this computer

3. Select the option you want to apply and click Resolve.

Note: When there are no conflicts, the sync conflicts page is not available.
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Collaborating in Workshare

Once you have shared folders with other users, those users will be able to access
Workshare via the web app, view the files in the folder and add comments in real-time. If
they have permission, they could also add new versions to a file. Any new versions will be
synchronized to your desktop and you can also add versions to Workshare files from your
desktop through your Workshare desktop app or your local Workshare sync folder. For
example, simply open a file from your local Workshare sync folder, edit it and save it and it
will be synced to Workshare online and appear as a new version.

E_EJ Workshare

File View Help

e Qriginal Document.doc

| Versiond - || Uldated just now by Elizabeth Morris

You can also open any file and save over a file in your local Workshare sync folder. It will
be synced to Workshare online and appear as a new version.
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Getting Content Online

As well as using your local Workshare sync folder to get your content online, you can use
the right-click options and toolbar options added by the file share & sync element of your
Compare installation.

Right-click sharing

The way to share files and folders from your desktop is to share them to a Workshare
group.

Right-clicking any file on your desktop provides the option to share it to a group. The file or
folder will be added to the group’s files and all members of the group will be able to access
it.

To share to a group:

1. In File Explorer, right-click any file or folder.

] Minutes 281 [ Compare with Workshare hon File o0&
MO Modifief ] Convert to PDF with Workshare h Text Format 04
@3 ND Maodifie = Combine files in Workshare o ) R f
B0 Orgind IR < svor o gove

RS i

2. Select Workshare, then Share to group.

= Shoxe i oron =

This file will be shared with people in:

Enter group namel

—1  Sample Original Document. docx ﬁ
34KB
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3. Enter the name of the group you want to share the file/folder with. When you click
in the text box, a list of the most recent groups selected is displayed. As you start to
enter a name, groups are suggested to you.

This file will be shared with people in:

Review Material

Create a new group: Review Material

4. Select an existing group or enter a new group name and click Create a new
group.

Note: Click Change Group to remove the specified group so you can select
another one.

5. If you want to change the name of the file/folder you are sharing, click Z and edit
the name.

6. Click Share. The file/folder is uploaded to the specified group in Workshare online.
If the group is synced, the added file or folder will also appear in the selected group
in your local Workshare sync folder.

From open Office documents

Using Workshare toolbar options, you can save your Office files to Workshare online so
they will be accessible to you online at all times. You can save them directly to a folder in
My Files if they are private files that you don’t want to share with anyone or you can save
them directly to a group if you want to collaborate on them with people inside and outside
your company.

You can save Word, Excel and PowerPoint files in their native format or convert them to
PDF as you save.

Note: You can also save redlines to Workshare online from within Workshare Compare.
Refer to Saving redlines to Workshare online.

Additionally, you can display the Workshare Connect panel inside Office which provides a
window into the document you have shared to a Workshare group.
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Saving to My Files

The My Files area of Workshare online is where you can securely store your own private
files that you don’t want to share with anyone but you want easy access to from anywhere.

To save documents to My Files:
1. Open a file in Microsoft Word, Excel or PowerPoint.

2. In the Workshare tab, click Save to My Files. The Save to My Files dialog is

displayed.
€3 saveto My Files — O >
&1 Create new folder
4 ® @® My Fies
() 2 Woaork in Progress
O B 550
) 2 Private
) (&5 Draft Contracts
Filz name: ;Sample Original Document - Sample Mndiﬁedi
Save as type: | Adobe Acrobat Fle { *.pdf) "

Tip! You can also display this dialog using Workshare options in the File menu.

3. Browse through My Files and select the folder where you want to save the file.

Note: To create a new folder, click Create new folder, enter a name for the folder
and click Create.

4. In the File name field, modify the name of the file as required.
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5. From the Save as type dropdown list, select the format for the saved file from the
following:
= Word Document/Excel Workbook/PowerPoint Presentation: Saves the file
in its native format
= PDF: Saves the file as a PDF file
o PDF/A: Saves the file as a PDF/A file

6. Click Save. The file is saved to the specified folder in Workshare My Files and you
can log into Workshare and access the file from anywhere. The following
notification pops up on your desktop:

» File saved to Workshare
Copy link View

You can click View to open the file in Workshare in your browser or click Copy link
to copy the URL to the file to your clipboard. You can then paste this link to another
location, for example, an email or an instant message.

If the Workshare My Files folder is synced, the added file or folder will also appear in your
local Workshare sync folder

Once you have saved a file to My Files, you can continue working and making changes as
required. Clicking Save to My Files again will save the file to Workshare with the same
name and in the same location as a new version. If you want to save the file to My Files as
a new file with a different name, click the arrow on the Save to My Files button and click

Save as.
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Sharing to a Workshare group

By sharing files to Workshare groups, you save your file to a group in Workshare and all
members of that group can access your file and collaborate on it with you.

To share documents to a group:
1. Open a file in Microsoft Word, Excel or PowerPoint.

2. In the Workshare tab, click Share. The Share dialog is displayed.

Share >
D

A copy of your file will be shared to:

Enter group name

o

m% WS Professional 9 UG & Version 1

5.2 MB

| Cancel

Tip! You can also display this dialog using Workshare options in the File menu.

3. Enter the name of the group you want to share the file with. As you start to enter the
name, groups are suggested to you.

A copy of your file will be shared to:

sur| (/]

Sunset Project Grou

Waorkshare Ltd, 2 members

Create a new group: sun

4. Select a group or enter a new group name and click Create a new group.

5. Edit the name of the document by clicking 4 , modifying the name and then
clicking o
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6. Click Share. The document is saved to the group in Workshare and a confirmation
dialog is displayed.

Share >
>

©

File shared

A copy of Sample Original Document
has been shared in the folowing group:

Sunset Project Group I -
Workshare Ltd 4

i
|

Link to file: | &
https://my.workshare.com/ #aroups/share/bc80933c-5d53-1126-3590-000d33b05bfd

I Gutogro“p :

If the Workshare group is synced, the added file or folder will also appear in your
local Workshare sync folder

7. Continue in one of the following ways:

s Click Create email to open a new email in Outlook that includes a link to the
document in Workshare. You can invite people to the group by sending the
email to them.

o Click Go to group to open the group in Workshare in your browser where you
can see the document, set group permissions and select members.

Note: Click & to copy the link to the document to your clipboard. You can then
paste this link to another location, for example, an email or an instant message.

Monitoring shared files

The Workshare Connect panel inside Office provides a window into the files you have
shared to Workshare groups.
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When you have shared a document into a group in Workshare and you open the
document locally, the Workshare Connect panel provides a view of what is happening with
your collaboration. You can see the other reviewers (the members of the group) and
whether they are online at the moment. You can also see how many comments have been
made on the document and whether any new versions have been added to it. With a
single click you can open the document in Workshare online via a browser and join in the
collaboration by viewing comments and making your own comments.

If you open a shared document in Office and the Workshare Connect panel is not
displayed, click Toggle Panel in the Workshare tab to display it. When the document is
not shared to a Workshare group, the panel will look something like this:

Workshare Connect * X

&
T
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Once your document is shared, the Workshare Connect panel will provide real-time

information about the collaboration, like new comments and versions.

Click the version
dropdown to see
other versions of
the document. Click
a version to display
it in the Workshare
web app.

The Comments tab
shows the number
of comments made
on the displayed
version as well as
the total number on
all versions.

Click here to display
the document in the
Workshare web

app.

New versions

When another group member adds a new version of the document, you are notified in the

Workshare Connect

- X

A new version of this document is available. Download

Sample Modified Document..doox

Version 1 »

Comments

People

Comments on this version

Total of 6 on this document

A new version has
been uploaded.
Click here to
download it.

The People tab
shows the members
of this group and
whao is reviewing
and editing the
document.

When there are
comments you have
not yet read, click
this alert to display
the document in the
Workshare web app
S0 yoU can review
the comments.

Workshare Connect panel. Click Download and the new version is downloaded and

opened. Now the Workshare Connect panel will ask if you'd like to see what’s different
between this new version and the previous version. With a single click, both versions are
compared in Workshare Compare.

Workshare Connect

Version 1

Comments

Sample Original Document.docx

A This document has been updated since you last
A0, opened it. See changes

People
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Comments added

In the Comments tab, you can see the number of comments made on the version of the
file you are looking at (in orange) as well as the total number of comments on all versions
of the file. If you want to see the actual comment, click View online and open the file in
Workshare via a browser so you can view comments and update versions and add
comments if you want. When comments are made that you have not yet seen, click the
Unread comments alert and the file is opened in Workshare via a browser.

Group members

In the People tab, you can see all members of the group that have access to your
document. A green light indicates the member is currently viewing the file. The following
three lists are available:

« Everyone: All members who have access to the file
+ Reviewers: Any member who has looked at the file

o Editor: A member who has looked at the file in Word (and had Workshare installed
and the Connect panel turned on)
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Chapter 6: Advanced PDF
Functionality

This chapter describes how to convert a PDF file to a Microsoft Word file. It includes the
following section:

« Converting PDF Files to Word Format, page 137, describes how to convert a
PDF document into Microsoft Word format.
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Converting PDF Files to Word Format

Note: This functionality is not available when Workshare Compare is installed in Office
2013 environments (and above); they have this functionality built-in.

Workshare Compare provides accurate conversion of PDF files to Microsoft Word files
(PDF to DOC/DOCX format) preserving document formatting and page layout. This
functionality is available from within Microsoft Word and by right-clicking closed PDF files
on your desktop.

Converting a PDF document into Word format is useful if you want to edit the document,
as PDF documents cannot be edited as easily as Word documents.

Notes:
Workshare cannot convert secure PDFs, meaning PDF files with security settings
configured.

Scanned PDF files will not be converted to editable text — the content remains as an
image and cannot be edited.

To convert a PDF:

1. To convert a PDF document to DOC format:
o Right-click the closed PDF file and select Open in Word with Workshare.
= From Microsoft Word, click Open. Browse to the PDF file and click Open.
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The Open PDF in Word dialog is displayed.

Workshare - Open PDF in Word o]
|
(=) Workshare

© Flowing (Rec d);
Preserves page layout, ARRANGEMENT LE
columns, formatting, graphics :
and text flow. Introduction Howe
The Lead Mbonager and the make
p - other Managers (as defined in  whett
() Continuous paragraph 2°beI05:) authe
Detects the page layout and I nece:
Chapter Ore Howe
columns bUt only e This amangement letter sets make
the formatting, graphics and out the scope and limitations  whett
text flow. —

ARRANGEMEN"

Introduction
The Lead Manager and the
other Managers (as defined in
paragraph 2 below)

I*D2ws 3 -

Chapter One

2. Select a conversion method according to how much of the formatting and layout
you want to preserve and click OK. The PDF document is converted to Word
format and is opened in Microsoft Word.

You must save the document.

Notes:
The name in the title bar will still include the PDF extension. However, the document is in
DOC/DOCX format.

When converting a PDF file to Word format, the display may vary according to the type of
PDF. The type of PDF means the software used to create the PDF file. For example,
Adobe, Amyuni, CutePDF, novaPDF, and so on.
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Chapter 7: Configuring Workshare

This chapter describes the Workshare Configuration Manager. It includes the following
sections:

« Introducing the Workshare Configuration Manager, page 140, introduces the
Workshare configuration utility.

o Accessing the Workshare Configuration Manager, page 140, describes how to
access the Workshare Configuration Manager.

o Setting Parameters, page 142, describes how to set values for parameters in the
Workshare Configuration Manager.
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Introducing the Workshare Configuration
Manager

The Workshare Configuration Manager is a configuration utility that enables you to
configure Workshare and the way it behaves as well as modify the configuration of the
default profile (via the parameters in the Protection category).

Note: A profile is a collection of policies. A policy is a set of parameters applied by
Workshare Protect when determining content risk.

Administrator Mode and User Mode

The Workshare Configuration Manager has two modes as follows:

o Administrator Mode: This mode is for administrators to make changes to the
default settings on the local machine. Settings made are saved in
HKEY_LOCAL_MACHINE in the Registry. As a user you will only have access to
Administrator mode if you have Administrator rights.

o User Mode: This mode is for users to make changes to the Workshare
configuration to suit their own personal preferences on the local machine. Other
users could log in and they would not have the same configuration settings.
Settings made are personal to the user and saved in HKEY_CURRENT_USER in
the Registry.

Note: Your system administrator may have restricted the rights of users to modify
configuration parameters by locking individual parameters so that users cannot override
the setting. If you have restricted access rights and have special requirements for
configuration, please speak to your system administrator.

Accessing the Workshare Configuration
Manager

The Workshare Configuration Manager can be accessed from within Microsoft Office or
from the Start menu.
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To access the Workshare Configuration Manager from Microsoft Word:

In an open document, click Options in the Workshare tab or from the Start menu, select

Workshare Configuration (User Mode). The Workshare Configuration Manager opens in
User Mode.

&3 Workshare Configuration Manager (User Made) i O x
r:j Workshare Configuration Manager i

Options. Rendering Set Manager My Products

ﬁ Reset All To Default App | [] Hide options | cannot change -S.e-crrcr.:-ticn,";gi.'ra.‘ion G::;ons Q
=11 I 7 i A
'ﬂjiﬁ. \ == 3
Protection . S 4 0
Administration Sharing Interactive Protect Remove Metadata Exciude Metadata ‘Convert to PDF Compress as Zip
X : EEERCE]
S48 |
Comparison L\:{r]ég*J Lw?]'
Administration User Interface Rendering Sets
oy ooo ool
_iJ-‘_nflg&L |
General > '@ d
! g
Administration User Interface
==
" | =|
Integrations m——l
General

Note: In User Mode, the state of the options reflects the settings in
HKEY _CURRENT_USER in the Registry.

The configuration parameters for Workshare are grouped into categories and sub-
categories. Click a sub-category to display its parameters. The different sub-categories

and their parameters are described in a separate guide - Workshare Configuration
Options.

Searching parameters

If you know the name of a parameter (or part of its name) but not its location, you can
search the Workshare Configuration Manager using the search box on the top right.

custom

Protection
Exclude Metadata
Exclude specified custom properties
Remove Metadata
Delete custom properties (Office)
Interactive Protect
Delete custom properties (Office)
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Click the parameter in the results list and the relevant category and sub-category are
displayed in the Workshare Configuration Manager.

Setting Parameters

Most parameters in the Workshare Configuration Manager are set by selecting or
deselecting a checkbox. There are also some that require you to enter a value in a text
box.

To specify parameters:

1. In the Workshare Configuration Manager, select a category and then a
sub-category.

2. Set a value for a parameter by selecting or deselecting the checkbox, selecting an
option from a dropdown list or entering a value in a text box.

Default document open location
a8 Default email attachment format | portable Document Format (-pdf}
Default Redline save location
Default rendering set
[T Display document description as well as document ID
Display document selection dialog on startup
£ Display Redline in page layout view 6

Display source document labels

The (5] icon to the right of a parameter indicates that the parameter value has
been changed.

Note: When parameters have been locked by your administrator, the parameter
will be disabled and a lock symbol will appear to the left of the parameter. You
cannot change locked parameters.

3. Continue to select categories and sub-categories and specify parameters as
required.
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4. Click Apply to save your settings. A confirmation message is displayed once the
settings have been saved.

Workshare >
@ Options applied, restart Office applications
i The options have been successfully applied for this user.

Please restart all running Microsoft Office applications
to ensure that yvour changes take effect,

5. Click OK and restart all Microsoft Office applications.

Note: The different sub-categories and their parameters are described in the Workshare
Configuration Options guide.
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Appendix A. Configuring Rendering
Sets

This appendix describes how to configure rendering sets for Workshare Compare and
apply them to a comparison. It includes the following sections:

+ Introducing Rendering Sets, page 145, introduces Workshare rendering sets and
describes how they determine the look of a redline.

» Accessing the Rendering Sets Manager, page 146, describes how to access the
Workshare Rendering Sets Manager.

o Customizing Rendering Sets, page 149, describes how to create your own
rendering sets as well as modify and delete existing rendering sets.

 Rendering Set Parameters, page 150, provides a detailed description of all the
parameters included in rendering sets.
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Introducing Rendering Sets

Workshare Compare uses colors and different formats in the redline to enable you to see
the changes that have been made to the documents.

For example, the following indications can be used:

o Deletions in red-with-a-strikethrough

e Insertions in bright blue with a double underline

e Moved or cut text in green-with-a-strikethrough

o Pasted (copied) text in areen with a double underline

o Moved deletions in

The colors and formats adopted depend on the rendering set applied to the comparison.
Workshare Compare includes several different rendering sets that you can apply as
required or you can modify these rendering sets or create your own rendering set.

Note: It is general practice that your system administrator will have been involved in
creating a set of standard rendering sets for your company to use and may have
restricted the rights of users to create, delete or modify their own rendering sets. If you
have restricted access rights and have special requirements for rendering sets, please
speak to your system administrator.

Where are rendering sets stored?

By default, rendering sets are stored in the following locations:

o The default rendering sets included with Compare are machine-wide rendering sets
and are stored in a shared documents folder at the following location: C: Users >
Public > Public Documents > Workshare > Rendering.

« Any further rendering sets created by users are personal rendering sets and are
stored in C: Users > (user name) > My Documents > Workshare > Rendering. This
can be changed by an administrator in the Default location rendering set
parameter in the Workshare Configuration Manager (Comparison >
Administration category).

You can store rendering sets at other locations but you must specify the location (or
locations) in the Additional locations for rendering sets parameter in the Workshare
Configuration Manager (Comparison > Administration category). Workshare Compare
looks in the two default locations (specified above) to create a list of the possible rendering
sets available and will also look in any additional locations specified in this parameter.
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Applying rendering sets

You apply a rendering set to a comparison before the comparison is run and you can also
apply a rendering set at any time after a comparison has been performed.

To apply a rendering set after the comparison has been run:
o Refer to Applying a different rendering set

o Refer to Changing the comparison options

Accessing the Rendering Sets Manager

The Rendering Sets Manager is accessible from the Workshare Configuration Manager,
from Workshare Compare and from the Workshare tab in Microsoft Office.

From the Workshare Configuration Manager

Access the Workshare Configuration Manager and select the Rendering Set Manager tab.

@ Workshare Configuration Manager (Administrator Mode]) il m] *

EjWorkshare Configuration Manager

Administrator Mode

Options. Rendering Set Manager | My Products
Rendering Set: [Standard . | Save As... Delete Search Rendering Options

Comparison Options Comparison Options

Select the document features to be compared.

Redline Options

Redline Rendering _A Comparison Options

[#] Allow Auto Retry
[¥] Detect List Numbering Changes
[¥] Detect Footnote/Endnote Numbering Changes

[¥] Compare Headers/Footers

[#] Compare Footnates

|71 Compare at Character Level

[T] Compare Numbers at Character Level

[ Ignore Embedded Objects/Images

[7] Ignere Case Changes

|71 Ignore Text Boxes

= Ignore Field Codes

[¥] Compare field contents as text
[7] Ignore Tables

[7] Display comments in redline
|7] Detect Changes to Images

|71 Ignare auto list against manual number list changes

Hslp Workshare Configurstion Manager | Suild 007102 | Copyright ©1998-2016 Workshare Led. % Workshare

If you have permissions, you can modify and delete existing rendering sets and create new
rendering sets. Refer to Customizing Rendering Sets.
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Before running a comparison

Before running a comparison, click in the Compare Documents dialog.

) Rendering Sets - O x

Rendering Set: .Standard ¥ Save | Save As.. || Delete |

Comparison Options Comparison Options
Select the document features to be compared.
Redline Options

Redline Rendering s A Com Pa rison QPtians
Allow Auto Retry
Detect List Mumbering Changes
Detect Footnote/Endnote Numbering Changes

Compare Headers/Footers

Compare Footnotes

] Compare at Character Level

[[] Compare Numbers at Character Level

O Ignore Embedded Chjects/Images

O Ignore Case Changes

O Ignore Text Boxes

|l Ignore Field Codes

Compare field contents as text
I:l Ignore Tables

] Display comments in redline
[ Detect Changes to Images

[ Ignore auto list against manual number list changes

| 0K || Cancel || Help: |

If you have permissions, you can modify and delete existing rendering sets and create new
rendering sets. Refer to Customizing Rendering Sets.

Additionally, you can edit the rendering set parameters as required and click OK. The
Save Rendering Set dialog is displayed where you can either:

« Enter the name of an existing rendering set to overwrite a rendering set or enter a
new name to create a new rendering set. Do not use the following characters when
naming rendering sets: <, >, :,\, “, /, \ or |. Click Yes. The updated rendering set is
saved and it is selected in the Compare Documents dialog.

o Click No. The revised options are saved as a temporary rendering set called
“Custom rendering set” and this rendering set is selected in the Compare
Documents dialog.
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Configuring Rendering Sets

In the Workshare Compare main window, click Edit in the Home ribbon (Comparison

Themes group).

@ Rendering 5ets

Rendering Set: | Standard

Comparison Options

Redline Options

Redline Rendering

Comparison Options
Select the document features to be compared.

A Comparison Options

Allow Auto Retry

Detect List Mumbering Changes
Detect Footnote/Endnote Numbering Changes
Compare Headers/Footers

Compare Footnotes

O Compare at Character Level

[] Compare Numbers at Character Level
[ ignore Embedded Objects/Images
O Ignore Case Changes

I:l Ignore Text Boxes

[ Ignore Field Codes

Compare field contents as text

I:l Ignore Tables

[[] Display comments in redline

[[] Detect Changes to Images

O Ignore auto list against manual number list changes

Apply | Cancel || Help |

If you have permissions, you can modify and delete existing rendering sets and create new

rendering sets. Refer to Customizing Rendering Sets.

Additionally, you can re-run a comparison changing specific comparison options. Refer to
Changing the comparison options.
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Customizing Rendering Sets

If you have the relevant access rights, you can modify and delete existing rendering sets
as well as create new rendering sets.

Note: Depending on how Workshare Compare has been distributed through the
company, you may or may not have access rights to configure rendering sets. If you have
any questions about your access rights, please speak to your system administrator.

Modifying existing rendering sets

If you have permission, you can modify the settings of an existing rendering set.
To modify an existing rendering set:

1. In the Rendering Sets Manager, select the rendering set you want to modify from
the Rendering Set dropdown list.

Rendering Set: | Custom rendering set v]
Custorn rendering set
Standard no color
Standard no moves
Standard with caret for deletes
Redline Options | Standard with change numbers
Standard with font changes
Standard with shading
Standard

Comparison Opt|

Redline Renderin

[ Allow Autc Retry

(= . e e . - -

2. Configure or modify the parameters for the rendering set as follows:

o Click a category in the left pane to display parameters for that category in the
right pane.
o Configure the parameters as required.

Categories and their parameters are described in Rendering Set Parameters.

3. Click Save. The modified settings are saved to the selected rendering set.

Creating new rendering sets

If you have permission, you can create a new rendering set. You create a new rendering
set based on an existing rendering set and then modify it as required.

To create a new rendering set:

1. In the Rendering Sets Manager, select the rendering set on which you want to base
your new rendering set from the Rendering Set dropdown list.
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2. Click Save As. The Save Rendering Set dialog is displayed:

) Save Rendering Set *

Enter a name to use for the new rendering set.

Mew Set Mame || |

3. Enter a name for the rendering set. Enter the name of an existing rendering set to
overwrite a rendering set or enter a new name to create a new rendering set. Do
not use the following characters when naming rendering sets: <, >, :;, \, “, /,\\ or|.

4. Click OK. The new rendering set is selected in the Rendering Set dropdown list.

5. Configure or modify the parameters for the rendering set as follows:

= Click a category in the left pane to display parameters for that category in the
right pane.

= Configure the parameters as required.
Categories and their parameters are described in Rendering Set Parameters.

6. Click Save. The settings are saved to your new rendering set.

Deleting rendering sets

If you have permission, you can delete rendering sets from the Rendering Sets Manager.
To delete a rendering set:

1. In the Rendering Sets Manager, select the rendering set that you want to delete
from the Rendering Set dropdown list.

2. Click Delete. The selected rendering set is deleted.

Rendering Set Parameters

The parameters for rendering sets are grouped into the following categories:
e Comparison Options
o Redline Options

* Redline Rendering
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The categories appear in the left pane of the Rendering Sets Manager. Selecting a
category displays the parameters for that category in the central pane. The right hand
pane show a preview of how the redline will look with the parameters selected.

Comparison Options

Comparison Options Comparison Options
Select the document features to be compared.
Redline Options

Redline Rendering _A Comparison Options
Allow Auto Retry
Detect List Numbering Changes
Detect Footnote/Endnote Mumbering Changes
Compare Headers/Footers
Compare Footnotes
] Compare at Character Level
[ Compare Numbers at Character Level
[] Ignore Embedded Objects/Images
[| Ignore Case Changes
[] Ignore Text Boxes
[ | Ignore Field Codes
Compare field contents as text
] Ignore Tables
Display comments in redline
Detect Changes to Images

[] Ignore auto list against manual number list changes

The Comparison Options category includes parameters that enable you to customize
how the compare is performed.
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The Comparison Options parameters are described in the following table:

Parameter

Allow Auto Retry

Detect List Numbering
Changes

Detect
Footnote/Endnote
Numbering Changes

Compare
Headers/Footers

Compare Footnotes

Compare at Character
Level

Compare Numbers at
Character Level

Ignore Embedded
Objects/Images

Ignore Case Changes

Description

When selected, if a comparison fails for any reason then
Workshare Compare automatically attempts to perform a
comparison using reduced settings. Workshare Compare
methodically and automatically disables the Comparison
Options selected until it is able to perform a comparison.

If selected, changes to automatically generated list
numbers for numbered paragraphs are detected.

If selected, changes to the numbering of footnotes and
endnotes are detected. You may want to deselect this
parameter yet keep the Compare Footnotes parameter
selected. This way, changes to the content of footnotes
and endnotes will be detected but not changes to the
numbering.

If selected, the headers and footers in the original and
modified documents are compared.

If selected, the footnotes in the original and modified
documents are compared.

If selected, words that are only slightly different from each
other are compared. For example, if banana has been
changed to bananas - Workshare Compare shows just an
insertion of an s in the redline, rather than showing a
deletion of banana and an insertion of bananas. This is
intended to catch simple typing mistakes.

As above description, but compares numbers instead of
characters.

If selected, embedded objects and images are ignored
while doing the comparison and will not be displayed in
the redline.

If not selected, the embedded objects and images will
appear in the redline (although changes to them are not
detected unless the Detect changes to Images
parameter is selected.)

This option is useful when documents have very large
images embedded in them which would produce vast
amounts of data if written to the redline RTF file and would
slow down the comparison process and the loading of the
redline.

If selected, any case changes, for example, upper case to
lower case, made in the modified document are ignored.
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Parameter Description

Ignore Text Boxes If selected, any text boxes in the modified document are
ignored.

Ignore Field Codes If selected, fields are treated as the same even if their field

codes differ. So if you have a Date field in the original
document and an Author field in the same place in the
modified document, the redline will not show a change.

If not selected, field codes are compared and where they
have changed, the entire original field is shown as deleted
and the entire modified field is shown as inserted.

Compare field If selected, converts certain field codes to text and then
contents as text compares. If not selected, compares field code only.
Fields converted to text will not be subject to the Ignore
Field Codes parameter if that is also selected.

Note: The following field codes are converted to text:
TOC, REF, TOA, TA, DATE, TIME, COMMENTS,
KEYWORDS, AUTHOR, FILENAME, SAVEDATE,
CREATEDATE, PAGEREF, INDEX, DOCPROPERTY,
TITLE, MERGEFIELD, NOTEREF, SHAPE, QUOTE.
Other field codes will be dealt with according to the
Ignore Field Codes parameter setting.

For example, where there is a date field that in the original
document shows 1 Jan 2012 and in the modified updates
to 31 Jan 2012. When this parameter is selected, the
redline will show 431 Jan 2012. Where this parameter is
not selected, no change will be shown.

Ignore Tables If selected, any tables in the modified document are
ignored.

Display comments in If selected, comments in the original and modified

redline documents are compared.

Detect Changes to If selected, images in the original and modified documents

Images are compared.

In order for images to be compared, you must ensure that
the Ignore Embedded Objects/Images parameter is
NOT selected.
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Parameter Description
Ignore auto list If selected, when an automatically formatted list is being
against manual compared against a manual list, any changes in the

number list changes manual list are ignored.

Generally this parameter should NOT be selected. It
should only be selected in circumstances when one of the
documents being compared contains automatic list
numbering and the other document contains manual list
numbering.

Redline Options

Comparison Options Redline OPtions
Set the options for the construction and display of the redline document.
Redline Options

A General Options

L J

Redline Rendering

Include redline statistics At end of document ¥

["] Include Redline Comparison Summary
["] Include Redline Option Summary

["] Display Workshare Compare Footers
(] Black And White Headers

[C] Black And White Footers

[C] Show Moved Deletions

[C] Show Changes to Spaces

[C] Show Paragraph Changes

Include file names in Redline statistics

A Change Indicator Options

L J

[] Show Hidden Text

["] Show Line Numbering
Show Change Numbering ToolTips

Show change bars [Left margin v]
Show change numbers [Not shown v]
‘A’ Readability

Paragraph Matched Text Threshold U
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The Redline Options category includes parameters that enable you to customize how the
redline is displayed and what information is included with the redline.

The Redline Options parameters are described in the following table:

Parameter
General Options

Include redline
statistics

Include Redline
Comparison Summary

Include Redline Option
Summary

Display Workshare
Compare Footers

Black And White
Headers

Black And White
Footers

Show Moved Deletions

Show Changes to
Spaces

Show Paragraph
Changes

Include file names in
Redline statistics

Description

If selected, statistics about the changes between the
original and modified documents are displayed in the
redline. You can select to display these statistics at the
start of the document or at the end of the document.

If selected, a summary of all the changes is displayed at
the end of the redline. The changes are hyperlinked to
take you directly to the change in the redline.

If selected, a summary of the options selected in the
current rendering set is displayed at the end of the redline
in the statistics report.

If selected, details about the two documents being
compared are displayed in the footer of the redline.

If selected, changes detected in the header are rendered
in black and white. The color scheme set up in the
rendering set is maintained for changes to all other parts
of the document.

If selected, changes detected in the footer are rendered in
black and white. The color scheme set up in the rendering
set is maintained for changes to all other parts of the
document.

If selected, text that was deleted from a section of the
document and then subsequently moved to a new
location is indicated.

If selected, any extra spaces that have been added to or
deleted from the modified document are indicated.

If selected, paragraph markers ( 1) of any extra
paragraphs that have been added to or deleted from the
modified document are displayed.

If selected, the names of the compared documents are
included in the redline statistics.

Change Indicator Options

Show Hidden Text

Show Line Numbering

If selected, hidden text is displayed in the redline.

If selected, the line number is displayed to the left of each
line in the margin of the redline.
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Parameter Description

Show Change If selected, tool tips are displayed when you position the
Numbering ToolTips cursor over change numbers.

Show change bars If selected, vertical lines to indicate a change are

displayed next to each change in the margin of the
redline. You can select to display the lines either in the
Left or Right margin.

Show change numbers | If selected, the change number is displayed next to each
change in the margin of the redline. You can select to
display the number either in the Left or Right margin.

Readability See the Readability section below.

Note: The change indicator settings do not show if you open the redline in Microsoft
Word.

Readability

The Readability option enables you to set at what point insertions and deletions should no
longer be marked individually but marked as an entire paragraph deleted followed by an
entire paragraph inserted. The deleted paragraph is as the paragraph appears in the
original document and the inserted paragraph is as the paragraph appears in the modified
document.

For example, the following paragraph showing numerous deletions and insertions is quite
difficult to read:

DeltaV|ew Redlme—wrth—Table of Contents:

It would be much easier to read this paragraph if it was presented as the entire paragraph
deleted followed by a new paragraph inserted, as follows:

Obviously, if there were only a few deletions and insertions in a paragraph, then the first
example is easy to read.
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With the Readability parameter, you can specify at what point Workshare Compare no
longer marks deletions and insertions individually but marks the entire paragraph as a
deletion followed by the new paragraph as an insertion. You specify this by setting a
readability percentage by dragging the Paragraph Matched Text Threshold slider to your
required setting. The percentage selected is shown in a tool tip below the slider.

A Readability

Paragraph Matched Text Threshold U

)

The meaning of the setting is as follows:

o With readability set at 10%, Workshare Compare will mark insertions and deletions
individually unless 90% of the paragraph has changed. In other words, in most
circumstances paragraphs will be displayed in the same way as the first example
shown previously. Only when more than 90% of the paragraph has changed will
Workshare Compare display the paragraph as the second example.

o With readability set at 50%, Workshare Compare will mark insertions and deletions
individually unless 50% of the paragraph has changed. In other words, paragraphs
will be displayed in the same way as the first example shown previously unless
more than 50% of the paragraph has changed.

o With readability set at 90%, Workshare Compare will mark insertions and deletions
individually unless 10% of the paragraph has changed. In other words, in most
circumstances paragraphs will be displayed in the same way as the second
example shown previously. Only when less than 10% of the paragraph has
changed will Workshare Compare display the paragraph as the first example.

The default setting for readability is 10%.

Workshare Compare looks at each paragraph separately and assesses its readability
according to the number of changes in the paragraph.

Note: When working with tables, Workshare Compare does not treat the entire table as a
paragraph. Each paragraph within each cell is treated separately.

Readability only applies to paragraphs that contain both inserted and deleted text because
such paragraphs may be unclear whereas paragraphs with only insertions or deletions do
not have such readability problems.
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Redline Rendering

CEGE S ar S Redline Rendering

Set the options for how your changes are displayed/rendered in the redline
Redline Options document.
Redline Rendering A Inserted Text

Inserted Text Color | B - |
Inserted Text Background ' v |

Inserted Text Format Double Underline v
Surrounding Characters Change Text

Vv Deleted Text

VvV Moved Text

VvV Change Numbering
Vv Font Changes
Vv Style Changed Text

Vv Table Changes

The Redline Rendering category includes parameters that enable you to customize how
specific types of changes are displayed in the redline.

The Redline Options parameters are presented in the following sections:

Inserted Text

The Inserted Text section includes parameters that enable you to customize how you
would like inserted text to appear in the redline.

A Inserted Text

Inserted Text Color | I - l
Inserted Text Background N7
Inserted Text Format Double Underline % ]
Surrounding Characters Change Text
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The Inserted Text parameters are described in the following table:

Parameter Description

Inserted Text Color The color of inserted text.

Inserted Text The color of the background of inserted text.
Background

Inserted Text Format @ The format of inserted text. Select from Underline, Double

Underline, /talic or Strikethrough.

Surrounding A keyboard character to go before and after inserted text.
Characters

Deleted Text
The Deleted Text section includes parameters that enable you to customize how you

would like deleted text to appear in the redline.

A Deleted Text

Deleted Text Color I — vl
Deleted Text Background l v I

Deleted Text Format [Smkethfough v]

Surrounding Characters Change Text

Deleted Text Replacement Character
("] Replace Deleted Text with a Single Character

(] Include summary of deletions

The Deleted Text Format parameters are described in the following table:

Parameter Description

Deleted Text Color | The color of deleted text.

Deleted Text The color of the background of deleted text.
Background

Deleted Text The format of deleted text. Select from Underline, Double
Format Underline, /talic or Strikethrough.

Surrounding A keyboard character to go before and after deleted text.
Characters
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Parameter Description

Deleted Text The character used to replace deleted text. If the Replace
Replacement Deleted Text with a Single Character checkbox is selected,
Character the deleted text is replaced with a single instance of the

character specified. If the Replace Deleted Text with a Single
Character checkbox is not selected, each character in the
deleted text is replaced with the character specified. For
example, if the word compare is deleted and the character
specified is X, the word appears as XXXXXXX.

Replace Deleted If selected, deleted text is replaced with a single character. If
Text with a Single | you select this checkbox, enter the required character in the
Character Deleted Text Replacement Character field. For example, if

the word compare is deleted and the character specified is X,
the word appears as X.

Include summary | If selected, a summary of deletions is included with the redline.
of deletions

Moved Text

The Moved Text section includes parameters that enable you to customize how you would
like moved text to appear in the redline.

El\%Moved Text

Show Movements

Moved Text Color B - I
Moved Text Background v |

Moved Source Text Format [Smke&hfough v‘
Moved Destination Text Format [quh[g_undgdmg v]
Move Source Surrounding Characters Change Text
Move Destination Surrounding Characters Change Text
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The Moved Text parameters are described in the following table:

Parameter

Description

Show Movements

If selected, moved text is shown in the redline. If you leave
this checkbox unchecked, then any text that has been
moved is displayed the same as inserted and deleted text.

Note: Text is only shown as moved if it's over 22
characters. Anything less will be shown as insertions and
deletions. This is to prevent showing moved text
incorrectly. For example, if someone had deleted the
word "and" from one paragraph and added "and" in
another, they probably have not moved the text, rather
they are just changing the individual paragraphs, so
would want them displayed as insertions and deletions.

Moved Text Color

The color of moved text.

Moved Text
Background

The color of the background of moved text.

Moved Source Text
Format

The format of the source moved text. Select the format of
the text in its original position from Underline, Double

Underline, /talic or Strikethrough.

Moved Destination
Text Format

The format of the destination moved text. Select the format
of the text in its new position from Underline, Double

Underline, /talic or Strikethrough.

Move Source
Surrounding
Characters

A keyboard character to go before and after source moved
text. Specify the characters to surround the text in its
original position.

Move Destination
Surrounding
Characters

A keyboard character to go before and after destination
moved text. Specify the characters to surround the text in
its new position.
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Change Numbering

The Change Numbering section includes parameters that enable you to select whether
change numbers are shown in the redline and, if so, how they appear.

A Change Numbering

(] Show Change Numbering
Show Change Numbering before Change
Change Number Text Color - v

Change Number Text Format Superscript

The Change Numbering parameters are described in the following table:

Parameter Description

Show Change If selected, the number of the change is displayed next to each
Numbering change in the body of the redline (as superscript).

Show Change If selected, the change number is displayed before the change. If
Numbering not selected, the change number is displayed after the change. It

before Change | is recommended to position the change number before the
change as footnotes often appear after text. This reduces
confusion.

Change Number | The color of change numbers.
Text Color

Change Number | The format of change numbers. Select from a range of formats,
Text Format including Superscript or Bold.

Font Changes

The Font Changes section includes parameters that enable you to customize how you
would like any font changes to appear in the redline.

A Font Changes

] Show Font Changes

Font Change Text Color -
Font Change Text Background N
Surrounding Characters Change Text

The Font Changes parameters are described in the following table:

Parameter Description

Show Font Changes If selected, font changes are shown in the redline.
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Parameter Description

Font Change Text The color of font changes.

Color

Font Change Text The color of the background of font changes.
Background

Surrounding A keyboard character to go before and after font changes.
Characters

Note: Insertions and deletions override any font changes. For example, if the modified
document has new inserted text in a different font, it appears as inserted text and not as
font change text.

Style Changed Text
The Style Changed Text section includes parameters that enable you to customize how
you would like any style changes to appear in the redline.

A Style Changed Text

("] Show Paragraph Style Changes
Style Changed Label Color v

Show Character Style Changes

Style Changed Color >
Style Changed Background v
Style Changed Format Double Underline v
Surrounding Characters Change Text

The Style Changed Text parameters are described in the following table:

Parameter Description

Show Paragraph If selected, paragraph style changes are shown in the

Style Changes redline. Paragraph style changes are indicated in words, for
example, normal to heading two.

Style Changed The color of text in paragraphs where the paragraph style

Label Color has changed.

Show Character If selected, character style changes are shown in the redline.

Style Changes

Style Changed The color of character style changes.

Color
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Parameter Description

Style Changed The color of the background of character style changes.
Background

Style Changed The format of character style changes. Select from
Format Underline, Double Underline, Italic or Strikethrough.
Surrounding A keyboard character to go before and after style changed
Characters text.

Note: Changes to heading styles are also shown in the statistics report at the end of the
redline.

Table Changes

The Table Changes section includes parameters that enable you to customize how you
would like any format changes in tables to appear in the redline.

Table change options [Changes with surrounding char: v]

Table Cell Inserted Color Cl
Table Cell Deleted Color [:l
Table Cell Moved Color El
Table Cell Merged Color [:l
Table Cell Padding Color :I

The Table Changes parameters are described in the following table:

Parameter Description
Table Change The way changes in tables are indicated. You can select
Options from the following: Changes with surrounding

characters, Changes without surrounding characters,
Whole original and modified tables, Whole modified
table only or Whole modified table only (unmarked).

Selecting Whole modified table only (unmarked), the
modified table is shown in the redline as a new table with
no changes marked. Selecting Whole modified table only,
the modified table is also shown in the redline as a new
table but it is shown as an insertion.

Table Cell Inserted The color of inserted cells.
Color
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Parameter Description

Table Cell Deleted The color of deleted cells.
Color

Table Cell Moved The color of moved cells.

Color

Table Cell Merged The color of merged cells.
Color

Table Cell Padding The color of padded cells.
Color

What are padded cells?

Padded cells occur when an insert and delete have occurred within a table, a cell becomes
both an insert and a delete; therefore it creates a padded cell.

Original Table
Cell 1 Cell 2 Cell 3
Cell 4 Cell 5 Cell 6
Modified Table
Cell 1 Cell 3
Cell A Cell B
Cell 4 Cell 6
Rendered Table
Cell 1 Cell 2 Cell 3
Cell A PADDED CELL Cell B
Cell 4 Cell 5 Cell 6
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Appendix B. Configuring Comparison
Themes

This appendix describes how to configure comparison themes for Workshare Compare for
PowerPoint and apply them to a comparison. It includes the following sections:

* Introducing Comparison Themes, page 167, introduces Workshare Compare
comparison themes and describes how they determine the look of a comparison.

« Applying Comparison Themes, page 167, describes how to apply a comparison
theme to a comparison.

o Customizing Comparison Themes, page 168, describes how to create your own
comparison themes as well as modify existing comparison themes.

« Comparison Theme Parameters, page 170, provides a detailed description of all
the comparison theme parameters.
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Introducing Comparison Themes

Workshare Compare for PowerPoint uses colors and different formats in the comparison to
enable you to see the changes that have been made to the presentation.

The colors and formats adopted depend on the comparison theme applied to the
comparison. Workshare Compare for PowerPoint includes a default comparison theme
that you can apply or you can modify this comparison theme or create your own
comparison theme.

Applying Comparison Themes

You can apply a comparison theme to a comparison before the comparison is run and also
at any time after a comparison has been performed.

To apply a comparison theme before the comparison is run:

In the Select Presentations for Comparison dialog, select a comparison theme from the
Select Comparison Theme dropdown list.

To apply a comparison theme after the comparison has been run:

In the Comparison Themes group of the Home tab, select a comparison theme from the
Select dropdown list. Workshare Compare for PowerPoint re-performs the comparison
applying the new comparison theme styles to the resulting comparison.
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Customizing Comparison Themes

You can modify existing comparison themes as well as create new comparison themes.
Comparison themes are created and modified in the Comparison Themes Manager.

To open the Comparison Themes Manager:

Select Edit in the Comparison Themes group of the Home tab. The Comparison Themes
Manager is displayed.

Note: You can also click \2] to the right of the Select Comparison Theme field in the
Select Presentations for Comparison dialog.

@ Comparison Themes Manager — O e

View and edit existing comparison themes and create new ones

| Detect All Cha nges “| | Create Mew | Renarne Delete
Comparison Select the opticns to be included in the comparison
Insertions 4 Detect Changes to:
Deletions Speaker Motes
Moves Image Content
Prgperh_'r l:hangeg Embedded th_]ECt Content
Font Changes ltern Location and Size
Senstivity Text Formatting

Text Box Formatting

Slide Background

Hyperlink Target

Autoshape Style and Orientation
Detect Moved Text
Detect Moved Slides

Apply OK | Cancel

Comparison themes are made up of a set of parameters. The comparison theme
parameters are grouped into categories. The categories appear in the left pane of the
Comparison Themes Manager. Selecting a category displays the parameters for that
category in the right pane of the Comparison Themes Manager. The different categories
and their parameters are described in Comparison Theme Parameters.
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Creating new comparison themes

You can create new comparison themes as required to determine the colors and formats
used in the comparison to distinguish the changes that have been made to the
presentation.

To create a new comparison theme:

1. In the Comparison Themes Manager, click Create New. The Comparison Theme
Name dialog is displayed.

@ Comparisen Theme Mame >

Enter the new name for the comparison theme

|NE‘W Comparison Theme |

| ok || Cancel

2. Enter a name for the comparison theme and click OK.

3. In the Comparison Themes Manager, specify the comparison theme parameters as

follows:
o Click a category in the left pane to display parameters for that category in the
right pane.

o Configure the parameters as required.
Categories and their parameters are described in Comparison Theme Parameters.

4. Click Apply. The new comparison theme is saved.

Note: When you click OK in the Comparison Themes Manager, Workshare Compare for
PowerPoint re-performs the comparison applying the new comparison theme styles to the
resulting comparison.

Modifying existing comparison themes

You can modify existing comparison themes by changing the parameter settings for the
comparison theme or changing the name of the comparison theme. You can also delete
unwanted comparison themes.

To modify an existing comparison theme:

1. In the Comparison Themes Manager, select the comparison theme you want to
modify from the dropdown list.
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2. Modify the comparison theme parameters as follows:

= Click a category in the left pane to display parameters for that category in the
right pane.

= Configure the parameters as required.
Categories and their parameters are described in Comparison Theme Parameters.

3. Click Apply.

Note: When you click OK in the Comparison Themes Manager, Workshare Compare for
PowerPoint re-performs the comparison applying the new comparison theme styles to the
resulting comparison.

To rename a comparison theme:

1. In the Comparison Themes Manager, select the comparison theme from the
dropdown list and click Rename. The Comparison Theme Name dialog is
displayed.

2. Enter the new name for the comparison theme and click OK. The comparison
theme is saved with the new name.

To delete a comparison theme:

In the Comparison Themes Manager, select the comparison theme that you want to delete
from the dropdown list and click Delete. The comparison theme is deleted.

Note: You can delete one of the predefined comparison themes but all predefined
comparison themes are regenerated when Workshare Compare for PowerPoint is
launched.

Comparison Theme Parameters

The comparison theme parameters for Workshare Compare for PowerPoint are grouped
into the following categories:

o Comparison

e Insertions

e Deletions

e Moves

o Property Changes
e Font Changes

o Sensitivity
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Comparison

The Comparison category includes parameters that enable you to specify what changes
Workshare Compare for PowerPoint will detect.

Maves

Property Changes
Fant Changes
Sensitivity

[Ccmparisuﬂ | Select the options to be included in the comparison
Insertions 4 Detect Changes to:
Deletions

Detect Maoved Text
Detect Moved Slides

Speaker Motes

[ Image Content

["| Embedded Object Content

[C] Item Location and Size

[C] Text Farmatting

[C] Text Box Formatting

(] slide Background

[ Hyperlink Target

[C] Autoshape Style and Qrientation

The Comparison parameters are described in the following table:

Parameter

Description

Detect Changes to

Select the specific items that Workshare Compare for
PowerPoint will detect changes to, from the following: Speaker
Notes, Image Content, Embedded Object Content, Item
Location and Size, Text Formatting, Text Box Formatting,
Slide Background, Hyperlink Target, Autoshape Style and
Orientation.

Detect Moved Text

If selected, moved text within slides is detected.

Detect Moved Slides

If selected, moved slides are detected.
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Insertions

The Insertions category includes parameters that enable you to specify how inserted text
as well as inserted images and objects will be displayed.

Comparison

[Insertinns ]

Deletions

Mowes

Property Changes
Font Changes
Sensitivity

Select how insertions are highlighted

Insertion options Insertion sample

[ Bold

[ alic Inserted text
[¥] Underline

[T] Striketh rough P-!"‘“ i- ----- -i
Calor = - | m i E E

The Insertions parameters are described in the following table:

Parameter

Description

Insertion options

Select how insertions are displayed.

You can select any or a combination of the following
formatting options for inserted text: Bold, Italic, Underline
and Strikethrough. (You cannot select Underline and
Strikethrough.) You also select the font color from the Color
dropdown list.

Inserted images and objects are indicated with a dashed
border in the selected color.

An example of how inserted text, inserted images and inserted
charts will look with your selections is shown.
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Deletions

The Deletions category includes parameters that enable you to specify how deleted text
as well as deleted images and objects will be displayed.

Comparison

Insertions

| Deletions I

Moves

Froperty Changes
Font Changes
Sensitivity

Select how deletions are highlighted

Deletion options Deletion sample

[ Bold

[ Htalic Delatad tast
["] Underline

r 3 - P ————— -
[¥] Strikethrough ' ‘_ﬁ E
o W2 i ML

The Deletions parameters are described in the following table:

Parameter

Description

Deletion options

Select how deletions are displayed.

You can select any or a combination of the following
formatting options for deleted text: Bold, Italic, Underline and
Strikethrough. (You cannot select Underline and
Strikethrough.) You also select the font color from the Color
dropdown list.

Deleted images and objects are indicated with a dashed
border in the selected color.

An example of how deleted text, deleted images and deleted
charts will look with your selections is shown.
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Moves

The Moves category includes parameters that enable you to specify how moved text as
well as moved images and objects will be displayed.

Comparison
Insertions
Deletions
Property Changes
Font Changes
Sensitivity

Select how moved items are highlighted

Source (moved from)

Move source options

[ Bold

[ talic

[C] Underline
Strikethrough

Color: . ¥

Destination (moved to)

Move source sample

Move destination options

[ Bold
[E Ttalic

Move destination sample

Color:

Underline
[C] Strikethrough

Moved text

B -

The Moves parameters are described in the following table:

Parameter

Description

Move source options

Select how the source of moves is displayed.

You can select any or a combination of the following
formatting options for source moved text: Bold, Italic,
Underline and Strikethrough. (You cannot select Underline
and Strikethrough.) You also select the font color from the
Color dropdown list.

The source of moved images and objects is indicated with a
dashed border in the selected color.

An example of how source moved text, source moved images
and source moved charts will look with your selections is
shown.

174




Configuring Comparison Themes

Parameter

Description

Move destination
options

Select how the destination of moves is displayed.

You can select any or a combination of the following
formatting options for destination moved text: Bold, Italic,
Underline and Strikethrough. (You cannot select Underline
and Strikethrough.) You also select the font color from the
Color dropdown list.

The destination of moved images and objects is indicated with
a dashed border in the selected color.

An example of how destination moved text, destination moved
images and destination moved charts will look with your
selections is shown.

Property Changes

The Property Changes category includes parameters that enable you to specify how
items that have had their properties changed will be displayed.

[PfﬂpEl‘t"-,F Changes ]

Font Changes
Sensitivity

Comparison Select how items with changed properties are highlighted
fnsertions Changed items option Changed items sample
Deletions F s i =

I I
| = ~ 1 1
o oo BT i (|

The Property Changes parameters are described in the following table:

Parameter

Description

Changed item option

Select a color from the Color dropdown list. Images and
objects that have had their properties changed are indicated
with a dashed border in the selected color.

An example of how changed images and charts will look with
your selection is shown.
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Font Changes

The Font Changes category includes parameters that enable you to specify how text that
has had its font changed will be displayed.

Comparison Select how font changes are displayed

Insertions
Changed font option Changed font sample

Color: H - Changed text

Deletions

Mowes

Property Changes
[Fﬂnt Changes ]

Sensitivity

The Font Changes parameters are described in the following table:

Parameter Description

Changed font option | Select a color from the Color dropdown list. Text that has had
its font changed is displayed in the selected color.

An example of how changed text will look with your selection
is shown.
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Sensitivity

The Sensitivity category includes parameters that enable you to specify how sensitive
Workshare Compare for PowerPoint should be when detecting changes.

Comparison
Insertions
Deletions

Moves

Property Changes
Font Changes

| Sensitivity |

Select the options for sensitivity of comparisens

Choosing extreme values for the sensitivity settings can lead to
unusual comparison results. The button to the right will reset all Reset All

values to their defaults,
Slide similarity threshold (%)
uf
Text Box similarity threshald (%)
1
Table similarity threshold (35)
(i}

Minimum length for moved text

{
Thresheld for detecting changes in size or position
&}
Minimum ratio of unchanged text to surrcunding changes

o

The Sensitivity parameters are described in the following table:

Parameter

Description

Slide similarity
threshold (%)

Specify at what point insertions and deletions should no
longer be marked individually but marked as an entire slide
deleted and an entire slide inserted.

For example, if you set the threshold at 30% and the
similarity between the slides is calculated to be less than
30% then they will be shown as an inserted and deleted
slide. If the similarity is calculated as more than 30% then
the slides will be shown with changes found to individual
items on the slides.

Drag the slider to your required setting. As you drag the
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Parameter

Description

Text Box similarity
threshold (%)

Specify at what point insertions and deletions in text boxes
should no longer be marked individually but marked as an
entire text box deleted and an entire text box inserted.

Drag the slider to your required setting. As you drag the
slider, the percentage is shown as a tool tip above the slider.

Table similarity
threshold (%)

Specify at what point insertions and deletions in tables
should no longer be marked individually but marked as an
entire table deleted and an entire table inserted.

Drag the slider to your required setting. As you drag the
slider, the percentage is shown as a tool tip above the slider.

Minimum length for
moved text

Specify the minimum number of characters to detect as a
move — moved pieces of text shorter than this threshold will
be shown as an insertion and a deletion.

Drag the slider to your required setting. As you drag the

slider, the length (in characters) is shown as a tool tip above
the slider.

Threshold for detecting
changes in size or
position

Specify a threshold which determines how far an object
must be moved (or by how much its size must be changed)
for the change to be detected. The threshold value is
measured in inches.

Drag the slider to your required setting. As you drag the
slider, the position (in inches) is shown as a tool tip above
the slider.

Minimum ratio of
unchanged text to
surrounding changes

Specify at what point short matches of text should be
ignored if they are surrounded on both sides by unmatched
text. This prevents common words such as 'of', 'and' and
'the' being matched up in a paragraph where the content has
been completely changed.

Drag the slider to your required setting. As you drag the
slider, the percentage is shown as a tool tip above the slider.

Note: Selecting extreme values for the Sensitivity parameters can lead to unusual
comparison results. You can return the Sensitivity parameters to their default settings at
any time by clicking Reset All.
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Appendix C. Configuring Workshare
Desktop App

This appendix describes how to configure the Workshare desktop application (the desktop
app). This is an application that syncs content between Workshare and your PC so you
can access your files and continue collaborating from your desktop while offline.

Configuring the Workshare Desktop App
You can configure application settings for the Workshare desktop app, such as the
location of the sync folder or general account settings.

To configure the Workshare desktop app:

1. Click the desktop app system tray icon and select Preferences or from the File
menu in the desktop app main window, select Preferences. The following dialog is
displayed.

(5 Account — *

& b ‘KR © -l

Account General Metwork Sync Settings  Notifications

User Login: e sspsilissstaas

Sign out

Account:  Workshare Lid
SErver: https: ffmy.warkshare. com

‘ersion: Workshare 2. 16,3696.0
\Check for Updates |

The Account page provides information about your account. You can see your
registered Workshare email address that you use to log in to Workshare as well as
the address to the Workshare server. Additionally, you have version information
about the desktop app.
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2. Select General.

(=) General - *

& o ® © -l

Account  General  Metwork  Sync Settings  Motifications

[+] Launch Workshare when I login

Display DM5 Open dialog when adding files
(Requires Waorkshare & or above with a DMS integration)

Enahle OpenGL rendering
OpenGL rendering is required to dean files when uploading via drag and drop.

Control how Warkshare updates:

Automatically download and install updates b

3. Select the Launch Workshare when | login checkbox and the desktop app will
start when your computer is started.

4. When you have Workshare 9 (or above) with a DMS integration, select the Display
DMS Open dialog... checkbox and you can select files from your DMS when
uploading files to Workshare from the desktop app.

5. By default, the desktop app uses off-screen rendering (OpenGL rendering). In
cases where off-screen rendering is not supported (for example, GPUs with older
graphics drivers), the desktop app will automatically switch to on-screen rendering.
If the desktop app cannot recognize that there is a problem with off-screen
rendering, you can manually switch to on-screen rendering by deselecting the
Enable OpenGL rendering checkbox.

Note: When using on-screen rendering, the clean/convert options will not be
available when using drag and drop to add files. For more information about
OpenGL rendering, refer to this article in the Workshare knowledge base.

6. To control how Workshare updates, select from the dropdown:

= Automatically download and install updates: Updates to the desktop app will
be downloaded and installed automatically as they become available.

= Notify me when updates are ready to install: You will be notified when
updates to the desktop app are available.
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7. Select Network.

5 Network — *

@ o & © «

Account  General  Metwerk  Sync Settings  Motifications

Bandwidth: | Change Settings...

Proxies: Change Settings. ..

Metwork Status Connected

The Network page enables you to limit bandwidth settings and change the settings
of your proxy server.

8. In the Bandwidth field, click Change Settings.

[ Bandwidth p 4

Download rate: Don't limit

Limit to: 0 KE/fS
(== [ cmat |

9. If you want to limit the bandwidth available to data downloaded to the desktop app,
deselect the Don’t limit checkbox and specify the limit in the Limit to field.

10. Click Save.
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11. In the Proxies field, click Change Settings.

=) Proxy >

Proxy Settings: (O No Proxy

(@ Auto-detect

() Manual:
Force Proxy:
Proxy Type: HITP i
Server:

Part:

I Save | Cancel

12. When working with a proxy server, select Auto-detect and Workshare will use your
computer’s system settings to connect to the network, or select Manual and enter
your proxy server details manually.

Note: There is no Auto-detect option available when working on a Mac.

13. When manually specifying proxy server settings, you can select Force Proxy so
that the desktop app traffic MUST go via your proxy server and if the proxy server
is not available then the desktop app will be offline.

14. Select the type of your proxy server (HTTP, HTTP Caching or Socks5) and enter
the server address and port number.

15. Click Save.
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16. Select Sync Settings.

5 sync Settings

& oL ® O o

Account  General Metwork Sync Settings  Motifications

Workshare sync location;

| C: Users/helens \Warkshare Browse

Show sync conflict confirmation messages

17. If required, change the location of the Workshare sync folder by clicking the browse
button and selecting a different location. By default, this folder is named and

located as follows:
o Windows: C:\Users\[user name]\Workshare
s Mac: /Users/[user name]/Workshare

Any files or folders put in this folder will be synced to Workshare online and will
appear in the desktop app.
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18. Select Notifications.

(=) Notification — oo

& b @ O ol

Account  General Metwork SyncSettings  Motifications

Notify me when: By email By desktop alerts

Someone first accesses a folder
A new file is added to a folder

There is a new version of a file

KR EE

A comment is posted

KIRIRIRIE]

When someone shares files or folders with me

19. If required, change the notification settings. By default, users receive notifications
by email and via desktop popup alerts in the following circumstances:

= When a user first accesses a folder you have shared with them
= When a new file is added to a shared folder

= When there is a new version of a file

= When a comment is posted

o When someone shares a file or folder with you
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5 Workshare Ltd.
© 2019. Workshare Ltd. All rights reserved.

Copyright

Workshare Professional and Workshare DeltaView are registered trademarks of Workshare Ltd. Workshare Compare,
Workshare Protect, Workshare 3, Workshare DeltaServer, SafetyGain, and the Workshare logo are trademarks of
Workshare Ltd. All other trademarks are those of their respective holders.

Trademarked names may appear throughout this guide. Instead of listing these here or inserting numerous trademark
symbols, Workshare wishes to state categorically that no infringement of intellectual or other copyright is intended and
that trademarks are used only for editorial purposes.

Disclaimer

The authors/publishers of this guide and any associated help material have used their best efforts to ensure accuracy
and effectiveness. Due to the continuing nature of software development, it may be necessary to distribute updated
help from time to time. The authors would like to assure users of their continued best efforts in supplying the most
effective help material possible.

The authors/publishers, however, make no warranty of any kind, expressed or implied, with regard to Workshare
programs or help material associated with them, including this guide. The authors/publishers shall not be liable in the
event of incidental or consequential damages in connection with, or arising out of, the programs or associated help
instructions.

For details of Workshare patents, see www.workshare.com/patents

Revisions

Published for Workshare 10: 18/12/18; minor revisions: 17/1/19 & 15/2/19

Workshare Ltd., 20 Fashion Street, London E1 6PX www.workshare.com
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